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Korkma, sönmez bu afaklarda yüzen al sancak;  
Sönmeden yurdumun üstünde tüten en son ocak.  
O benim milletimin y ld z d r, parlayacak;  
O benimdir, o benim milletimindir ancak.  
 

Çatma, kurban olay m, çehreni ey nazl  hilâl! 
Kahraman rk ma bir gül! Ne bu iddet, bu celâl? 
Sana olmaz dökülen kanlar m z sonra helâl. 
Hakk d r Hakk’a tapan milletimin istiklâl. 
 

Ben ezelden beridir hür ya ad m, hür ya ar m. 
Hangi ç lg n bana zincir vuracakm ? a ar m! 
Kükremi  sel gibiyim, bendimi çi ner, a ar m. 
Y rtar m da lar , enginlere s mam, ta ar m. 
 

Garb n âfâk n  sarm sa çelik z rhl  duvar,  
Benim iman dolu gö süm gibi serhaddim var. 
Ulusun, korkma! Nas l böyle bir iman  bo ar, 
Medeniyyet dedi in tek di i kalm  canavar? 
 

Arkada , yurduma alçaklar  u ratma sak n; 
Siper et gövdeni, dursun bu hayâs zca ak n. 
Do acakt r sana va’detti i günler Hakk’ n; 
Kim bilir, belki yar n, belki yar ndan da yak n  

 

 

Bast n yerleri toprak diyerek geçme, tan :  
Dü ün alt ndaki binlerce kefensiz yatan . 
Sen ehit o lusun, incitme, yaz kt r, atan : 
Verme, dünyalar  alsan da bu cennet vatan . 
 

Kim bu cennet vatan n u runa olmaz ki feda? 
üheda f k racak topra  s ksan, üheda! 

Cân , cânân , bütün var m  als n da Huda, 
Etmesin tek vatan mdan beni dünyada cüda. 
 

Ruhumun senden lâhî, udur ancak emeli: 
De mesin mabedimin gö süne nâmahrem eli. 
Bu ezanlar -ki ehadetleri dinin temeli-  
Ebedî yurdumun üstünde benim inlemeli. 
 

O zaman vecd ile bin secde eder -varsa- ta m, 
Her cerîhamdan lâhî, bo an p kanl  ya m, 
F k r r ruh-  mücerret gibi yerden na’ m; 
O zaman yükselerek ar a de er belki ba m. 
 

Dalgalan sen de afaklar gibi ey anl  hilâl! 
Olsun art k dökülen kanlar m n hepsi helâl. 
Ebediyyen sana yok, rk ma yok izmihlâl; 
Hakk d r hür ya am  bayra m n hürriyyet;  
Hakk d r Hakk’a tapan milletimin istiklâl! 

 
         Mehmet Âkif Ersoy 



 

GENÇL E H TABE 

 

Ey Türk gençli i! Birinci vazifen, Türk istiklâlini, Türk Cumhuriyetini, 

ilelebet muhafaza ve müdafaa etmektir. 

Mevcudiyetinin ve istikbalinin yegâne temeli budur. Bu temel, senin en 

k ymetli hazinendir. stikbalde dahi, seni bu hazineden mahrum etmek 

isteyecek dâhilî ve hâricî bedhahlar n olacakt r. Bir gün, istiklâl ve cumhuriyeti 

müdafaa mecburiyetine dü ersen, vazifeye at lmak için, içinde bulunaca n 

vaziyetin imkân ve eraitini dü ünmeyeceksin! Bu imkân ve erait, çok 

namüsait bir mahiyette tezahür edebilir. stiklâl ve cumhuriyetine kastedecek 

dü manlar, bütün dünyada emsali görülmemi  bir galibiyetin mümessili 

olabilirler. Cebren ve hile ile aziz vatan n bütün kaleleri zapt edilmi , bütün 

tersanelerine girilmi , bütün ordular  da t lm  ve memleketin her kö esi bilfiil 

i gal edilmi  olabilir. Bütün bu eraitten daha elîm ve daha vahim olmak üzere, 

memleketin dâhilinde iktidara sahip olanlar gaflet ve dalâlet ve hattâ h yanet 

içinde bulunabilirler. Hattâ bu iktidar sahipleri ahsî menfaatlerini, 

müstevlîlerin siyasî emelleriyle tevhit edebilirler. Millet, fakr u zaruret içinde 

harap ve bîtap dü mü  olabilir. 

Ey Türk istikbalinin evlâd ! te, bu ahval ve erait içinde dahi vazifen, 

Türk istiklâl ve cumhuriyetini kurtarmakt r. Muhtaç oldu un kudret, 

damarlar ndaki asil kanda mevcuttur. 

                       Mustafa Kemal Atatürk 
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Öğrenme biriminde yer 
alan konuları gösterir.

Bu öğrenme biriminde 
neler öğrenileceğini 

gösterir.

Öğrenme biriminde yer 
alan temel kavramları

gösterir.

Öğrenme biriminin 
karekodunu gösterir.

Öğrenme biriminin 
adını gösterir.

Öğrenme biriminin 
numaralarısını gösterir.

Hazırlık çalışmaları 
alanını gösterir.

DERS MATERYALİNİN TANITIMI



Uygulama alanını 
gösterir.

Uygulama bilgi notu 
birimini gösterir.

Konu görsellerini
gösterir.

Etkinlik birimini 
gösterir.
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Örnek birimini 
gösterir.

Madde birimini 
gösterir.

Tablo
alanını gösterir.
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Kontrol listesini gösterir.

Ölçme ve Değerlendirme 
birimini gösterir.



KONULAR

1.1. TASARIMA ÖN HAZIRLIK
1.2.  WEB SAYFASI ESKİZİ 
1.3. TASARIMIN OLUŞTURULMASI
1.4. GÖRSELLER ÜZERİNDE İŞLEMLER 

TEMEL KAVRAMLAR
•	 Arayüz

•	 Duyarlı web tasarımı

•	 Genel Ağ

•	 Web

•	 Web arayüzü

•	 Web sayfası

•	 Web sitesi

NELER ÖĞRENECEKSİNİZ?
•	 Web sitesi tasarımına ön hazırlık yapma

•	 Web sayfası eskizi oluşturma

•	 Web sitesi tasarımı oluşturma

•	 Görseller üzerinde işlemler yapma

Hazırlık Çalışmaları
1.	 İlgi alanınıza ait, yaptığınız çalışmaları paylaşmak ya da satışa sunmak istediğinizde neler 

yaparsınız? 

2.	 Sürekli kullandığınız bir sosyal medya uygulamasına herhangi bir kullanım farklılığı gel-
diğinde ne düşünürsünüz? 

3.	 Herhangi bir web sitesinin, beğendiğiniz ya da beğenmediğiniz özellikleri nelerdir? Fi-
kirlerinizi sınıf arkadaşlarınızla paylaşınız.

16

KOD=41362

1.



17

1.Öğrenme Birimi

WEB ARAYÜZÜ
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İletişim, yaşam boyunca ihtiyaç duyulan bir olgu olmakla birlikte teknolojik ilerlemeler sonucunda 
iletişimin belli ögeleri de gelişim ve değişime uğramıştır. Zaman içerisinde mevcut araçlar ve kanal-
ların ihtiyacı karşılayamaması nedeniyle iletişimdeki araçlar dijitalleşmiş, kanal ise genel ağ (internet) 
olmuştur. 

İletişim kanalı olarak genel ağın kullanımı web sitelerinin doğmasına neden olmuştur.  Teknolojik 
gelişmeler ve değişen bilişim, yaşamın pek çok değişkenini etkileyerek insanların beklentilerini değiş-
tirmiştir. Beklentiler sonucunda web siteleri de gelişim göstermiştir. Etkileşim içermeyen statik web 
siteleri, Web 2.0 teknolojisiyle etkileşim içeren dinamik web sitelerine yerini bırakmıştır. Bu bağlamda 
web tasarımında şu üç farklı model ele alınmıştır: 

•	 Duyarlı Web Tasarımı [RWD (Responsive Web Design) (rispansiv veb dizayn)]: Duyarlı tasarım 
olarak da bilinen, kullanılabilirliği ve memnuniyeti sağlamak için web sayfalarının çeşitli cihaz-
larda minimumdan maksimum pencere ya da ekran boyutlarında iyi işlenmesini amaçlayan bir 
web tasarımı yaklaşımıdır. 

•	 Adaptasyon Web Tasarımı [Adaptive Web Design (adapdıv veb dizayn)]: Ekran genişliğine 
orantılı şekilde uygulanabilen, sayfanın önceden belirlenmiş çözünürlüğüne ulaşana dek yapısı 
bozulmadan küçülmesini sağlayan ve belirlenen ölçüye ulaşıldığında diğer çözünürlüklere odak-
lanabilen, sabit ölçüler kullanılarak tasarım yapımını sağlayan web tasarımı yaklaşımıdır.

•	 Likit Web Tasarımı [Liquid Web Design (likit veb dizayn)]: Standart çözünürlükten büyük veya 
küçük çözünürlüğe ulaşımı sırasında sayfanın yapısını bozmadan büyümesini ve küçülmesini 
sağlayan web tasarımı yaklaşımıdır.

Web sitelerinin, web teknolojisindeki gelişmeler ve kullanıcı beklentileri dikkate alınarak tasar-
lanması gerekir. Web tasarımı; Web1.0’da içeriğin yönetici tarafından, Web2.0’da kullanıcı tarafından, 
Web3.0’da topluluk tarafından oluşturulması göz önünde bulundurularak yapılmalıdır. Web tasarı-
mında kullanılan bazı kavramlar mevcuttur. Bu kavramlar şunlardır:

İnternet (Net-Genel ağ): Bilgisayarları birbirine bağlayan elektronik iletişim ağıdır.

World Wide Web (www ya da Web-Dünya Çapında Ağ): Genel ağ üzerinde yayımlanan birbiriyle 
bağlantılı hiper-metin belgelerinden oluşan bilgi sistemidir.

IP (İnternet Protocol): Genel ağ ortamında her bilgisayarın kendine özel numarası vardır. Bu numa-
ralar IP olarak adlandırılır.

Http (Hypertext Transfer Protocol): Genel ağın hipertext dosyalarını ulaştırma kurallarıdır.

Ftp (File Transfer Protocol): Dosya aktarma kurallarıdır. 

Tcp / IP (Aktarma Denetim Kuralları / İnternet Kuralları): Hizmet eden (server) ile hizmet edilen 
(client) arasındaki ilişkiyi düzenleyen kurallardır. 

URL: Evrensel kaynak belirleyicidir. Web Server (kaynak olduğundan), IP, aradığı kaynağı URL adres 
sistemini kullanarak bulur. 

URL’nin genel yapısı: erişim-yöntemi://sunucu-ismi[: port] / konum şeklindedir.

Örneğin http://www.websitesiismi.com 

Web Browser (Tarayıcı-İnternet Tarayıcı-Ağ Tarayıcısı-Web Göz Atıcı): Kullanıcıların  ağ sunu-
cuları  üzerinde yer alan  HTML  veya daha gelişmiş sayfaların açılmasını sağlayan bir yazılımdır. 
Explorer, Firefox, Google Chrome buna örnektir.

Web Server (Sunucu): Web sitesine ait dosyaları saklayan ve genel ağ kullanıcılarının erişimine 
sunan cihazlara web server denir. Bir web sitesinde yayımlanması istenen sayfaların, görsellerin veya 
belgelerin genel ağ kullanıcıları tarafından erişebileceği bir cihazda tutulmasıdır.
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Hosting: Web sitesinin barınabileceği alandır. Veri  saklama ve yayımlama işlemine web hosting 
denir. Web sunucusundan belirli bir disk alanı kiralayarak ya da telekomdan kiralık hat aracılığıyla 
web sunucusu kurarak oluşturulabilir. 

DNS (Alan Adı Servisi): Genel ağ üzerindeki sunucuların adresleri (IP) her biri 0-255 arasında olan 
dört basamaktan oluşur. Genel ağ üzerinde alan adı-IP adresi eşleştirmesi yapan servislere DNS adı 
verilir. Kullanıcının  girmek istediği web sitelerinin IP adreslerini akılda tutması  zor olacağından DNS 
kullanılmaktadır. 

Domain: Web sitesine ulaşılabilecek isimdir. Genel ağ üzerinde web sitesini yayımlamak isteyen 
firma ya da şahıs, web sitesine ait bir alan adı (domain) seçer. 

Hiper-metin: Elektronik cihazlarda gösterilen ve sadece yazıdan ibaret olmayan gelişmiş özelliklere 
sahip belgelerdir.

Web Sayfası: Web için hazırlanan ve web tarayıcısı kullanılarak görüntülenebilen metin, görsel ve 
animasyon şeklinde içeriklere sahip dokümandır.

Web Sitesi: Web üzerindeki sayfalar, 
metin, görsel ve animasyon şeklinde 
ziyaretçisine bilgi aktaran ya da 
hizmet sunan sayfaların tümünü 
kapsayan doküman topluluğudur.

Arayüz: Bir hizmeti sunan sistem 
(makine, bilgisayar) ile kullanan 
sistem (kullanıcı) arasında etkileşim 
köprüsü görevi gören grafik tasarım 
disiplinidir. Herhangi bir prog-
ramlama bilgisine sahip olmayan 
kullanıcıların da bilgisayar program-
larını veya program komutlarını 
içeren makineleri kullanabilmelerini 
sağlamak için geliştirilen görsel, 
işitsel veya dokunsal kumanda araç-
larının tümüdür.

Web Arayüzü: Web sitesinin dijital 
ekrana yansımış detaylarını içeren 
grafik unsurlarının tamamıdır 
(Görsel 1.1).

Plastisite (Kullanıcı Arayüzü 
Esnekliği): Bir kullanıcı arayüzünün, 
kullanılabilirliği korurken hem 
sistemin fiziksel özelliklerindeki 
hem de çevredeki değişikliklere 
dayanma kapasitesidir.

Görsel 1.1: Farklı web arayüzleri 

1.1. TASARIMA ÖN HAZIRLIK
Estetik, işlevsel, ergonomik bir web sitesi tasarımı, doğru yapılmış bir ön hazırlıktan; ön hazırlık ise 
müşteri amaç ve isteklerinin net anlaşılması, kullanıcı beklentisi analizinin doğru yapılmasından 
geçer. Web sitesinin hazırlanacağı amacı bilmek siteyi oluşturma sürecinde oldukça önemlidir.
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Web sitesi oluşturma amaçları şunlardır:

•	 Bir duygu ya da düşünceyi ifade etmek.

•	 Bir işletmeyi tanıtmak.

•	 Bir ürünü pazarlamak.

•	 Bir topluluk oluşturmak. 

•	 İnsanlara yardım etmek.

•	 Eğlenebilmek, keşif yapmak.

•	 Yeni bir yatırımı teşvik etmek veya tetiklemek. 

•	 Bilgi paylaşmak ya da bilgiye erişmek. 

•	 Yeni teknolojileri denemek.

•	 Bağımsız olmak, küresel olmak. 

•	 Dünya çapında tanınmak.

•	 Reklam ve satış yapmak. 

Web sitesi türleri; temelde eğlence ve ticaret olmakla birlikte kişisel siteler, bloglar, fotoğraf paylaşım 
siteleri, eser sahibi web siteleri, sosyal paylaşım siteleri, mobil cihaz siteleri, bilgilendirici web siteler, 
çevrim içi iş ve katalog siteleri, dizin web siteleri, kurumsal siteler ve e-ticaret siteleri olarak sıralana-
bilir (Görsel 1.2). Genel ağda en çok ziyaret edilen web sayfaları, kişisel ve ticari sayfalardır. Web sitele-
rinin, amaçları doğrultusunda kullanıcılarla yapmış olduğu bilgi paylaşımları, hedefe hızlı ulaşılmasını 
sağlar.

Görsel 1.2: Şahıs, kurum web sayfası ve sitesi örnekleri



21

WEB ARAYÜZÜ

Rekabetçi dijital dünyada web sitesinin iyi olması için amaca uygunluk, estetiklik ve elverişli bir kulla-
nılabilirlik seviyesine sahip olması gerekir.  Hedef kitle için web sitelerinin, yaşayan bir bilgi kaynağı, 
günlük hayatı kolaylaştıran araç ve genel ağ üzerinden insanlığın erişimine sunulmuş olduğu düşü-
nülerek tasarlama ve planlama sürecinin titizlikle yürütülmesi gerekir.

Web sitesi proje oluşturma aşamasında planlanması gereken unsurlar şunlardır:

•	 Web sitesinin genel amacının açık ve net belirlenmesi

•	 Hedef kitle analizi yapılması

•	 Grafik tasarım yaklaşımının belirlenmesi

•	 Kullanılabilirlik testlerinin site oluşturulma sürecine dâhil edilmesi

•	 Kullanıcı merkezli bir tasarım 
belirlenmesi

•	 Belgelemenin proje sürecine 
dâhil edilmesi

•	 Dolaşım sistemlerinin belir-
lenmesi

•	 Sitenin prototipinin (ön mode-
linin) oluşturulması

•	 Sitenin test edilme süreci

Tüm veriler bilgilendirme dosya-
sında bir araya getirilmelidir 
(Görsel 1.3).

Ön hazırlık aşamasında göz önünde bulundurulması gereken hususlar şunlardır:

•	 Web sitesi kategorisi özellikleri

•	 Web arayüzünde kullanıcı sistem insan olduğundan görüp kullanılan iletişim mekanizmalarının 
(görüntü, ses vb.) kullanılabilirliği ya da ergonomik özellikleri, belli kural ve standartlara uyumluluk 
derecesinin (zaman ve eldeki olanaklar göz önünde tutularak) belirlenmesi gibi konular

•	 Web arayüz tasarımında da arayüz tasarım disiplininin amacı ve bu amaca ulaşmak için ön gördüğü 
yöntemler 

•	 Kullanıcı odaklı tasarım (kullanıcının amaçları, alışkanlıkları ve kullanım deneyimi göz önünde 
bulundurularak tasarlanması)

•	 Etkileşim tasarımı (makine ve insan arasındaki etkileşimin hedeflerinin ve yöntemlerinin tespiti)

•	 Hedefe etkin biçimde ulaşmanın önündeki engellerin araştırılarak ortadan kaldırılması

1.1.1. Web Sitesiyle İlgili Bilgilendirme Dosyası Hazırlama

Görsel 1.3: Bilgilendirme dosyası örneği

1.1. ETKİNLİK 
Farklı kategorilerde web sayfası ve web sitesine ait örnekler araştırınız. 
Araştırdığınız örnekleri inceleyerek görüşlerinizi sınıf arkadaşlarınızla 
paylaşınız.
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UYGULAMA ADI: Bilgilendirme Dosyası Hazırlama  

AMAÇ: Bilgilendirme dosyası hazırlamak. 

Araç Gereç

1. Bilgisayar

2. Genel ağ 

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak web sitesi tasarlamak için bilgi-
lendirme dosyası hazırlayınız.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı 
ve araç gerecinizi hazırlayınız

2.	 Web sitesinin genel amacını açık ve net belirleyiniz.

3.	 Hedef kitle analizi hazırlayınız.

4.	 Grafik tasarım yaklaşımını belirleyiniz.

5.	 Tasarımınızı hazırlarken kullanıcı merkezli olmasına dikkat ediniz.

6.	 Dolaşım sistemlerini belirleyiniz.

7.	 Sitenin prototipini (ön modelini) oluşturunuz.

8.	 Çalışmanızı uygun formatta kaydediniz.   

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 1’in ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

1.1. UYGULAMA
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1.1.2. Renk Paletinin Hazırlanması
Web sitesi, kullanıcıyla karşılaştığı ilk aşamada dijital grafiğiyle ilgi uyandırabilir. Web sitesinde este-
tiğin önemli olduğu kadar kullanılabilirliğin de önemli olduğu göz önünde bulundurulmalıdır. Web 
sitesinin dijital grafiğiyle uyandırılan ilgi, kullanılabilirlik ile kullanıcıyı amacına ulaştırmalıdır. Dijital 
grafikte bu iki unsur birbirini tamamlar ve destekler nitelikte olmalıdır. 

Web sitesi dijital grafiğinin tasarlanması aşamasında şu ögeler göz önünde bulundurulmalıdır:

Grafik Ögeleri ve Dosya Ağırlıkları: Web sitesinin görsel estetiği ve zenginliği grafik ögelerdir. 
Sitede kullanılan görseller, sunucu bilgisayardan kullanıcı bilgisayarına indirilerek gösterilir. Kulla-
nılan grafik ögelerin sayfa kapasitesini ağırlaştıracağı düşünülerek gereksiz öge ve ağır dosya kullanı-
mından kaçınılmalıdır. Tablo, metin, görsel vb. grafik ögelerinin tamamı sayfa ve site içerisine uyumlu 
ve dengeli bir şekilde konumlandırılmalı, sayfalar olabildiğince sade tasarlanmalıdır. Grafik ögelerinin 
tüm kullanıcılara gösterilebilmesinin yolu, web sitesine uygun formatlarda grafikler oluşturulması ya 
da bu ögelerin dönüştürülerek kullanılmasıdır. Bu iş için uygun formatlar Jpeg, Gif, Png ve Svg’dir.  

Yerleşim Düzeni (Layout): Web sayfasının görsel yapısı yerleşim düzeni ile oluşturulur. Yerleşim 
düzeninde tüm ekranın içerik ve ortam türlerine sahip bölgelere ayrılma yöntemi belirlenmeli ve web 
sitesinde olması planlanan her web sayfası için bir ekran düzeni tasarımı oluşturulmalıdır. Yerleşim 
düzeni, bir kapsayıcı (container) içerisinde yer alan logo, başlık (header), ana içerik (main-content), 
yönlendirme (navigation), yan çubuk (slidebar) ve alt bilgi (footer) olmak üzere altı ana bölümden 
oluşur. Her bölümün tasarım ve yerleşimi birbirinden ayırt edilebilir, kolay algılanabilir ve düzgün bir 
biçimde olmalıdır. Yerleşim düzeni tasarımın bütünüyle tutarlı olmalı ve sayfalar tam doldurulmaya 
çalışılmadan içeriğin rahat algılanabileceği küçük boşluklar bırakılmalıdır.

Tipografi Kullanımı: Tipografinin ilk işlevi okunmaktır. Karakter, yazı türü, yazı büyüklüğü, satır 
uzunluğu, satır arası ve karakterler arası boşluk gibi değerler tipografi için oldukça önemlidir. Tipografi, 
basılı malzemede ve ekranda birbirinden farklıdır. Yazının ekranda okunur olması için sans-serif yazı 
tipi kullanılmalı ve site genelinde kullanılabilirlik açısından yazı tipi en fazla iki olmalıdır. Yazı stili 
diğer ögelerle uyumlu ve tutarlı şekilde seçilmelidir.  Ekran üstü okuma için tasarlanmış Georgia ve 
Verdana gibi fontlar kullanılabilir. Farklı yazı tipi boyutları, farklı konu anlatımlarında değil vurgulama 
amaçlı, başlık ya da alt başlıklar için kullanılabilir. Yazı rengi sitenin genel durumuna ve rengine göre 
uyumlu, dengeleyici seçilmelidir. 

Arka Plan Tasarımı: Arka plan, sayfa tasarımının bir parçası şeklinde planlanmışsa ve başlangıç 
aşamasında değil arka planın en son eklenmesi uygun olacaktır. Arka plan, web sitesine estetik değer 
katabileceği ya da etkililiğini yok edebileceği göz önünde bulundurularak dikkat dağıtıcı, algılamayı 
zorlaştırıcı canlı renkler ya da karmaşık desenler yerine açık, düz ve olabildiğince sade tercih edilme-
lidir.

Renk ve Kontrast: Web sitesinin görüntüleneceği cihazlar göz önünde bulundurulduğunda kullanı-
lacak renk modu RGB’dir. RGB [red, green, blue (kırmızı, yeşil, mavi)] üç temel renk ışığından oluşan, 
her biri 0-255 arası değer alabilen milyonlarca tonu ifade eder. Rengin görünümü, kullanıcı tercih-
lerine ve donanımına göre farklılıklar gösterir. Web sitesinde kullanılacak renk şeması, şirketin marka

Bilgi notu

Görsellik ile işlevselliğin dengeli olması, akılda kalıcılık ve olumlu bir izlenim 
oluşturmaktadır.
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renkleri başta olmak üzere tasarımcı tercihi, kullanılabilirlik çalışmaları vb. etkenlere göre belirlenir. 
Tasarımcı; tercihinde tasarımın yaklaşım biçimini, hedef kitlenin renk tercihini, firma ya da ürünün 
karakteri ya da kişiliğini ve rengin kültürel çağrışımını dikkate almalıdır (Görsel 1.4). Web sitesi tasa-
rımında renk kullanımı, uygulamada renk farklılığıyla iletilen bir bilginin renge bağımlı olmayan bir 
ögeyle de iletilmesi gereğidir. Bir web sitesi renkleriyle algılana bilirlik ve okunabilirlik için yeterli 
kontrastı taşımalıdır.

Görsel 1.4: Kurum renkleri bazında renk paleti örneği

1.1.3. Alanda Kullanılan Diğer Çalışmaları İnceleme
Web sitesinin başarıya ulaşması için planlama sürecinde, tasarımda kullanılan belirli deneyim ve 
birikim ürünü olan tasarım şablonlarına ve belirlenen genel konulara önem vermek gerekir. Var olan 
web sitesi tasarım eğilimlerinin araştırılması, başarılı sitelerin geçtiği süreçler, bilgi ya da planlarının 
incelenmesi, siteyi başarıya ulaştıracak güncel bilgilere sahip olunması sürecin verimli tamamlan-
masına katkı sağlar.

Bilgilendirme dosyasında mevcut bilgiler ve değişken özellikler göz önünde bulundurularak alanda 
yapılmış çalışmaların incelenmesi, tasarım oluşturma aşamasında ve sonrasında yaşanabilecek olum-
suzlukları ortadan kaldırır. Amacı doğrultusunda, hedefine ulaşmış başarılı ya da ulaşamamış az kulla-
nıcısı olan başarısız siteler mevcut imkânlarla görüntülenir (Görsel 1.5, 1.6).
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Görsel 1.5: Başarılı site örneğİ

Görsel 1.6: Başarısız site örneği

1.1.4. Görsel Materyalleri Bulma
Web sitelerinde ortak bazı temel ögeler kullanılır. Bunlar site kimliği, gövde metni, bağlantılar, 
dolaşım sistemleri (sayfalar arasında geçişi sağlayan sistem), görüntüler, formlar ve sayfa alt bilgile-
ridir. 

Sorumlu bir şekilde kullanılması gereken görüntüler, site içerisinde dolaşım sistemlerinde, formlar 
hâlinde, bağlantı olarak ve daha çok çeşitli yerlerde diğer ögelere göre daha fazla kullanım çeşitli-
liğine sahiptir. Sadece araç olarak değil hedef kitleye açık mesaj vermek için de kullanılır. Verilmek 
istenen mesajın bir görüntü aracılığıyla iletilmesi daha kolaydır ve  bu görüntü aracı çok fazla bilgi 
iletmekle kalmaz aynı zamanda bunu çok hızlı yapar. Çok fazla bilgi iletmekle kalmayan şey nedir?



26

Her programın kullanım amacının farklı olması sebebiyle profesyonel bir web sitesi tasarımı için piksel 
tabanlı görsel düzenleme programı, deneyim tasarımı programı, vektörel tabanlı görsel düzenleme 
programı, interaktif içerik oluşturma programı ve web editörü programı ile senkronize (eş zamanlı) 
olarak çalışmalar yapılmalı, tasarımlar oluşturulmalıdır. 

Bilgilendirme dosyasında bulunan ve ayrıca edinilen görüntü, ses, grafik, fotoğraf, video, animasyon vb. tüm 
materyaller uygun düzenleme 
programı ile kullanılacağı ortama 
gerekli hâle getirilmelidir. Mater-
yallerin kullanılacağı ortam web 
olması sebebiyle dijital ortam 
özellikleri göz önünde bulundu-
rularak çözünürlük, renk modu, 
format biçimi vb. özellikleri 
weble uyumlu hâle getirilme-
lidir. Örneğin weble uyumlu hâle 
getirilmemiş renk modu sorunu, 
estetik açıdan istenmeyen 
sonuçlar doğurur (Görsel 1.8).

Bilgilendirme dosyasında olan şahıs ya da kurumdan alınmış görsel materyallerin yanı sıra, sitenin 
oluşturulmasında ve geliştirilmesinde fayda sağlayabilecek, tasarıma estetik görünüm kazandırabi-
lecek, içeriği yansıtan, algılamayı zorlaştırmayan, merak uyandıran, dikkat çekici görsel materyaller 
edinilmelidir. Bu görsel materyaller (fotoğraf, grafik, animasyon, video, illüstrasyon vb.) hazır hâlde 
bulunabileceği gibi site için tasarımcı tarafından oluşturulabilir (Görsel 1.7). 

 Görsel 1.7: Görsel materyaller

1.1.5. Materyalleri Kullanıma Uygun Hâle Getirme

Görsel 1.8: Görsel düzenleme 

Bilgi notu

Görsel materyaller, içerik geliştirici yapay zekâ uygulamalarıyla da oluşturulabilir.
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UYGULAMA ADI: Tasarımda Kullanılacak Görsel Materyalleri Hazırlama  

AMAÇ	 : Tasarımda kullanılacak görsel materyalleri elektronik ortama aktararak  hazırlamak.  

Araç Gereç

1. Bilgisayar

2. Fotoğraf düzenleme programı

3. Haricî bellek 

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak web sitesi tasarlamak için 
kullanılacak görsel materyalleri dijital ortama aktararak uygun hâle getiriniz.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma ala-
nınızı ve araç gerecinizi hazırlayınız. 

2.	 Bilgisayarı çalışmaya hazır hâle getiriniz. 

3.	 Kullanacağınız fotoğrafları bilgisayara aktarınız.

4.	 Fotoğraf düzenleme programını açınız.

5.	 Web tasarımı için kullanılacak görsel materyalleri belirleyiniz.

6.	 Görsel materyallerin çözünürlük, renk modu, format biçimini uygun hâle getiriniz.

7.	 Düzenlediğiniz fotoğrafları uygun formatta kaydediniz.

8.	 Düzenlediğiniz görselleri aktarmak için bilgisayar ortamında dosya oluşturunuz.

9.	 Oluşturduğunuz dosyaya site adı veya kendi adınızı veriniz.

10.	 Dosya içerisine düzenlemesini yaptığınız görselleri aktarınız.

11.	 Sonra kullanılmak üzere dosyayı haricî belleğe aktarınız. 

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 
1’deki Kontrol Listesi 2’nin ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken 
bu ölçütleri dikkate alınız. 

1.2. UYGULAMA
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1.2. WEB SAYFASI ESKİZİ
Web sitesi dijital grafiği oluşturmak için elde edilen verilerle birlikte tasarım bilgileri; sayfa düzeni için 
gerekli olan materyallere karar vermek, etkileşimler ve işlemler tasarlamak ve fikirler üretmek için 
kullanılmalıdır. 

Tasarım bilgisi içerisinde; görsel süreklilik (tutarlılık), açıklık, denge, görsel hiyerarşi, vurgu, ritim, oran 
ve orantı, uyum ve bütünlük olan genel tasarım ilkeleri ile kimliği siteye net olarak yansıtılır.  Kulla-
nıcıların ihtiyaçlarına uygun olması, kolay kullanım, çevrim içi ortamda özgün olması, yüksek kaliteli 
içerik, minimum indirme zamanı, sık güncelleme yapma, web sitesi tasarım ilkeleri ile birlikte değer-
lendirilir.

Web siteleri hedef kitle tarafından kullanılacağından web arayüzü kullanıcı odaklı tasarlanmalıdır. 
Hedef kitle analizinde teknolojik gelişmeler ve yaşam standartları göz önünde bulundurulduğunda 
kullanıcı cihaz değişkenlerinin fazla olması, kullanıcı arayüzü esnekliği konusunu önemli hâle getir-
miştir. Web sitesi ziyaretçilerinin çoğunluğunu, mobil cihaz kullanıcılarının oluşturması duyarlı web 
tasarımını daha da önemli hâle getirmiştir. 

Eskiz çalışmalar, duyarlı web sitesi tasarımı için kullanıcı arayüzü plastisitesi göz önünde bulunduru-
larak hazırlanmalıdır. 

Yerleşim düzeni için oluşturulması gereken altı ana bölüm (logo, başlık, ana içerik, yönlendirme, 
yan çubuk, alt bilgi) amaca, kullanılabilirliğe ve estetik gereksinimlere uygun bir tasarım olacak 
şekilde oluşturulmalıdır. Bu tasarıma ulaşmak için elde hazırlanacak birkaç eskiz gereklidir. Tasarımcı 
açısından farklı arayüz seçeneklerini değerlendirme, müşteri açısından karar verme aşaması için en 
az üç adet eskiz çalışma hazırlanmalıdır.

1.2.1. Ana Sayfa Taslağı ve Sayfa Menülerini
Web sitesi ana sayfası, kullanıcıların siteyi ziyareti esnasında ilk karşılaşacağı sayfadır. Bu bakımdan 
ana sayfanın her açıdan tüm site içeriğini yansıtacak nitelikte olması son derece önemlidir. Ayrıca 
tasarım anlamında karmaşık olmayan olabildiğince sade, boyut olarak çok yer tutmayan materyaller 
seçilerek fazla zaman almadan hızlı bir şekilde açılabilecek olması, sitede kalınmasını ya da kalınma-
masını etkileyen unsurlardır. İçerik sayfalarına ulaşmak için oluşturulması gereken menü bölümü, site 
arayüzüyle uyumlu ve hatta tamamlayıcı, kolay erişilebilir ve rahat kullanılabilir nitelikte olmalıdır.

Bütün bu özellikler dikkate alınarak oluşturulan bir ana sayfa arayüzü (Görsel 1.9), web sitesi için 
amacını gerçekleştirmek adına ön koşul niteliğindedir.

Görsel 1.9: Web arayüz (layout) düzenleme sayfası 
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1.2.2. Menülere İlişkin Arayüzler
Ana sayfada link (bağlantı) verilen her menü için görüntülenebilen bir web sayfası hazırlanmalıdır. Bu 
web sayfaları genellikle main-content bölümünde görüntülenmek üzere düzenlenir.Tasarım olarak 
site geneline uyumlu, tamamlayıcı nitelikte ve göstereceği içeriği yansıtacak şekilde tasarlanmalıdır. 
İçeriği gösterilecek menü sayfalarının hem web sitesinin bir parçası hem de başlı başına bir web 
sayfası olduğu göz önünde bulundurulmalıdır. Ayrıca menü sayfalarının içerik bakımından olabildi-
ğince dengeli oluşturulması gerekir (Görsel 1.10).

Görsel 1.10: İçerik sayfası örnekleri



30

1.2.3. Ana Sayfa ve Arayüz Taslağını Renk Paletine Göre Renklendirme
Web sitesi için hazırlanan ana sayfa başta olmak üzere tüm içerik sayfaları, belirlenen renk paletine 
göre renklendirilmelidir. Renk seçimi; web sitesinde kullanılacak renk modunun RGB olması göz 
önünde bulundurularak algılanabilirlik ve okunabilirlik için gerekli kontrastlık sağlanacak nitelikte 
olmalıdır. Web sitesi sayfaları eskiz çalışmaları seçilen renklere uygun şekilde renklendirildikten sonra 
müşteri sunumu hazırlanmalıdır (Görsel 1.11). Birden fazla seçenek sunulması karar aşaması için 
önemlidir.

Görsel 1.11: Web sitesi için belirlenen renk paleti doğrultusunda renklendirilmiş arayüz (layout) örneği

1.2.4. Web Arayüzlerinde Görsel Materyallerin Yerlerini Gösterme
Web sayfası tasarımlarında denge ve bütünlük adına tipografik düzenleme önemli bir konudur ve 
hareketli ya da hareketsiz tüm görsel materyaller düz metinlere oranla daha dikkat çekicidir. Bu 
bağlamda materyal konumu özellikle bilgi içerikli metin düzenlemesi için önemlidir (Görsel 1.12). 

Görsel 1.12: Materyal konumlandırma
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UYGULAMA ADI: Anasayfa Taslağı Hazırlama

AMAÇ: Anasayfa taslağı sayfa menüleri hazırlama ve arayüzleri göstermek. 

Araç Gereç

1. Bilgisayar

2. Web sayfası arayüz oluşturma programı

3. Haricî bellek 

4. Uygulamada hazırlanan görsel materyaller

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak anasayfa taslağı, sayfa 
menüleri hazırlayınız.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma ala-
nınızı ve araç gerecinizi hazırlayınız. 

2.	 Bilgisayarı çalışmaya hazır hâle getiriniz. 

3.	 2. uygulamada hazırladığınız görsel materyalleri, web sayfasında kullanmak için 
hazırlayınız.

4.	 Web sayfasında kullanılacak tipografik ögelerin konumlandırılmasına dikkat edi-
niz. 

5.	 Görsel materyallerin tipografik ögelerle ilişkisine ve konumlandırılmasına dikkat 
ediniz.

6.	 Ana sayfa ve menülerin bütünlüğüne dikkat ediniz.

7.	 RGB renk modunu kullanınız.

8.	 Ana sayfa ve tüm içerik sayfaları, belirlediğiniz renk paletine göre renklendirilme-
sine dikkat ediniz.

9.	 Düzenlemenizi uygun formatta kaydediniz.

 DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 
1’deki Kontrol Listesi 3’ün ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken 
bu ölçütleri dikkate alınız. 

1.3. UYGULAMA
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1.3. TASARIMIN OLUŞTURULMASI
Seçilen eskiz çalışma, bilgisayar ortamına aktarılıp üzerinde uygulamalar yapılarak geliştirilir. Çalış-
manın, orijinal hâline gelebilmesi için bilgisayar ortamında tasarımın oluşturulması, ardından 
prototip (ilk örnek) olarak yayımlanması, gerekli durumlarda ekip arkadaşlarıyla paylaşılması gerekir. 
Bunları yapmak için geniş bir yelpazeye sahip “deneyim tasarımı” programı uygundur. Deneyim 
tasarımı programı aynı zamanda web editör programı, interaktif içerik oluşturma programı, piksel 
tabanlı görsel düzenleme programı ve vektörel tabanlı düzenleme programıyla eş güdümlü çalışma 
imkânı sunar. 

1.3.1. Deneyim Tasarımı Programı Tanıtımı
Profesyonel bir çalışma oluşturulmak istendiğinde deneyim tasarımı programı (Görsel 1.13) ve diğer 
düzenleme programları eş güdümlü olarak kullanılmalıdır.

Deneyim tasarımı programında, kullanım için birçok cihaza yönelik ekran tasarımı oluşturulabilir. 
Farklı cihazlar seçilebileceği gibi farklı ekran boyutları ve işletim sistemleri de seçilebilir. Ayrıca 
duyarlı web sitesi arayüz tasarımı da oluşturulabilir (Görsel 1.14).

Görsel 1.13: Deneyim tasarımı programı arayüzü

Görsel 1.14: Web arayüzü tasarımı
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Deneyim tasarımı programında Start a new document bölümünden, çalışma alanı için cihaz çeşidi 
ve ölçüsü seçilir (Görsel 1.15). 

Görsel 1.15: Yeni çalışma alanı için farklı cihaz ve ölçü seçenekleri

Görsel 1.16: Çalışma alanı ekranı

Deneyim tasarımı programında; (Görsel 1.16) üst kısımda menü ve mod olmak üzere iki, alt kısımda 
ise sol, orta ve sağ olmak üzere üç bölüm mevcuttur.
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Menü; File dosya, Edit program ve genel, Object nesne, 
Plugins eklenti, View çalışma alanı görüş ve Window 
pencere özelliklerinin düzenlenebildiği komutları içerir.  

Mod; Design tasarım, Prototype ilk örnek bağlantı ve Share 
3. kişilerle (ekip arkadaşları, müşteri gibi) paylaşma özellik-
lerini içerir.

Sol panel; bileşen ekranı, araç kutusu, eklentiler, katmanlar 
ve tasarımda kullanılan öge listesi mevcuttur (Görsel 1.17). 

Orta bölümde; çalışma yüzeyi (artboard) mevcuttur (Görsel 
1.18).

Görsel 1.17: Sol panel

Görsel 1.18: Orta bölüm

Görsel 1.19: Sağ panel

Sağ panel, seçili ögeler üzerinde işlem yapılabilecek özel-
likler paneli mevcuttur (Görsel 1.19).



35

WEB ARAYÜZÜ

1.3.2. Yeni Belge Açma
Bir web arayüzü tasarımının duyarlı olabilmesi, kullanılan tasarım elemanlarının cihazla uyumlu olma-
sıyla sağlanmalıdır. Tasarım elemanlarının, esnek grid sistemi kullanılarak belli bir standart ölçekleme 
sistemine göre yerleştirilmesi ve hizalanması gerekir. Grid tabanlı tasarımın çalışma ilkesi hizalamaya 
dayanır.

Esnek grid sistemi, matematiksel oran ve eşitliklere dayanan bir hesaplamayla tasarım ögelerinin 
piksel tabanlı ekranlarda en doğru biçimde düzenlenmesi için gereklidir. Bu hesaplamalarla oluş-
turulan grid sistem, arayüz tasarım elemanlarının üzerinde istenen değişikliklerin kısa sürede yapıl-
masını ve göze hoş gelen bir düzende hazırlanmasını sağlar. 

Web tasarımının her cihaza uyum sağlayabilmesi için Nathan Smith tarafından duyarlı web tasarımı 
için geliştirilen 960 grid sistemi, birçok değere bölünebilmesi ve sütun (Esnek grid sisteminin en 
küçük birimidir.) kullanılarak tasarlanabilmesi sebebiyle en çok kullanılan sistemdir. Sistem ayrıca 
960 piksellik bir web arayüz üzerinde çalışma alanının genişliğine (content width), kenar boşluk-
larına (margin), sütunlar arası genişliğe (gutter width), sütun genişliğine (column width) ve sütun 
sayı (number of columns) değerlerinin belirlenmesine de yardımcı olur. Web bölümünden 960’ın katı 
olan 1.920 piksel seçilebilir (Görsel 1.20).

Görsel 1.20: Yeni arayüz ölçüsü

1.3.3. Seçim Aracıyla Nesne Düzenleme, Araç ve Panellerle Grid 
	 Sistemi Düzenleme
Deneyim tasarımı programında sol panelde yer alan Select Tool (Görsel 1.21) ile seçme ve taşıma 
işlemleri yapılabilir. Select tool ile seçili hâle getirilen öge ya da ögeler sağ panelde yer alan Özel-
likler paneliyle düzenlenebilir. Özellikler panelinden yapılabilecek işlemler, seçili olan öge ya da 
ögelere göre değişkenlik gösterir. Özellikler panelinden hizalama, konum, ölçü, renk vb. özellikler 
düzenlenebilir.

 Görsel 1.21: Select tool
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Yeni oluşturulan web sayfasında iken artboard içerisinde farenin sol tuşu ile çift tıklanır ve Grid pane-
linden Layout seçeneği seçilerek aktif hâle getirilir.

Grid Panelinde Örnek Hesaplama: 960 grid sistem kullanılarak hazırlanan bir 960 piksellik sayfanın, 
60 piksel genişliğinde 12 sütuna bölündüğü, sütunlar arası genişliğin 20 piksel ve kenar boşlukla-
rının 10 piksel olduğu varsayıldığında çalışma alanı 940 piksel olur. 12 sütun 4 kısma bölünerek üçer 
sütunluk sınıflar oluşturulur. Bu durum matematiksel olarak 3 + 3 + 3 + 3 = 12 şeklinde ifade edilir. 
Sistemdeki sayısal değerler baz alınarak tasarım yapıldığında container içinde yer alan logo, navi-
gasyon, ana içerik, üst bilgi, yan çubuk ve alt bilgiye ait bölümlerin yerleşimi kolaylaşır.

Duyarlı web sayfa tasarımı oluşturma aşamasında referans olması açısından çalışma yüzeyi Görsel 
1.22’deki gibi 12 kolona bölünür.

Görsel 1.22:Grid sistemi

1.3.4. Bitmap Araçları, Nesne Özellikleri, Bilgi Paneli, Resim Boyutu, 
Damga Aracı Kullanımı

Piksel Tabanlı Programda Düzenleme

Lasso tool, görselin tamamı yerine belirli bölgelerinde işlem yapabilmek için kullanılabilir. Control 
panelinden, seçim ya da çizim alanı ölçüsünde artırma, azaltma vb. işlemler yapılabileceği gibi 
opacity ayarıyla geçiş değeri verilebilir. Seçmek ya da çizmek istenen şekle göre kullanım farklılığı 
gösteren şu üç çeşidi mevcuttur: 

Lasso tool, serbest kullanılabilen seçim ve çizim aracıdır (Görsel 1.23). 

Polygonal lasso tool, düz kenarlarda kullanılabilen seçim ve çizim aracıdır.

Magnetic lasso tool, renk ton değerine göre kullanılabilen seçim ve çizim aracıdır.

Görsel 1.23: Lasso tool
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Transform; görsel ya da nesnenin genişlik, yükseklik, yatay eksende ve dikey eksende konumu, 
döndürme, aynalama vb. özelliklerinin verilebildiği paneldir (Görsel 1.24).  

Görsel 1.24: Transform

Image size, görsel ya da nesnenin boyutlarının görüntülenip herhangi bir netlik kaybına uğramadan 
yeniden boyutlandırılabildiği paneldir (Görsel 1.25).

Görsel 1.25: İmage size

Stamp tool, görselin seçili bazı bölümlerini istenen alana klonlamak için kullanılan araçtır (Görsel 1.26). 
Kopyalanmak istenen görsele göre değişkenlik gösteren şu iki çeşidi mevcuttur:

Clone stamp tool, mevcut görselden kopyalanan bölümü istenen alana klonlamak için kullanılır.

Pattern stamp tool, seçilmiş farklı bir görseli ya da deseni istenen alana kopyalamak için kullanılır. 

Görsel 1.26: Stamp tool
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1.3.5. Vektör Araçlarını Kullanarak Çizimler Yapma
Deneyim tasarımı programında web arayüz background tasarlamak için bir takım vektörel çizim 
araçları mevcuttur. Bu araçlar şunlardır:

Rectangle tool, dikdörtgen ve kara çizimler oluşturmak için kullanılır. Farenin sol tuşu ile serbest 
ölçülü dikdörtgen, farenin sol tuşu ve shift ile kare çizimler yapılabilir. Çizilen ögenin özellikleri ise 
özellikler panelinden düzenlenir.

Görsel 1.27: Rectangle tool

Ellipse tool, elips ve daire çizimler oluşturmak için kullanılır (Görsel 1.28). Farenin sol tuşu ile serbest 
ölçülü elips, farenin sol tuşu ve shift ile daire çizimler yapılabilir. Çizilen ögenin özellikleri ise özel-
likler panelinden düzenlenir.

Görsel 1.28: Ellipse tool
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Polygon tool, çok kenarlı çizimler oluşturmak için kullanılır. Çizilen ögenin özellikleri ise özellikler 
panelinden düzenlenir (Görsel 1.29).

Görsel 1.29: Polygon tool

Line tool, düz çizimler oluşturmak için kullanılır. Çizilen ögenin özellikleri ise özellikler panelinden 
düzenlenir (Görsel1.30).

Görsel 1.31: Pen tool
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Vektörel çizim araçları kullanılarak Görsel 1.32’deki gibi web arayüz background tasarımları oluştu-
rulur.

Görsel 1.32: Web arayüz background

1.4. GÖRSELLER ÜZERİNDE İŞLEMLER 
Görsel düzenlemesinde, profesyonel bir çalışma için görselin “düzenlenebilir” formatına uygun 
düzenleme programları tercih edilmelidir. Deneyim tasarımı programı diğer görsel düzenleme prog-
ramları ile eş güdümlü çalışma imkânı sunar.

Web sitesi bir sayfadan oluşabileceği gibi (Bu durumda web sayfası adını alır.) birden fazla sayfadan 
da oluşabilir. Bu durum sitede olması istenen içeriğe göre değişkenlik gösterir. Çok sayfadan oluşan 
bir web sitesi içeriğinde kullanılan görseller de sayıca artar. 

Deneyim tasarımı programında web arayüzü tasarımında birden fazla sayfa (anasayfa ve içerik 
sayfaları olmak üzere web sitesine ait tüm sayfaların arayüzleri) tasarlanabilir. Bu durumda görseller, 
ilgili düzenleme programında düzenlenerek arayüzde gösterilebilir.

1.2. ETKİNLİK 
Grafik tasarımcı olarak kendi web sitenizi tasarladığınızı varsayınız. 
Kişiliğinizi ve çalışmalarınızı yansıtan, web sitenizin arka planını 
(background) vektörel bir çizim programında tasarlayınız.
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1.4.1. Katman Paneli ve Renk Seçenekleri Ayarları
Deneyim tasarım programında her bir artboard bir web sayfası olarak tasarlanır. Sol panelde artboard 
(çalışma yüzeyi) aracının seçilmesiyle sağ panele, açılabilecek artboard ölçü seçenekleri gelir. İstenen 
ölçü seçilerek yeterli sayıda artboard açılabilir. Bu şekilde çalışma alanına istenen ölçüde ve sayıda 
artboard eklenebilir (Görsel 1.33).

Görsel 1.33: Artboard

Layer, deneyim tasarımı programında katmanlar her bir artboard içerisinde sıralanır. Artboard 
içerisine konumlandırılan her bir öge, sol panelde bir katman olarak işlem görecektir (Görsel 1.34).

Görsel 1.34: Layer
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Appearance; deneyim tasarımı programında sağ panelde renklendirme düzenlemesinin yapıldığı 
bölümdür. Renk düzenlemesi yapılacak öge seçilir. Opacity ile şeffaflık, blend mode ile karışım 
modu, fill ile dolgu rengi, border ile çerçeve rengi, pick color from screen ile ekranın belli bölü-
münden renk seçimi ve effects ile arka plan renk etkisi düzenlemesi yapılabilir (Görsel 1.35). 

Görsel 1.35: Appearance

Görsel 1.36: Web sayfası background tasarımları
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1.4.2. Nesneleri Hizalama ve Çoğaltma, Şekilleri Birleştirme, 
Parlaklığı Değiştirme, Bir Yol Boyunca Metin Ekleme ve Metni 
Yollara Dönüştürme 

Align, sağ panelde yer almakla birlikte artboard içerisinde bulunan bir nesneyi hizalamak için kulla-
nılır. Dikeyde top, middle ve bottom yatayda ise left, center ve right seçenekleriyle yapılabilir 
(Görsel 1.37).

Görsel 1.37: Align paneli

Path, sağ panelde bulunmakla birlikte birden fazla nesne üzerinde biçimlendirme işlemi yapmak 
için kullanılır (Görsel 1.38). Add ile ekleme, Subtract ile çıkarma, Intersect ile kesişim, Exclude 
overlap ile kesişimi hariç tutma gibi seçenekleri mevcuttur.

Görsel 1.38: Path paneli

Repeat grid; sağ panelde bulunur, tekrarlayan ögeler oluşturmak için kullanılır (Görsel 1.39). 

Görsel 1.39: Öge tekrarı 

Opacity; sağ panelde bulunur, seçili rengin şeffaflık derecesini düzenlemek için kullanılır (Görsel 1.40).

Görsel 1.40: Opacity paneli
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Vektörel Tabanlı Programda Düzenleme

Type; vektörel tabanlı programda bulunan, metin ekleme ve tipografik düzenleme yapabilmek için 
kullanılan bir araçtır (Görsel 1.41). 

Görsel 1.41: Type paneli

Şekil ya da yol üzerine imleç konumlandırılarak metin yazılır. Type on a path options panelinden yola 
hizalama, etki, çevirme ve aralık düzenlemesi yapılır (Görsel 1.42).

Görsel 1.42: Type on a path options paneli
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Deneyim tasarımı programında gelişmiş mevcut özellikler, diğer grafik düzenleme programları ile 
senkronize kullanılarak Görsel 1.43’teki gibi farklı web arayüz tasarımları yapılabilir.

Görsel 1.43: Web arayüz tasarımları
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Görsel 1.44: 

Görsel 1.45: 
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UYGULAMA ADI: Anasayfa Taslağı Hazırlama

AMAÇ: Anasayfa taslağı sayfa menüleri hazırlamak ve arayüzleri göstermek. 

Araç Gereç

1. Bilgisayar

2. Web sayfası arayüz oluşturma programı

3. Haricî bellek 

4. Uygulamada hazırlanan görsel materyaller

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak belirlediğiniz bir alan için web 
sitesi tasarımı yapınız.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı 
ve araç gerecinizi hazırlayınız. 

2.	 Bilgisayarı çalışmaya hazır hâle getiriniz. 

3.	 Web sayfasında kullanılacak tipografik ögelerin konumlandırılmasına dikkat ediniz. 

4.	 Görsel materyallerin tipografik ögelerle ilişkisine ve konumlandırılmasına dikkat edi-
niz.

5.	 Ana sayfa ve menülerin bütünlüğüne dikkat ediniz.

6.	 RGB renk modunu kullanınız.

7.	 Ana sayfa ve tüm içerik sayfaları, belirlediğiniz alana uygun renk paletine göre renk-
lendirilmesine dikkat ediniz.

8.	 Düzenlemenizi uygun formatta kaydediniz.

9.	 Çalışmanız süresince zamanınızı doğru planlayınız.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 3’ün ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

1.4. UYGULAMA
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A) Aşağıda verilen cümlelerin başındaki parantezlere cümleler doğru ise “D”, yanlış ise “Y” 
yazınız.

1. (   ) Duyarlı web tasarımı web sayfalarının çeşitli cihazlarda, pencere ya da ekran boyutlarında iyi 
işlenmesini amaçlayan yaklaşımdır. 

2. (   ) Genel ağ bilgisayarları birbirine bağlayan elektronik iletişim ağıdır.

3. (   ) Genel ağ ortamında her bilgisayarın IP numarası aynıdır. 

4. (   ) URL evrensel kaynak belirleyicidir. 

B) Cümlelerde yer alan boşlukları uygun ifadelerle doldurunuz.

5. Web sitesi türleri; .......................................................................  sitelerdir.

6. Web sitesine .......................................................................    formatlarda grafikler oluşturulur.

7. Web sitesinde .......................................................................   renk modu kullanılır.

8. Web sitesi .......................................................................  kullanıcıların siteyi ziyareti esnasında ilk karşıla-
şacağı sayfadır.

9. Ana sayfada .......................................................................   verilen her menü için görüntülenebilen bir web 

C) Aşağıdaki verilen soruların doğru cevaplarını işaretleyiniz. 

10. Aşağıdakilerden hangisi veri saklama ve yayımlama işlemine verilen addır? 

A) DNS 

B) Domain

C) Server

D) URL

E) Web hosting   

11. Aşağıdakilerden hangisi bilgisayar ile kullanıcı arasında etkileşim köprüsü görevi gören 
grafik tasarım disiplinidir? 

A) Arayüz

B) Domain

C) Plastisite

D) Hosting   

E) Web server 

ÖLÇME VE DEĞERLENDİRME
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12. Aşağıdakilerden hangisi web için hazırlanan ve web tarayıcısı kullanılarak görüntülene-
bilen metin, görsel ve animasyon şeklinde içeriklere sahip dokümandır? 

A) DNS 

B) Domain

C) Web browser

D) Web hosting   

E) Web sayfası

Ç) Aşağıda verilen soruların cevaplarını noktalı yerlere yazınız.

13. Arayüz taslağı hazırlarken renklendirmede dikkat edilmesi gerekenleri açıklayınız.

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

14. Web sayfası tasarımında kullanılacak görsel materyallerin hazırlanma aşamaları nelerdir? 
Açıklayınız.

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

15. Deneyim tasarımı programını açıklayınız.

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................
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KONULAR

2.1. DÜĞMELER

2.2. GRAFİKLER

2.3. AKTARMA İŞLEMİ VE OPTİMİZASYON 

2.4. HAREKETLİ RESİMLER

2.5. AÇILIR MENÜLER

TEMEL KAVRAMLAR
•	 Buton

•	 Dilimleme 

•	 Export

•	 Image map

•	 Motion tween

•	 Movie clip

•	 Sembol

•	 Shape tween

•	 Optimizasyon

NELER ÖĞRENECEKSİNİZ?
•	 Web sayfasına uygun düğmeleri oluşturma

•	 Düzenlemede belirlenen etkin resim bölgelerini oluşturma 

•	 Aktarma ve optimizasyonu en uygun şekle sokma

•	 Düzenlemede belirlenen hareketli resimleri oluşturma

•	 Açılır menüleri oluşturma

2.
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Hazırlık Çalışmaları
1.	 Herhangi bir web sitesinin beğendiğiniz ya da beğenmediğiniz özellikleri nelerdir? 

2.	  Bir web sitesinden beklentilerinizi sınıf arkadaşlarınızla paylaşınız.

3.	  Sosyal medyada hareketli görüntü oluşturmak için hangi uygulamaları kullanıyorsunuz? 

4.	  Sosyal medyada kullanılan statik görüntüler ve hareketli görüntüler arasındaki farklar 
nelerdir? Fikirlerinizi sınıf arkadaşlarınızla paylaşınız.



2.Öğrenme Birimi
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2.1. DÜĞMELER
Web2.0; interneti etkileşimli bir hâle getirmiş ve HTML 5, CSS 3 gibi teknolojilerle etkileşimli web 
platformları oluşturulmasını sağlamıştır. Web3.0 ise güven gerektirmeyen bir alt yapıya dayalı yeni 
etkileşim paketleri ile tamamen merkezî olmayan bir web olarak geleceğin internetini oluşturmuştur.

Oluşturulmak istenen web sitelerinin arayüz, içerik ve alt yapı koşullarının web3.0 internetine uygun 
olarak tasarlanması her açıdan (tasarımcı / kullanıcı) yerinde bir karardır. 

Web sayfalarında butonlar (düğme) çok basit ya da karmaşık olabilen, bir bağlantıyı açmak ya da bir 
filmi kontrol etmek için kullanılan sembollerdir. 

2.1.1. İnteraktif İçerik Oluşturma Programı
Profesyonel bir web tasarımı için içerikte kullanılan web araçlarının, vektör tabanlı animasyon ve 
interaktif içerik oluşturma yazılımında oluşturulması oldukça önemlidir. Actionscript (ekşınsıkript) 
kodlama desteği sunan interaktif içerik oluşturma programı; raster grafikleri, vektörel grafik, zengin 
metin ve animasyon hazırlama, ses ve video ekleme ve bunları web siteleri, web uygulamaları, zengin 
internet uygulamaları ve video yayınlarını yayımlamak için kullanılır. Aynı zamanda diğer düzenleme 
programları ile eş güdümlü çalışma imkânı sunar. 

İnteraktif içerik oluşturma programının üst kısmında menü, sol bölümde araçlar, sağ bölümde 
paneller ve alt bölümde Timeline (zaman çizelgesi) vardır (Görsel 2.1).

Görsel 2.1: Programı arayüzü

Menü bölümünde; dosya, düzen, görünüş, ekleme, değiştirme, yazı, komutlar, kontrol, hata ayıklama 
konularında işlem yapılabilecek komutlar mevcuttur. 

Sol bölümde, sahnede animasyon ögeleri oluşturabilmek için gerekli araçlar mevcuttur.

Sağ bölümde, animasyon oluşturma esnasında gerekli paneller mevcuttur.

Alt bölümde, animasyon oluşturulması için gerekli zaman çizelgesi mevcuttur.
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İnteraktif içerik oluşturma programında yeni bir sayfa oluşturmak için File>New ya da Ctrl+N kısayolu 
kullanılabilir. New Document panelinden; platform, ölçü, kare hızı (saniye başına düşen kare sayısı), 
platform tipi belirlenebilir (Görsel 2.2).

Görsel 2.2: New Document paneli

İnteraktif içerik oluşturma programında, diğer grafik tasarım programlarından farklı olarak zaman 
çizelgesi anlamına gelen Timeline paneli mevcuttur (Görsel 2.3). Çalışmanın katmanlar ve kare-
lerdeki içeriğinin zaman içindeki durumları Timeline paneliyle düzenlenebilir ve kontrol edilebilir.

Görsel 2.3: Timeline paneli

İnteraktif içerik oluşturma programında, çalışma sahnesinde ön izleme için Timeline panelinden 
Play ya da klavyeden Enter, tarayıcıda ön izleme için Control>Test Movie>In Browser ya da F12 
kullanılır.

İnteraktif içerik oluşturma programında, farklı formatlarda kayıt yapılabilir. Çalışmanın kullanılacağı 
ya da aktarılacağı ortam özelliklerine göre kayıt yapmak gerekir.

1.2. ETKİNLİK 
İnteraktif içerik oluşturma programını inceleyiniz.

İnteraktif içerik oluşturma programının diğer grafik düzenleme prog-
ramları ile farklılıklarını bulunuz.

Bulduğunuz sonuçları sınıfta arkadaşlarınızla paylaşınız.
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2.1.2. Düğme Oluşturma
İnteraktif içerik oluşturma programında düğmeleri (buton)oluşturmak için semboller kullanılır 
(Görsel 2.4). Semboller, istendiğinde tekrar tekrar düzenlenebilen, kullanılabilen nesnelerdir. 
Nesneler; metin, grafik olabileceği gibi görsel de olabilir. 

Görsel 2.4: Düğme görselleri

İnteraktif içerik oluşturma programında üç tür sembol oluşturulabilir.

Movie Clip: Bir animasyon sahnesi içerisindeki yeniden düzenlenebilen, animasyon parçaları oluş-
turmak üzere kullanılan, etkileşimli kontroller ve sesler içeren, kendi çok kareli zaman çizelgeleri olan 
sembol türüdür.  

Buton: Çeşitli düğme durumlarıyla ilişkili grafikler oluşturulabilen ve düğmelerle eylemler ataya-
bilen, etkileşimli düğmelerin oluşturulabildiği ve zaman çizelgesi olan sembol türüdür.  

Grafik: Zaman çizelgesi kullanılmayan, statik görüntülerden oluşan sembol türüdür. Diğer sembol 
türlerine göre dosya boyutu olarak az yer kaplar.

Çalışma sayfasına sembol eklemek için Insert>New Symbol, Ctrl+F8 ya da nesne üzerinde farenin 
sağ tuşuyla Convert to symbol kullanılabilir. Create New Symbol panelinden sembolün adı, türü 
(animasyon, buton, grafik), kaydedileceği dosya belirlenebilir (Görsel 2.5). 

Görsel 2.5: Convert to symbol paneli

2.2. ETKİNLİK 
Genel ağ ortamında düğme çeşitlerini inceleyiniz.
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UYGULAMA ADI: WEB SAYFASI DÜZENLEMELERİNE UYGUN DÜĞMELERİ OLUŞTURMA

AMAÇ: Çizimi sembole dönüştürmek.

Araç Gereç

1. Bilgisayar

2. İnteraktif içerik oluşturma programı

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak kendi oluşturacağınız bir 
çizimi sembole dönüştürünüz.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı 
ve araç gerecinizi hazırlayınız. 

2.	 Sembol hâline getireceğiniz şeklin eskizini çiziniz.

3.	 Eskizi interaktif içerik oluşturma programına aktarınız.

4.	 Eskizi interaktif program araçlarını kullanarak eskizi çiziniz

5.	 Eskizi renklendiriniz.

6.	 Işığı ya da yansımayı hazırlayınız.

7.	 Çizimi sembole çeviriniz

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 4’ün ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

2.1. UYGULAMA
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Create New Symbol panelinden Button seçilir ve sembol sahnesinde buton olarak kullanılmak 
istenen grafik oluşturulur. 

Web sayfalarında kullanılan butonların dört farklı durumu vardır (Görsel 2.6): 

Up: Butonun ilk durumudur.

Over: Fareyle üzerine gelindiğindeki durumudur.

Down: Fareyle tıklandığındaki durumudur.

Hit: Fareyle tıklandığındaki etki alanı durumudur. Gizli buton durumlarında tercih edilir.

Görsel 2.6: Buton durumları

Diğer üç durum tasarlanmasa bile sadece Up durumunda oluşturulan bir buton, buton işlevi görür 
(Görsel 2.7).

İkinci durum için buton sembolündeyken Timeline panelinde Over karesinde farenin sağ tuşuyla 
İnsert Keyframe (anahtar kare) eklenir. Keyframe, durumda değişiklik yapmak istendiğinde eklenir.  
Sembol sahnesindeyken buton grafiğinde durum değişikliği yapılır (Görsel 2.8).

Görsel 2.7: Buton Up durumu Görsel 2.8: Buton Over durumu
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Üçüncü durum için buton sembolündeyken Timeline panelinde Down karesinde farenin sağ tuşuyla 
İnsert Keyframe buton grafiğinde durum değişikliği yapılır (Görsel 2.9).

Dördüncü durum için buton sembolündeyken Timeline panelinde Hit karesinde farenin sağ tuşuyla 
İnsert Keyframe buton grafiğinde durum değişikliği yapılır (Görsel 2.10).

Görsel 2.10: Buton Hit durumu

Görsel 2.9: Buton Down durumu
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UYGULAMA ADI: WEB SAYFASI DÜZENLEMELERİNE UYGUN DÜĞMELERİ OLUŞTURMA

AMAÇ: Buton çizimi yapma.

Araç Gereç

1. Bilgisayar

2. İnteraktif içerik oluşturma programı

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak kendi oluşturacağınız bir çizimi 
butona dönüştürünüz.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı 
ve araç gerecinizi hazırlayınız. 

2.	 Buton hâline getireceğiniz şeklin eskizini çiziniz.

3.	 Eskizi bilgisayara aktarıp interaktif içerik oluşturma programında çiziniz.

4.	 Çizdiğiniz butonu sembol hâline getiriniz.

5.	 Çalışmanızı  program formatında kaydedip öğretmeninize gösteriniz.

6.	 Çalışma alanınızı  temiz ve düzenli bırakınız.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 4’ün ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

2.2. UYGULAMA
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Metinler, butona dönüştürülebileceği gibi buton üzerinde isim olarak da kullanılabilir. Araç kutu-
sundan Text Tool ile metin eklenir (Görsel 2.11), Properties panelinden metin özellikleri düzenlene-
bilir (Görsel 2.12).

Görsel 2.11: text tool

Görsel 2.12: Metin ekleme

Görsel 2.13: Properties paneli
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UYGULAMA ADI: WEB SAYFASI DÜZENLEMELERİNE UYGUN DÜĞMELERİ OLUŞTURMA

AMAÇ: Buton üzerine yazı ekleme.

Araç Gereç

1. Bilgisayar

2. İnteraktif içerik oluşturma programı

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak kendi oluşturacağınız bir çizimi 
butona dönüştürünüz. 

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı 
ve araç gerecinizi hazırlayınız. 

2.	 Buton hâline getireceğiniz şeklin eskizini çiziniz.

3.	 Eskizi bilgisayara aktarıp interaktif içerik oluşturma programında çiziniz.

4.	 Butonun çizim ve renklendirme işlemlerini bitiriniz.

5.	 Yazmak istediğiniz sözcüğü butona ekleyiniz.

6.	 Çizdiğiniz butonu sembol hâline getirip tüm işlemleri bitirdikten sonra çalışma sayfasını 
kaydediniz.

7.	 Atölyeyi temizleyip çalışmanızı öğretmeninize gösteriniz.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 4’ün ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

2.3. UYGULAMA
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İnteraktif içerik oluşturma programında çalışma ve sembol sahnesi farklı sahneleri ifade eder (Görsel 
2.14). Sembol sahnesine geçiş yapabilmek için üzerine farenin sol tuşuyla çift tıklamak, çalışma 
sahnesine geri dönmek için boş alan üzerine farenin sol tuşuyla çift tıklamak yeterlidir (Görsel 2.15).

Görsel 2.14: Çalışma sahnesi Görsel 2.15: Sembol sahnesi

Semboller, Library paneline kaydedilir (Görsel 2.16). Düzenleme yapabilmek için panelde sembol 
isminin solundaki simgeye tıklamak yeterlidir. Panelde, üzerine fareyle çift tıklanıp, seçili hâle getiri-
lerek isim değiştirilebilir. Semboller, düzenleme yapılarak farklı kaydedilebilir ve silinebilir. 

Görsel 2.16: Library paneli
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Library panelinde mevcut bir sembol, sürükle bırak yöntemiyle farklı çalışma sahnelerinde kullanı-
labilir (Görsel 2.17).

Görsel 2.17: Buton sembolünün çalışma sahnesinde kullanımı

İnteraktif içerik oluşturma programında, File>Import to Library komutuyla farklı programlarda 
oluşturulmuş, farklı formatlarda grafikler program içerisine aktarılarak kullanılabilir (Görsel 2.18). 

Görsel 2.18: Import to Library
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Dosya seçildikten sonra Import panelinden özellikler belirlenerek Library paneline aktarılır (Görsel 
2.19, 2.20).

Görsel 2.19: İnteraktif içerik oluşturma programında import

Görsel 2.20: Library paneli 
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Çalışma sayfasına getirilen grafik, Convert to Symbol (F8) ile sembole dönüştürülerek düzenlene-
bilir (Görsel 2.21).

Görsel 2.21: Aktarılan grafiğin sembole dönüştürülmesi

İnteraktif içerik oluşturma programında butona bağlantı eklemek için Action Script kullanılmalıdır. 
Buton, çalışma sahnesine konumlandırılır ve seçili hâle getirilir. 

Properties panelinden Instance name bölümünden butona isim verilir. Window>Code Snippets 
paneli açılır (Görsel 2.22). Code Snippets panelinden ActionScript>Actions>Click to Go to Web 
Page komutu ile bağlantı kodları program tarafından yazılır. 

Görsel 2.22: Code snippets paneli
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Görsel 2.23: Actions paneli

Actions panelde, program tarafından eklenen kodların içerisinde açılması istenen web sitesi bağlantı 
adresi Görsel 2.24’teki gibi düzenlenmelidir. 

Görsel 2.24: Actions paneli bağlantı adresinin düzenlenmesi
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UYGULAMA ADI: WEB SAYFASI DÜZENLEMELERİNE UYGUN DÜĞMELERİ OLUŞTURMA

AMAÇ: Butona bağlantı adresi eklemek.

Araç Gereç

1. Bilgisayar

2. İnteraktif içerik oluşturma programı

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak oluşturduğunuz bir butona 
bağlantı adresi ekleyiniz.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı ve 
araç gerecinizi hazırlayınız. 

2.	 Buton hâline getireceğiniz şeklin eskizini çiziniz.

3.	 Eskizi bilgisayara aktarıp interaktif içerik oluşturma programında çiziniz.

4.	 Butona isim veriniz.

5.	 Butona bağlantı adresini ekleyiniz.

6.	 Tüm işlemler bittikten sonra çalışma sayfasını kaydediniz. 

7.	 Çalışma alanınızı  temiz ve düzenli bırakınız.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 4’ün ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

2.4. UYGULAMA
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2.2. GRAFİKLER
Web sayfalarındaki mevcut görsellerde etkin bölümler oluşturmak için Web editör programı, piksel 
tabanlı görsel düzenleme programı gibi farklı düzenleme programları kullanılabilir.

2.2.1. Image Map (Etkin Resim Noktası) Oluşturma
Image map (görüntü haritası) web uygulaması kontrolüdür. Web uygulamasında kullanılan bir 
görüntünün bölümlere ayrılması ve her bölüme link (bağlantı) verilmesidir. 

Web editör programında Image map oluşturmak için Properties paneli kullanılır (Görsel 2.25). 

Görsel 2.25: Properties paneli

Görüntü seçili hâle getirilir. 

•	 Properties paneli>Map bölümünden Rectangle Hotspot Tool ile kare ve dikdörtgen 
şeklinde alan, Circle Hotspot Tool ile daire şeklinde alan, Polygon Hotspot Tool ile çok 
kenarlı alan seçimi yapılır. Pointer Hotspot Tool ile seçili alanlar düzenlenir (Görsel 2.26).

•	 Properties paneli>Link seçeneğiyle bağlantıda açılması istenen dosya seçilir, Target ile 
linkin açılma şekli belirlenir. Alt ile görüntüde seçilen bölüm için açıklama metni verilir. 

Görsel 2.26: Image map paneli  
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UYGULAMA ADI: DÜZENLEMEDE BELİRLENEN ETKİN RESİM BÖLGELERİ OLUŞTURMA

AMAÇ: Image map oluşturmak.

Araç Gereç

1. Bilgisayar

2. Web editör programı

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak Image map yapınız.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı 
ve araç gerecinizi hazırlayınız. 

2.	 Uygulama yapacağınız görseli öğretmeninizle birlikte belirleyiniz.

3.	 Görseli web editör programında açınız.

4.	 Image map uygulaması için bölümlerinizi oluşturunuz. 

5.	 Ayrılan bölümlere, üzerine gelince açılmasını istediğiniz dosyayı ekleyiniz.

6.	 Çalışmanızı kaydediniz.

7.	 Çalışma alanınızı  temiz ve düzenli bırakınız.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 5’in ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

2.5. UYGULAMA

Rollover, aynı boyutta olmak şartıyla iki görüntüden oluşan, işaretçi üzerine gelindiğinde değişen 
görüntüdür. Görüntü, fareyle tıklamak ya da Rollover görüntü değiştirmek gibi farklı bir olaya yanıt 
verecek şekilde ayarlanabilir. Onmouseover (fareyle üzerine gelme) olayına yanıt vermek üzere 
otomatik olarak da ayarlanır. 
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Web editör programında, Rollover görüntü oluşturmak istenen yere imleç konumlandı-
rılır. Insert>HTML>Rollover Image ile Insert Rollover Image paneli açılır (Görsel 2.27).

Insert Rollover Image panelinde, 
Image name ile Rollover görün-
tünün adı verilir. Original image ile 
birinci görüntü seçilir. Rollover image 
ile ikinci görüntü seçilir. Preload 
rollover image ile bekleme olmaması 
için görüntüler tarayıcı önbelleğine 
önceden yüklenir. Alternate text ile 
görüntü tanımlama metni girilebilir. 
When clicked, Go to URL ile Rollover 
görüntüsü tıklandığında açılması 
istenen bağlantı adresi girilir ya da 
dosya seçilir.

Görsel 2.27: Insert Rollover Image paneli

UYGULAMA ADI: DÜZENLEMEDE BELİRLENEN ETKİN RESİM BÖLGELERİ OLUŞTURMA

AMAÇ: Rollover Image uygulaması yapmak.

Araç Gereç

1. Bilgisayar

2. Web editör programı

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak Rollover Image yapınız.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak araç gerecinizi ve 
çalışma alanınızı çalışmaya hazır hâle getiriniz.

2.	 Rollover görüntüde kullanmak istediğiniz görselleri belirleyiniz. 

3.	 Öğretmeninizle birlikte kullanılacak görsellere karar veriniz.

4.	 Web editör programını açınız.

5.	 Insert Rollover Image paneli ile görüntülerinizi getirerek düzenleyiniz ve çalışma sayfa-
nızı kaydediniz.

6.	 Atölyeyi temizleyip çalışmanızı öğretmeninize gösteriniz.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 5’in ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu 
ölçütleri dikkate alınız. 

2.6. UYGULAMA
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Piksel tabanlı görüntü düzenleme programında mevcut web araçları ile web sayfalarını ve web sayfası 
arabirim ögelerini tasarlamak için katman paneli ve dilimleme tekniği kullanılır.

Dilimleme; görüntüyü, web sayfasında HTML tablosu ya da CSS katmanları kullanılarak yeniden bir 
araya getirilebilen daha küçük görüntülere bölme işlemidir. Dilimleme işlemi, web arayüz çalışmaları 
için ya da web sayfasında kullanılacak herhangi bir görüntü için yapılabilir. Dilimlenmiş olan her bir 
görüntüye ayrı ayrı bağlantı atanabilmekle birlikte bağlantı vermeden de kullanılabilir. 

Dilimler; tablo, görüntü, görüntü yok gibi içerik türlerine göre ve kullanıcı, katman tabanlı, otomatik 
vb. oluşturulma şekillerine göre sınıflandırılır. Dilimler, Katman panelinde oluşturulursa Katman 
tabanlı dilimler, dilimleme aracı olan Slice Tool ile oluşturulursa Kullanıcı dilimleri, otomatik oluş-
turulursa Otomatik dilimler olarak adlandırılır.

Piksel tabanlı görüntü düzenleme programında web katmanı dilimler oluşturmak için, Layer pane-
linde görüntünün olduğu katman seçilir ardından Layer>New Layer Based Slice komutu kullanılır 
(Görsel 2.28). 

Görsel 2.28: Web layer paneli
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2.7. UYGULAMA

UYGULAMA ADI: DÜZENLEMEDE BELİRLENEN ETKİN RESİM BÖLGELERİ OLUŞTURMA

AMAÇ: Web layer düzenlemesi yapmak. 

Araç Gereç

1. Bilgisayar

2. Piksel tabanlı görüntü düzenleme programı

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak web layer düzenlemesi yapınız.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı 
ve araç gerecinizi hazırlayınız. 

2.	 Dilimlemek istediğiniz görüntüyü öğretmeninizle birlikte belirleyiniz.

3.	  Bilgisayarda, piksel tabanlı görüntü düzenleme programında görüntünüzü açınız.

4.	 Web katmanlarınızı oluşturunuz ve çalışma sayfanızı kaydediniz.

5.	 Çalışma alanınızı  temiz ve düzenli bırakınız.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 5’in ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

Slice tool (dilimleme aracı) (Görsel 2.29) 
ile, farenin sol tuşu kullanılarak sürük-
leme yöntemiyle görüntünün istenen 
bölümleri seçilir. Bu işlem ayrıca kılavuz 
çizgilerle alan belirlendikten sonra 
Control panelinden Slice from Guides 
komutuyla otomatik olarak da yapıla-
bilir (Görsel 2.30). Aynı görüntü üzerinde 
birden fazla seçim işlemi yapılabilir. 

Görsel 2.29: Slice Tool paneli Görsel 2.30: Slice From Guides komutu
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Slice select tool (dilim seçimi aracı) ile seçilmiş alanlar üzerinde taşıma ve düzenleme işlemleri 
yapılabilir (Görsel 2.31). Seçilmiş alan içinde farenin sağ tuşuyla açılan pencereden Delete slice ile 
dilim silme, Edit Slice Options ile açılan düzenleme penceresinden dilim adı, URL bilgisi, genişlik ve 
yükseklik vb. özellikler, Divide Slice ile yatayda/dikeyde otomatik bölme işlemi ve yeniden dilimleme 
belirlenir (Görsel 2.32). 

Dilimlenmiş görüntüler 
format biçimi, genişlik, 
yükseklik vb. görüntü 
özellikleri belirlenerek 
kaydedilir (Görsel 2.33, 
2.34).

Görsel 2.33: Divide Slice paneli

Görsel 2.32: Slice Options paneliGörsel 2.31: Dilimlenmiş görüntü

Görsel 2.34: Dilimlenmiş görüntü
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UYGULAMA ADI: DÜZENLEMEDE BELİRLENEN ETKİN RESİM BÖLGELERİ OLUŞTURMA

AMAÇ: Slice Tool ile görüntü dilimleme yapmak. 

Araç Gereç

1. Bilgisayar

2. Piksel tabanlı görüntü düzenleme programı

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak görüntü dilimleme düzenlemesi 
yapınız.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı ve 
araç gerecinizi hazırlayınız. 

2.	 Görsellerinizi öğretmeninizle birlikte belirleyiniz.

3.	 Bilgisayarda piksel tabanlı görüntü düzenleme programını açarak görüntünüzü getiri-
niz. 

4.	 Slice Tool ile dilimlemeyi yapınız. Çalışma sayfanızı kaydediniz.

5.	 Atölyeyi temizleyip çalışmanızı öğretmeninize gösteriniz.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 5’in ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

2.8. UYGULAMA

2.3. AKTARMA  İŞLEMİ VE OPTİMİZASYON
Web sayfalarıyla uyumlu ve çoğu tarayıcıda görüntülenebilir olması sebebiyle web sayfalarında 
yaygın kullanılan grafik dosya formatları Gif, Jpeg, Png ve Svg’dir. 

Görsellerin, kullanılması planlanan ortam için en uygun hâle getirilmesi işlemine optimizasyon, 
optimizasyon işleminden sonra kullanılmak istenen programa gönderme işlemine ise aktarma 
(export) denir.  
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2.3.1. Aktarma Sihirbazı
Çalışmaların, deneyim tasarımı programı ve 
piksel tabanlı görsel düzenleme programında 
optimizasyonu yapılarak web sitesinde kulla-
nılmak üzere aktarılmaları gerekir.  Aktarma 
işleminde kullanılan aktarma sihirbazları (ilgili 
paneller), seçilen dosya türüne elverişli görün-
tüleri en uygun hâle otomatik getirir ve kontrol 
seçeneği de sunar.

Deneyim tasarımı programında oluşturulan 
çalışmalar File>Export>All Artboards komu-
tuyla açılan Export Assets paneliyle aktarıla-
bilir (Görsel 2.35).

Görsel 2.35: Export Assets paneli

UYGULAMA ADI: AKTARMA VE OPTİMİZASYON İŞLEMLERİ

AMAÇ: Deneyim tasarımı programında export işlemi yapmak. 

Araç Gereç

1. Bilgisayar

2. Deneyim tasarımı programı

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak export işlemi yapınız.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı 
ve araç gerecinizi hazırlayınız. 

2.	 Daha önce yapmış olduğunuz bir arayüzü Export Assets panelini kullanarak aktarınız 

3.	 Atölyeyi temizleyip çalışmanızı öğretmeninize gösteriniz.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 5’in ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

2.9. UYGULAMA
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Piksel tabanlı görsel düzenleme programında oluşturulan çalışmalar şu iki şekilde export edilebilir:

•	 File>Export>Export Assets komutu ya da Alt+Shift+Ctrl+W kısayolu ile aktarılır: Export Assets 
panelidir (Görsel 2.36).

•	 File>Export>Save for Web ya da Alt+Shift+Ctrl+S kısayolu ile Save for Web panelidir (Görsel 
2.37).

Görsel 2.36: Export Asssets paneli

Görsel 2.37: Save for web paneli
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UYGULAMA ADI: AKTARMA VE OPTİMİZASYON İŞLEMLERİ

AMAÇ: Piksel tabanlı görüntü düzenleme programında export işlemi yapmak. 

Araç Gereç

1. Bilgisayar

2. Piksel tabanlı görüntü düzenleme programı

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak export işlemi yapınız.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı ve 
araç gerecinizi hazırlayınız. 

2.	 Daha önce yapmış olduğunuz bir arayüzü piksel tabanlı görüntü düzenleme programın-
da export aktarınız.

3.	 Atölyeyi temizleyip çalışmanızı öğretmeninize gösteriniz.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 5’in ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

2.10. UYGULAMA

2.3.2. Resim Dosya Türü, Ön İzleme Düğmesi ve Mevcut 
           Optimizasyon Ön Ayarları
Görüntülerde, yayımlanacağı ortam özelliklerine uygun dosya türü tercih edilmelidir. Bu durumda 
görüntü özelliklerinin yanı sıra genel ağla uyumlu tarayıcı özellikleri de dikkate alınarak en uygun 
dosya türü seçilmelidir. 

Bilgi notu

Tarayıcıların, genel ağ protokolleri kapsamında özellikle destek vermeyeceği 
dosya türleri kullanıldığı durumlarda, görüntü görüntülenemeyecektir. Web 
tasarımcılarının genel ağ protokolleri konusunda bilgi güncellemesi takibi 
yapmaları şarttır. 
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Web sayfalarıyla uyumlu çoğu tarayıcıda görüntülenebilen dosya türleri şunlardır:

GIF (Graphic Interchange Format): En fazla 256 renk kullanıldığından sürekli olmayan görüntüleri 
göstermek için en uygun formattır. 

Jpeg (Joint Photographic Experts Group): Milyonlarca renk içerdiğinden fotoğraf ya da sürekli 
olmayan tonlu görüntüler için en uygun formattır.

Png (Portable Network Group): Orijinal katmanı, vektörü, rengi ve alt gölge gibi efekt bilgilerini 
koruyan, dizinlenmiş renk, gerçek renkli görüntüler içeren formattır.  

Svg (Scalable Vector Graphics): Kalitesi bozulmadan yeniden boyutlandırılabilen vektör dosyası 
formatıdır. Yazıldığı kodlar nedeniyle web tasarımında buton, logo, simge, infografikler ve illüstras-
yonlar için en uygun formattır.

Piksel tabanlı görüntü düzenleme programında optimizasyon ve ön izleme için File>Export>Save 
For Web paneli kullanılır. Panelde görüntünün Original, Optimized, 2-Up ve 4-Up bölümlerinden 
farklı format karşılaştırması yapılarak ön izlemesi, Preview bölümünden ise tarayıcıda ön izlemesi 
yapılır (Görsel 2.38).   

Görsel 2.38: Save For Web optimizasyonu
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UYGULAMA ADI: AKTARMA VE OPTİMİZASYON İŞLEMLERİ

AMAÇ: Piksel tabanlı görüntü düzenleme programında optimizasyon işlemi yapmak. 

Araç Gereç

1. Bilgisayar

2. Piksel tabanlı görüntü düzenleme programı

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak optimizasyon işlemi yapınız.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı 
ve araç gerecinizi hazırlayınız. 

2.	 Daha önce yapmış olduğunuz bir arayüzü, piksel tabanlı görüntü düzenleme progra-
mında açınız.

3.	 Görüntünün optimize ayarlarını yapınız.

4.	 Çalışma sayfanızı kaydediniz.

5.	 Atölyeyi temizleyip çalışmanızı öğretmeninize gösteriniz.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 5’in ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

2.11. UYGULAMA
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Deneyim tasarımı programında File>Export>All Artboards komutuyla açılan Export Assets pane-
linden Export size komutuyla gerekli optimizasyon ayarları yapılır (Görsel 2.39).  

Görsel 2.39: Export Assets optimizasyonu

UYGULAMA ADI: AKTARMA VE OPTİMİZASYON İŞLEMLERİ 

AMAÇ: Deneyim tasarımı programında optimizasyon işlemi yapmak. 

Araç Gereç

1. Bilgisayar

2. Deneyim tasarımı programı

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak optimizasyon işlemini yapınız.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı 
ve araç gerecinizi hazırlayınız. 

2.	 Daha önce yapmış olduğunuz bir arayüzü deneyim tasarımı programında açınız.

3.	 Arayüz çalışmanızın optimizasyon ayarlarını yapınız.

4.	 Çalışma alanınızı  temiz ve düzenli bırakınız.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 5’in ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

2.12. UYGULAMA
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Deneyim tasarımı programında çalışmanın istenen aşamasında, ekran modları içinde mevcut olan 
Prototype ve Desktop Preview bölümlerinden ön izleme yapılır (Görsel 2.40). 

Görsel 2.40: Desktop preview bölümü

2.4. HAREKETLİ RESİMLER
Web için animasyonlar sağlayan eski teknolojilerin Web 3.0 teknolojisi tarafından desteklenmemesi 
temel neden olmakla birlikte, tutarlı olmaması ayrıca mobil cihazların kullanımının çoğalması, kulla-
nıcıların daha fazla performans istemesi vb. nedenlerden animasyon oluşturma ve kullanma tekniği 
değişim göstermiştir.

Animasyonlar; interaktif içerik oluşturma programı kullanılarak oluşturulabileceği gibi Web 3.0 
teknolojisiyle web editör programında da CSS3 ile oluşturulabilir. 

2.4.1. Animasyon Oluşturma
İnteraktif içerik oluşturma programında animasyon oluşturmak için semboller, katmanlar, timeline 
paneli ve komutlar kullanılır. Timeline panelinde, katmanlara hareket yeri ve çalışma zamanı belirti-
lerek animasyon oluşturulur. 

Animasyon oluşturmak için Grafik ve Movie Clip olmak üzere iki tür sembol kullanılır. Animasyonda 
Motion ile hareket, Shape ile şekil olmak üzere iki oluşum vardır. 

Timeline panelinde, hareketi oluşturan bir bütünün parçalarını oluşturmak için kullanılan Layer 
(katmanlar) ve hareket vermek ya da ses eklemek için kullanılan Frame (kareler) olmak üzere iki 
temel öge vardır. Bir frame; içeriği ile birlikte kopyalanabilir, yapıştırılabilir, silinebilir ve taşınabilir.

Animasyon oluşturma aşamasında sıklıkla kullanılan komutlar şunlardır:

Insert frame (F5) kare ekleme: İçeriğin görünmesini sağlamak için kullanılır. 

Insert keyframe (F6) anahtar kare ekleme: İçerikte küçük değişiklik yapmak için kullanılır. 

Insert blank keyframe (F7) boş anahtar kare ekleme: Sahne içeriğini tümüyle değiştirmek için 
kullanılır. 

Convert to symbol (F8) sembole dönüştürme: Nesneleri sembole dönüştürmek için kullanılır.

İnteraktif içerik oluşturma programında çalışma sahneleri; çalışma sahnesi ve kullanılan sembol-
lerin düzenlenebildiği sembol sahnesi olmak üzere farklılık gösterir (Görsel 2.41). Çalışma sahne-
sindeyken kullanılan sembol üzerinde düzenleme yapabilmek için sembolün üzerine çift tıklanıp, 
sembol sahnesine geçiş yapılarak düzenleme yapılır. Çalışma sahnesindeyken Enter butonu ile 
uygulama ön izlenebilir.

Görsel 2.41: Çalışma sahnesi ve Sembol sahnesi
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File>Import>Import to Library komutuyla kul-
lanılması planlanan görseller Library (kütüphane) 
paneline getirilir. Library panelinde mevcut görseller, 
sürükle bırak yöntemiyle sahneye getirilebilir. Sah-
nede animasyon için kullanılacak görsellerin sem-
bole dönüştürülmesi için F8 kısayolu, ölçü düzenlen-
mesi için ise Transform paneli kullanılabilir (Görsel 
2.42). Transform paneliyle genişlik, yükseklik, dön-
dürme, aynalama vb. düzenlemeler yapılabilir.

Görsel 2.42: Transform paneli

UYGULAMA ADI: DÜZENLEMEDE BELİRLENEN HAREKETLİ RESİMLERİ OLUŞTURMA

AMAÇ: İnteraktif içerik oluşturma programında import etme.

Araç Gereç

1. Bilgisayar

2. İnteraktif içerik oluşturma programı

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak yapmış olduğunuz butonu inte-
raktif içerik oluşturma programında library paneline ekleyiniz.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı 
ve araç gerecinizi hazırlayınız. 

2.	 Vektörel tabanlı tasarım programında bir buton yapınız.

3.	 Buton çizimi bittikten sonra çalışma sayfanızı kaydediniz.

4.	 Oluşturduğunuz butonu, interaktif içerik oluşturma programında import ederek library 
paneline ekleyiniz.

5.	 Çalışma alanınızı  temiz ve düzenli bırakınız.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 5’in ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

2.13. UYGULAMA
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Animasyon oluşturma aşamasında karışıklık yaşamamak 
adına sayfa içinde kullanılacak her sembol adlandırılmalı 
ve Layer panelinde de içeriğe göre adlandırma yapılma-
lıdır (Görsel 2.42). Layer paneli kullanımı yeni layer açma, 
layer silmek, layerleri gruplamak gibi düzenlemelerin yapı-
labildiği diğer düzenleme programları ile benzer kullanıma 
sahiptir. Üzerine çift tıklanarak yeni ad verilir.

Programda ölçülü çalışma için View>Rulers, View>Gri-
d>Show Grid, View>Guides komutları kullanılabilir 
(Görsel 2.43).

Görsel 2.43: Rulers ölçüsüGörsel 2.42: Layer adlandırma

İnteraktif içerik oluşturma programında yazı için Text Tool kullanılır (Görsel 2.44). Sahnede yazı ekle-
necek alana imleç konumlandırılır. Metin yazılır, düzenlemesi yapılabilecek Character ve Paragraph 
paneli Properties paneli içinde konumlandırılır, metin yazılır. Metnin düzenlemesinin yapılacağı 
Character panelinden 
yazı fontu, yazı stili 
ve boyutu, harf arası 
boşluklar, alpha, renk, 
alt-üst simge vb. dü-
zenlemeler yapılır. Pa-
ragraph panelinden 
ise hizalama, paragraf 
düzenlemeleri yapılır 
(Görsel 2.45).

Görsel 2.44: Text Tool
aracı

Görsel 2.45: Character ve Paragraph paneli
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Programda alt tuşu ile çoğaltma, shift tuşu ile birden fazla seçme işlemi yapılabilir. Aynı katmanda  
oluşturulmuş yazı ya da nesneyi farklı katmanlara almak için fare sağ tuşla açılan içerik menüsünden 
Distribute to Layers komutu ya da Ctrl+Shift+D kısayolu kullanılabilir. Yazıyla animasyon oluş-
turmak istenirse animasyon planına göre her bir sözcüğün sembole dönüştürülmesi gerekir. 

Yeni çalışma sayfası oluşturulurken verilen Frame Rate değeri, saniyede gösterilecek kare sayısını 
ifade eder (Görsel 2.46).  Sinema filmi için standart değerin 24 olması ve bu değerin webde iyi sonuç 
vermesi nedeniyle varsayılan değerdir. Farklı çalışmalar oluşturulurken bu değer değiştirilebilir. Film 
ya da animasyon; değer arttırıldığında hızlı, değer düşürüldüğünde yavaş olur.

Görsel 2.46: FPS (saniyedeki kare sayısı) değeri

İnteraktif içerik oluşturma programında web sitesi için banner (reklam bandı) tasarımı yapılabilir. 
Banner tasarımında özel ölçü çalışılabileceği gibi standart ölçülerle de çalışılabilir.

Standart banner tasarımı için çalışma sayfası File>New from Template komutuyla açılan New from 
Template panelinden açılabilir (Görsel 2.47).

Görsel 2.47: New from Template paneli
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File>New komutuyla açılan New Document panelinden, web sayfasında animasyonun frame rate 
değeri ve konumlandırılacağı alan özelliklerine göre genişlik ve yükseklik gibi değerler verilerek yeni 
sayfa açılır. 

Motion animasyonu (Görsel 2.48) oluşturmak için yapılması gerekenler şunlardır:

•	 Layer 1’de iken 1. frame üzerinde sağ tuş yapılır ve açılan içerik menüsünden Create Motion 
Tween (ara hareket oluşturma) komutu uygulanır (Görsel 2.49). Uygulanan komut Timeline 
panelinde 24 frame için geçerli olacaktır.

Görsel 2.48: Create Motion Tween paneli

•	 24. frame üzerinde fare sağ tuşla gelen içerik menüsünden Insert Keyframe>All komutu uygu-
lanır. 24. frame üzerine bir anahtar kare yerleştirilir. 

•	 24. frame üzerindeyken çalışma sahnesinde properties, transform panellerinden ölçü, konum, 
alpha, döndürme vb. değişiklikler uygulanır. 

Görsel 2.49:Motion animasyonu
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Animasyonda birden fazla Layer ile çalışılan durumlarda katmanların farklı zamanlarda hareket 
etmesi istenirse Layer’deki frame’ler shift ile seçilir ve başlaması istenen frame’e taşınır. Tüm katman-
ların animasyonun sonuna kadar görünür olması için her katman için son frame’de ya da daha ileri 
bir frame’de Insert frame eklenir (Görsel 2.50). 

Görsel 2.50: Timeline ve Layer ile frame düzenleme
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UYGULAMA ADI: DÜZENLEMEDE BELİRLENEN HAREKETLİ RESİMLERİ OLUŞTURMA

AMAÇ: Yazıya motion tween animasyonu uygulamak.

Araç Gereç 

1. Bilgisayar

2. İnteraktif içerik oluşturma programı

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak yazıya motion tween uygulayınız.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı ve 
araç gerecinizi hazırlayınız. 

2.	 İnteraktif içerik oluşturma programında motion tween uygulaması yapmak istediğiniz 
metni öğretmeninizle birlikte belirleyiniz.

3.	  Motion tween uygulaması için plan oluşturunuz.

4.	 Çalışma sayfasına metni yazınız ve düzenleyiniz.

5.	 Planınız doğrultusunda metne motion tween uygulayınız ve çalışmayı kaydediniz.

6.	 Çalışma alanınızı temiz ve düzenli bırakınız.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 5’in ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

2.14. UYGULAMA
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Shape animasyonu (Görsel 2.51) oluşturmak için şu işlemler gerçekleştirilir: 

•	 Timeline 1. framede iken sahnede şekil çizilir.

•	 Timeline’ da ileriki bir frame’ de (örnek 24. frame) Insert keyframe komutu uygulanır.

•	 Sahnede şekil üzerinde değişim yapılır ya da yeni şekil oluşturulur.

•	 Timeline’ da, orta kısımda, bir frame üzerinde Create Shape Tween komutu uygulanır.

Görsel 2.51: Shape Animasyonu

Shape animasyonlarında ilk şekil üzerinde değişiklik yapılabileceği gibi silinerek yerine farklı bir 
şekil de oluşturulabilir. Bu durumda son frame’de şekil silindikten sonra yerine oluşturulacak şeklin 
tam konumunda olması için Timeline paneli üzerinde Onion Skin (soğan zarı) komutu kullanılabilir 
(Görsel 2.52). Onion Skin komutuyla sahnede daha önceki frame’de nerede, ne olduğu görülebilir.

Görsel 2.52: Timeline Onion Skin komutu

Shape animasyonlarında şekil değişimi ile konum, renk, boyut değişimi birlikte de oluşturulabilir 
(Görsel 2.53). Bunun için son frame’deyken sahnede istenen değişimin yapılması yeterlidir.

Görsel 2.53: Shape animasyonu çoklu değişim



88

Shape animasyonları yazılarla da oluşturulabilir. Bunun için yazı formunun Modify>Break Apart 
komutuyla ya da Ctrl+B kısayoluyla şekle dönüştürülmesi yeterlidir. İlk Break Apart komutuyla ile 
sözcük harflere, ikinci Break Apart komutuyla ile harfler şekle dönüştürülür (Görsel 2.54). 

Görsel 2.54:Break Apart

UYGULAMA ADI: DÜZENLEMEDE BELİRLENEN HAREKETLİ RESİMLERİ OLUŞTURMA

AMAÇ: İnteraktif içerik oluşturma programında Shape tween uygulaması yapmak.

Araç Gereç

1. Bilgisayar

2.  İnteraktif içerik oluşturma programı

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak shape tween uygulaması yapınız.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı ve 
araç gerecinizi hazırlayınız. 

2.	 Motion tween uygulaması için plan oluşturunuz ve şekli belirleyiniz. 

3.	 Planınızı öğretmeninize gösteriniz.

4.	 Planınız doğrultusunda interaktif içerik tasarım programında ilk şekli çiziniz.

5.	 Planınız doğrultusunda motion tween uygulayınız. 

6.	  Çalışma sayfanızı kaydediniz.

7.	 Çalışma alanınızı temiz ve düzenli bırakınız.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 5’in ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

2.15. UYGULAMA
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Shape animasyonunda, şekillerdeki değişimleri kontrol edebilmek için kontrol noktası ekleme 
özelliği vardır. Şekil üzerinde istenen biçimde ve alanda değişiklik yapılmasını sağlamak için kulla-
nılan kontrol noktaları, Modify>Shape>Add Shape Hint komutu ya da Shift+Ctrl+H kısayoluyla 1. 
frame’deyken şekil üzerinde bir noktaya yerleştirilir. Son frame’de bu noktalar istenen konuma yerleş-
tirilerek animasyon oluşturulur (Görsel 2.55).

Görsel 2.55: Add Shape Hint komutu

Maske animasyonu oluşturmak için maske-
lenmek istenen görsel, çalışma sahnesine 
konumlandırılır. Maske için bir movie clip 
sembolü oluşturulur. Oluşturulacak movie 
clip sembolünün (motion ya da shape 
animasyonu) içindeki grafiğe döngüde 
kalmaması (durması) için son frame’ de iken 
Action panelinde stop(); komutu eklenme-
lidir (Görsel 2.56, 2.57). Çalışma sahnesine 
yeni layer açılır ve 1. frame’deyken maske 
sembolü getirilir. Yeni oluşturulan layer 
üzerinde fare sağ tuşla gelen menüden 
Mask komutu seçilir.

Görsel 2.56: Maske sembolü 

Görsel 2.57: Maske animasyonu
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UYGULAMA ADI: DÜZENLEMEDE BELİRLENEN HAREKETLİ RESİMLERİ OLUŞTURMA

AMAÇ: İnteraktif içerik oluşturma programında maske animasyonu yapma.

Araç Gereç

1. Bilgisayar

2.  İnteraktif içerik oluşturma programı

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak maske uygulaması yapınız.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı 
ve araç gerecinizi hazırlayınız. 

2.	 Öğretmeninizle birlikte maskelemek için görselinizi belirleyiniz.

3.	 Maske uygulaması için plan oluşturunuz.

4.	 İnteraktif içerik oluşturma programında maske yapacağınız görseli açınız. 

5.	 Planınız doğrultusunda maskeleme işleminde kullanacağınız sembolü oluşturunuz.

6.	 Görsele maske efekti uygulayınız. Çalışma sayfanızı kaydediniz.

7.	 Çalışma alanınızı  temiz ve düzenli bırakınız.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 4’ün ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

2.16. UYGULAMA

2.4.2. GIF Animasyonunu Aktarma ve Aktarma Ön İzlemesini Kullanma 
İnteraktif içerik oluşturma programında oluşturulan çalışmalar, öncelikle File>Export>Export 
Animated GIF komutuyla açılan Export Image panelinden düzenlenmeli, kaydedilerek aktarılma-
lıdır (Görsel 2.57).

Görsel 2.57: Export paneli
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Preset bölümünden format, renk, renk modu, kayıp, matlık, geçişli renk, şeffaflık vb. düzenlemeler; 
Image Size bölümünden genişlik, yükseklik vb. düzenlemeler; Color table bölümünden renk düzen-
lemesi yapılır. Animation bölümünden, animasyonun tekrar durumu düzenlenir ve kontrol pane-
liyle çalıştırılarak animasyon kontrol edilir. Son olarak Preview bölümünün browser kısmından ön 
izlemesi yapılır ve animasyon kaydedilir.

2.5. AÇILIR MENÜLER
Web siteleri ilk görünen sayfa (Index-Anasayfa) başta olmak üzere en az iki sayfadan oluşur. Anasayfada 
sabit bölümler (logo, alt bilgi gibi) ve değişken bölümler (içerik) vardır. Anasayfada, içerik sayfalarına 
bağlantı kurulabilmesi için bir açılır menü oluşturulur ve bağlantı verilir.

2.5.1. Şablon Oluşturma ve Resmi Maskeleme
Maskeleme, bir ögenin (sayfa, görüntü vb.) belirli bölümlerinin görünmesi, belirli bölümlerinin ise 
gizlenmesidir. Maskeleme işleminde maske nesnesi ve maskelenmek istenen öge olmak üzere iki 
unsur vardır.

Web sayfası arayüzünde bazı bölümlerin sabit, bazı bölümlerin ise değişken olması nedeniyle web 
sitesi tasarımında şablon oluşturulması oldukça önemlidir. 

Web editör programında şablon iki farklı şekilde oluşturulur:

•	 Assets panelinden Templates bölümü seçilir. New Template komutuyla boş bir şablon oluştu-
rulur (Görsel 2.58). Ardından gerekli düzenlemeler yapılır.

Görsel 2.58: Assets Templates bölümü
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Programa aktarılan arayüz çalışması gerekli düzenlemelerden sonra şablon olarak kaydedilir. Şablon 
olarak kullanılmak istenen sayfa açıkken File>Save as Template komutu ya da Insert>Templa-
te>Make Template komutuyla açılan Save As Template panelinden kaydedilecek site ve isim belir-
lenir (Görsel 2.59).

Görsel 2.59: Save As Template paneli

Web editör programında metnin gelmesi istenen alana imleç konumlandırılır ve metin yazılır. 
Programda ayrıca haricî yazılımlarda oluşturulmuş metinlerde Edit>Copy (Ctrl+C) ve Edit>Paste 
(Ctrl+V) komutlarıyla içeri aktarılabilir (Görsel 2.60). 

Görsel 2.60: Metin ekleme

Bilgi notu

Web arayüzüne metin eklenmesi 
durumunda kayıt aşamasında 
metinlerin grafiğe dönüşecek 
olması ve istenmeyen sonuçlar 
doğurması nedeniyle sitede kulla-
nılması planlanan metinler web 
tasarım editöründe eklenmelidir.  

Site içeriği için oluşturulan görüntülerde de maskeleme işlemi yapılabilir.  Maskeleme işlemi için maske-
lenmek istenen görüntüye ve maske nesnesine göre farklı yazılımlar kullanılabilir. 

Vektörel tabanlı tasarım programında maskeleme işlemi

Görsel materyallerde istenmeyen alanların görünmesini engellemek ya da tasarıma hareket katmak 
için yapılan maskeleme işlemi tasarımcıların sık  kullandığı bir yöntemdir.
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Vektörel tabanlı tasarım programında maskelenmek istenen görsel materyal çalışma ekranına getirilir 
(Görsel 2.61). Maske nesnesi programda hazır bulunan  ya da özel olarak çizilen şekillerden hazırlanır. 
Maskelenecek görsel alt kısımda kalacak şekilde, görsel materyal ve maske nesnesi üst üste getirilir. İkisi 
de seçiliyken farenin sağ tuşuyla açılan içerik menüsünden Make Clipping Mask komutu uygulanır. 
İstenen aşamada çalışma üzerinde düzenleme yapılabilir.

Görsel 2.61: Maskeleme

UYGULAMA ADI: DÜZENLEMEDE BELİRLENEN AÇILIR MENÜLERİ OLUŞTURMA

AMAÇ: Vektörel tabanlı tasarım programında maskeleme işlemi yapmak. 

Araç Gereç 

1. Bilgisayar

2. Vektörel tabanlı tasarım programı

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak maske işlemi yapınız.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı ve 
araç gerecinizi hazırlayınız. 

2.	 Maskeleme için öğretmeninizle görsel belirleyiniz.

3.	  Vektörel tabanlı tasarım programında maske yapacağınız görseli açınız. 

4.	 Maskeleme işleminde kullanacağınız şekli çiziniz. 

5.	 Çizim ve görseli aynı anda seçili hâle getiriniz.

6.	 Görsele maske efekti uygulayınız. Çalışma sayfanızı kaydediniz.

7.	 Çalışma alanınızı  temiz ve düzenli bırakınız.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 5’in ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu 
ölçütleri dikkate alınız. 

2.17. UYGULAMA
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Piksel Tabanlı Görüntü Düzenleme Programında Katman Paneliyle Maskeleme İşlemi 

Piksel tabanlı görüntü düzenleme programında çalışma sahnesine maskeleme yapılacak görsel 
materyali getirilir. Görsel materyalin olduğu layer seçili hâldeyken layer panelinin alt kısmında bulunan 
Add layer mask komutu uygulanır. Mask alanı seçiliyken araç kutusundan Brush tool ile (siyah renkte 
olduğundan emin olunduktan sonra) görünmesi istenmeyen alanlar boyanır (Görsel 2.62, 2.63).  

Görsel 2.62: Maskeleme

Görsel 2.63: Maskeleme

İstenen aşamada maskelenen alana başka bir görsel ya da metin eklenebilir.
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UYGULAMA ADI: DÜZENLEMEDE BELİRLENEN AÇILIR MENÜLERİ OLUŞTURMA

AMAÇ: Piksel tabanlı görüntü düzenleme programında maskeleme işlemi yapmak.

Araç Gereç 

1. Bilgisayar

2. Piksel tabanlı tasarım programı

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak maske işlemi yapınız.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı ve 
araç gerecinizi hazırlayınız. 

2.	 Öğretmeninizle birlikte maskelemek için görsel belirleyiniz.

3.	 Piksel tabanlı görüntü düzenleme programında maske yapacağınız görseli açınız. 

4.	 Görsel materyalin bulunduğu layer’dayken Layers panelinin altında bulunan Add layer 
mask komutunu uygulayınız. 

5.	 Araç kutusundan Brush tool’u alınız. Maskelemek istediğiniz alanı boyayınız. Bu işlemi 
yaparken doğru katmanda olduğunuzdan emin olunuz.

6.	 Çalışma sayfanızı kaydediniz.

7.	 Çalışma alanınızı temiz ve düzenli bırakınız.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 5’in ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

2.18. UYGULAMA
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Piksel Tabanlı Görüntü Düzenleme Programında Metne Maskeleme İşlemi 

Piksel tabanlı görüntü düzenleme programında, çalışma sahnesine maskeleme yapılacak görsel 
materyali getirilir. Maske nesnesi olarak kullanılacak metin yazılır. Layer panelinde metin katman 
penceresindeyken fare sağ tuşla açılan içerik penceresinden Select Pixels komutuyla metin seçili 
hâle getirilir. Görsel materyalin olduğu katmanda iken Ctrl+C ve Ctrl+V komutlarıyla maskeleme 
işlemi tamamlanır (Görsel 2.64).

Görsel 2.64: Metinle maskeleme

UYGULAMA ADI: DÜZENLEMEDE BELİRLENEN AÇILIR MENÜLERİ OLUŞTURMA

AMAÇ: Piksel tabanlı görüntü düzenleme programında metin kullanarak maske yapmak.

Araç Gereç

1. Bilgisayar

2. Piksel tabanlı görüntü düzenleme programı

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak maske uygulaması yapınız.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı 
ve araç gerecinizi hazırlayınız. 

2.	 Maskeleme yapmak istediğiniz görüntüyü öğretmeninizle birlikte seçiniz.

3.	 Görüntüyü piksel tabanlı görüntü düzenleme programında açınız.

4.	 Maske nesnesi olarak kullanacağınız metni yazınız. 

5.	 Maskelemeyi yapınız. Çalışma sayfanızı kaydediniz.

6.	 Çalışma alanınızı  temiz ve düzenli bırakınız.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 5’in ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

2.19. UYGULAMA
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2.5.2. Açılır Menü Ekleme ve Düzenleme
Web sitesi için oluşturulmuş tüm sayfalar arasında bağ oluşturulmalıdır. Her bir web sayfası, tarayıcı 
penceresinde açılacağından arada bağ kurulmamış sayfalardan geri dönüş olamayacaktır. Bu durum 
nedeniyle mevcut bağların doğru kurulması site içerisinde gezinme açısından önemlidir. 

Bağlar sayfaları arasındaki geçiş için oluşturulabileceği gibi pdf, grafik, film, ses dosyası, metin dosyası 
vb. ögeler için de oluşturulabilir. 

İçerik sayfalarında alt bölüm sayfalarının kategori şeklinde verilmesi gereken durumlarda açılır menü 
biçimi kullanmak tasarım açısından önemlidir. Açılır menünün, web standartlarına uygunluğu göz 
önünde bulundurularak oluşturulması gerekir.

Web editör programında Insert>Bootstrap Components>Navigation>Nav Tabs with Dropdown 
komutuyla açılır menü oluşturulur. Gerekli olan kodlar program tarafından yazılır (Görsel 2.65).

Görsel 2.65: Açılır menü oluşturma

Açılır menü düzenlemesi program modu Design seçilerek yapılmalıdır (Görsel 2.66).  

Görsel 2.66: Design modu
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Açılır menü düzenlemesi için Design modundayken düzenlenmek istenen bölüm farenin sol tuşuyla 
seçili hâle getirilir ve gerekli düzenleme yapılır (Görsel 2.67).

Görsel 2.67: Design modu açılır menü düzenleme

Web editör programında, açılır menü çalışma ön izlemesi için F12 ile tarayıcıda görüntülenir (Görsel 2.68).

Görsel 2.68:Açılır menü tarayıcı ön izlemesi
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UYGULAMA ADI: DÜZENLEMEDE BELİRLENEN AÇILIR MENÜLERİ OLUŞTURMA

AMAÇ: Web editör programında açılır menü yapmak. 

Araç Gereç

1.  Bilgisayar

2. Web editör programı

GÖREV: Aşağıdaki işlem basamaklarını açılır menü yapınız.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı 
ve araç gerecinizi hazırlayınız. 

2.	 Açılır menüde kullanılacak sayfaları öğretmeninizle belirleyiniz.

3.	 Web editör programında açılır menü için sayfalarınızı oluşturunuz.

4.	 Sayfanıza açılır menüyü ekleyiniz. 

5.	 Çalışma sayfanızı kaydediniz.

6.	 Çalışma alanınızı  temiz ve düzenli bırakınız.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 5’in ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

2.20. UYGULAMA
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ÖLÇME VE DEĞERLENDİRME

A) Aşağıda verilen cümlelerin başındaki parantezlere cümleler doğru ise “D”, yanlış ise “Y” 
yazınız. 

1. (   ) Butonlar çok basit ya da karmaşık olabilen, bir bağlantıyı açmak için kullanılan sembollerdir.

2. (   ) İnteraktif içerik oluşturma programında üst kısımda menü, sol bölümde araçlar, sağ bölümde 
paneller ve alt bölümde Timeline paneli vardır.

3. (    ) İnteraktif içerik oluşturma programında, hazırlanan çalışma tek formatta kaydedilir. 

4.  (    ) Sembol sahnesine geçiş yapabilmek için üzerine farenin sağ tuşuyla çift tıklamak, çalışma 
sahnesine geri dönmek için farenin sol tuşuyla çift tıklamak yeterlidir.

B) Aşağıda verilen cümlelerde yer alan boşlukları doğru ifadelerle doldurunuz. 

5. İnteraktif içerik oluşturma programında araç kutusundan ........................................................ tool ile metin 
eklenir, ........................................................ panelinden metin özellikleri düzenlenebilir.

6.  İnteraktif içerik oluşturma programında çalışma sayfasına getirilen grafik,..............................................
........... ile sembole dönüştürülerek düzenlenebilir.

7. İnteraktif içerik oluşturma programında ........................................................ panelde, program tara-
fından eklenen kodların içerisinde açılması istenen web sitesi bağlantı adresi düzenlenmelidir. 

8. Görsellerin, kullanılması planlanan ortam için uygun hâle getirilmesi ........................................................ 
işlemi ile gerçekleşir.

C) Aşağıdaki soruları dikkatlice okuyarak doğru seçeneği işaretleyiniz.

9. Aşağıdakilerden hangisi web sayfalarında kullanılan buton durumu değildir? 

A) Cut 

B) Down 

C) Hit Up

D) Ower

E) Up 

10. Aşağıdakilerden hangisi web sayfalarında kullanılan grafik dosya formatlarındandır?

A) Ast 

B) Axl

C) Gıf 

D) Pyr

E) Reh 
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11. Aşağıdakilerden hangisi deneyim tasarımı programında çalışmanın istenen aşamasında, 
ön izleme yapmayı sağlayan bölümdür?

A) Image map

B) Export 

C) Prototype

D) Frame 

E) Layer

12. Aşağıdakilerden hangisi animasyonlarında ölçü düzenlemesi için kullanılan paneldir? 

A) Frame Rate

B) Motion

C) Preview

D) Insert

E) Transform

Ç) Aşağıda verilen soruların cevaplarını noktalı yerlere yazınız. 

13. Web2.0’ ın internet alanına kattığı yenilikler nelerdir? 

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

14. Web3.0’ ın internet alanına kattığı yenilikler nelerdir? 

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

15. Web için animasyon oluşturma ve kullanma tekniği neden değişim göstermiştir?

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................
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KONULAR

3.1. TEMEL WEB KOMUTLARI
3.2. TABLO İŞLEMLERİ
3.3. GÖRSELLERİN EKLEMESİ
3.4. BAĞLANTILARI OLUŞTURMAK
3.5. CSS PANELİ
3.6. SİTE YÖNETİMİ 

TEMEL KAVRAMLAR
•	 Banner
•	 Css
•	 Div
•	 Ftp
•	 HTML
•	 İmage
•	 Link
•	 Motion
•	 Server
•	 Shape

NELER ÖĞRENECEKSİNİZ?
•	 Temel web komutları ile HTML belgesi oluşturma

•	 Tasarıma uygun şablonu editör programında oluşturma

•	 Tasarıma görsel ekleme

•	 Bağlantıları oluşturma

•	 CSS panelinde stiller oluşturma

•	 Site yönetim işlemlerini yapma

Hazırlık Çalışmaları
1.	 Günümüze kadar geliştirilmiş web teknolojileri nelerdir?

2.	 Kullandığınız web tarayıcı çeşitlerini sınıfta arkadaşlarınızla paylaşınız.

3.	 Beğendiğiniz bir web sayfasının yaşam döngüsünü sınıfta arkadaşlarınızla paylaşınız. 

3.

KOD=41363



3.Öğrenme Birimi

WEB TASARIM 
EDİTÖRÜ 103



104

3.1. TEMEL WEB KOMUTLARI
Web3.0 teknolojisi ile duyarlı web tasarımı oluşturmak için HTML5 ve CSS3 teknolojileri kullanılır. 
HTML şu özelliklere sahiptir:

•	 Web sayfalarını oluşturmak için kullanılan standart metin işaretleme dilidir.

•	 HTML5; dilin son sürümüdür, programlama dili değildir.

•	 Web sayfaları ve bu sayfaların biçimlendirilmesi için kullanılan bir teknolojidir. 

•	 Yazı, görüntü, video vb. farklı veriyi ve bunları içeren sayfaları birbirine basitçe bağlar.

Sayfaların web tarayıcısı yazılımları tarafından düzgün görüntülenmesi için gerekli kuralları belirler. 

•	 Web tarayıcıları HTML kodunu okur, yorumlar ve görsel hâle dönüştürür.

•	 HTML belli standartlara ve kurallara sahiptir. Web sayfaları herhangi bir text editörle oluşturulabi-
leceği gibi web sayfası hazırlamak için geliştirilmiş yazılımlarla da oluşturulabilir. 

HTML yazım kuralları şunlardır:

•	 Komutlar büyük ya da küçük harfle yazılabilir.

•	 Komutlar Türkçe karakterler (ş, ç, ı, ü, ğ, ö) içermez.

•	 Komutlar < ve > işaretleri arasında yazılır.

•	 Tag (etiket) adını alır.

Tagların kullanılış biçimleri şöyledir: 

•	 <tag_adi> şeklindedir.  

Örnek: <HTML>, <BODY>, <TITLE> 

•	 Bir tag <tag_adi> şeklinde açılır ve bazı taglar dışında </tag_adi> şeklinde kapatılır.

•	 Taglar iç içe yer alır ve en içteki tagdan başlatılarak kapatılır. 

<tag_1>

	 <tag_2>

		  ......

	 </tag_2>

</tag_1>

Örnek: <HTML>

	 <BODY>

		  ......

	 </BODY>

</HTML> 

    • Bir tag parametreler kullanılarak biçimlendirilir ve bu parametrelere tırnak 
işaretleri (“ ”)  arasında değer atanır. Değer ile parametre adının arasında eşittir işareti 
(=) kullanılır.

<tag_adı parametre_adı ="değer">

Örnek: <body bgcolor="blue
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Taglar işlevlerine ya da üstlendikleri görevlere göre gruplandırılır. Bu sınıflamalar şöyledir:

Meta Taglar: Kapanmasına gerek olmayan, head tagları arasında yer alan, siteyle ilgili birtakım özel-
liklerin yer aldığı, tarayıcı üzerinde görünmeyen fakat aynı zamanda tarayıcılar için veri oluşturulan 
taglardır. 

Script Taglar: Javascript gibi istemci tarafından çalışacak komut dosyaları dâhil etmek için kullanılan 
taglardır.

Biçimlendirme Taglar: Yorum satırları, metin içerisinde yapılan kısaltma açıklamaları, metin düzen-
lemeleri, adres bilgileri vb. biçimlendirmeler için kullanılan taglardır.

Yapısal Taglar: Kapsayıcı rol üstlenen yerleşim amacıyla kullanılan taglardır.

Liste Taglar: Sıralama ve listeleme yapabilmek için kullanılan taglardır.

Tablo Taglar: Bazı durumlarda yerleşim bazı durumlarda veri sunmak amacıyla tablo oluşturmada 
kullanılan taglardır. 

Form Taglar: Kullanıcılarla etkileşime geçmek ve veri edinebilmek için kullanılan taglardır.

Gömülü Taglar: Dışarıdaki bir kaynak üzerindeki video, ses vb. ögeleri sayfaya dâhil edebilmek için 
kullanılan taglardır. 

3.1.1. Proje İhtiyacı Belirleme
Web sitesi, firma ya da kurumun hedef kitlesiyle iletişimini sağlayan en önemli tanıtım araçlarından 
biridir. Web sitesi oluşturulduktan sonra sitenin düzenli olarak geliştirilmesi ve bakımının yapılması, 
sitenin güncel ve başarılı olmasını sağlayarak amacına ulaşmasında etkili olacaktır.

Projenin; bilgilendirme dosyasındaki mevcut bilgiler doğrultusunda, kullanıcı profili dikkate alınarak, 
trend ve popüler web teknolojileri kullanılarak oluşturulması, yayımlama ve geliştirme sürecinde 
olumlu sonuçlar doğurur. 

3.1.2. HTML Belgesi Oluşturma ve Kaydetme
Web sayfası belgesi dosyaadi.htm ya da dosya adi.HTML olarak kaydedilmelidir. Bu htm ya da HTML 
olan dosya uzantısı, belgenin bir web sayfası olduğunu gösterir ve web tarayıcının anlamasını sağlar 
(Görsel 3.1).

Görsel 3.1: Metin dosyası uzantısı ve HTML dosya uzantısı kaydetme
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3.1.3. Oluşturulan HTML Belgesini Web Tarayıcısında Görüntüleme
Web sayfası ister bir text editöründe ister web tasarımı editöründe hazırlanmış olsun, .html ya da 
.htm dosya uzantısıyla kaydedildikten sonra mevcut tarayıcı simgesiyle görüntülenebilir (Görsel 3.2).

Görsel 3.2: Metin dosyası ve tarayıcıda html görüntüleme

3.1.4. HTML Sayfasında Bulunması Gereken Standart Etiketleri 
           Kullanma
Her HTML belgesinin içermesi gereken bazı temel taglar vardır. Bunlar HTML, body, head, title tagla-
rıdır.

•	 <HTML> tagı bir web sayfasında bulunan ilk tagdır. Amacı, o belgenin bir HTML belgesi (Web 
sayfası da denebilir.) olduğunu bildirmektir. Bütün taglar <HTML></HTML> tagının içerisinde 
yazılır. Bu tagın parametresi yoktur.

•	 <head> tagı bir web sayfasının başlangıç kısmını oluşturur. <head></head> tagları arasına yazı-
lacak herhangi bir şey sayfada görünmez. Bu tagın içine style sheet kodları girilir. Bu tagın para-
metresi yoktur.
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•	 <title>  tagı içine gelecek yazı web sayfanızın başlığı olacak ve browser penceresinin başlık çubu-
ğunda görünecektir. <title> tagı <head> tagının içerisinde yazılır.

•	 <body> tagı bir web sayfasının gövde kısmı yani tarayıcıda görünen kısmıdır. İçerikte görünmesi 
istenenlerin (yazı, görsel, form vb.) içine yerleştirildiği tagdır. <head> tagından sonra kullanılır 
(Görsel 3.3).

Örnek: 

<HTML>

	 <head>

		  <title> Sayfa Başlığı </title>

	 </head>

	 <body>

	 Grafik Tasarım Bölümü, Web Tasarımı dersine başlıyoruz

	 </body>

</HTML>

Görsel 3.3: Web sayfası

3.1. ETKİNLİK 
Text editöründe HTML kodlarını yazarak Görsel 3.3’teki gibi bir ilk web 
sayfası oluşturunuz.
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3.1.5. Dil Desteği, Metinleri ve Görünümü Düzenleme, Resim Ekleme 
İşlemleri

Meta Tagları: Sayfa kodlaması, başlık, açıklama, yazar, anahtar kelimeler vb. özelliklerin belirtilmesini 
sağlar. Tarayıcılar buradaki verilerden sayfayla ilgili bilgi sahibi olur ancak taglar tarayıcı üzerinde 
görünmez. Kapanmasına gerek olmayan meta tagları, head tagı arasında yer alır.

Meta tagların kullanımı şu şekildedir:

<head>

<meta charset=“UTF-8”>

<meta name=“description” content=“…..”>

<meta name=“author” content=“Ad Soyad”>

<meta name=“keywords” content=“html, web tasarımı”>

<meta name=“viewport” content= “width=device-width, initial-scale=1.0”>

</head>

•	 <meta charset=“UTF-8”>

Sayfanın karakter kodlamasını belirlemek için kullanılır. Web sayfasında Türkçe karakterlerin düzgün 
görüntülenebilmesi için “UTF-8” kullanılır.

•	 <meta name=“description” content=“…..”>

Arama motorlarının site hakkında bilgi edinebilmesi için kullanılır.

•	 <meta name=“author” content=“Ad Soyad”>

Sitenin yazarının bilgisi verilir.

•	 <meta name=“keywords” content=“html, web tasarımı”>

Sitenin içeriğiyle ilgili anahtar kelimeler virgülle ayrılarak verilir.

•	 <meta name=“viewport” content= “width=device-width, initial-scale=1.0”>

Farklı cihazlardan (bilgisayar, tablet ve cep telefonları) sayfalara erişim sağlamak ve cihaz farklılığına 
göre içeriği boyutlandırmak için kullanılır.

Metinleri Düzenleme Etiketleri

 <font> </font>: Yazı özelliklerini belirlemek için kullanılan tagdır. Bu özellikler color (yazı rengi), face 
(yazı biçimi) ve size (yazı büyüklüğü) parametreleri kullanılarak verilebilir. Metni bold yapmak için 
<b> tagı, italik yapmak için <i> tagı, altı çizili yapmak için <u> tagı kullanılır. Başlık özellikleri <h1>, 
<h2>, <h3>, <h4>, <h5>, <h6> taglarıyla belirlenebilir. Paragraf yapmak için <p> tagı, satır sonu 
yaparak bir alt satıra geçmek ve satır boşluğu bırakmak için kapatılmasına gerek olmayan <br> tagı 
kullanılır. Sayfaya baştan sona bir satır boyunca çizgi çizmek için <hr> tagı kullanılır.

Kullanımı şu şekildedir:

<font color=“#ff0000” face= “arial, tahoma” size=“1”> Özellik eklenmek istenen metnin geleceği 
bölüm. </font> (Görsel 3.4).
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Görsel 3.4: “color=“#ff0000” face= “arial, tahoma” size=“1” özelliklerinde metin

<b>Buraya gelecek yazı bold olacak</b> (Görsel 3.5).

Görsel 3.5: Bold yazı biçiminde metin

<i>Buraya gelecek yazı italik olacak</i> (Görsel 3.6).

Görsel 3.6: İtalik yazı biçiminde metin

<u>Buraya gelecek yazı altı çizili olacak</u> (Görsel 3.7).

Görsel 3.7: Altı çizili biçimde metin
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<h1>Başlık 1 en büyük</h1>

<h2>Başlık 2 </h2>

<h3>Başlık 3 </h3>

<h4>Başlık 4 </h4>

<h5>Başlık 5 </h5>

<h6>Başlık 6 en küçük</h6> (Görsel 3.8).

Görsel 3.8: Başlıklandırma biçimleri

<p>Korkma, sönmez bu şafaklarda yüzen al sancak; <br>Sönmeden yurdumun üstünde tüten en 
son ocak. <br>O benim milletimin yıldızıdır, parlayacak;<br> O benimdir, o benim milletimindir 
ancak (Görsel 3.9).

</p>

Görsel 3.9: Metinlerin düzenlenmesi

Örnek: <HTML>

	 <head>

		  <title>Metinleri düzenlemek</title>

	 </head>

	 <body>

		  <font face =“verdana,tahoma” size="3" color="blue">Mavi yazı</font>

		  <font size="3" color="red"><b><i>Kırmızı bold ve italik yazı</i></b></	
font> 

	 </body> (Görsel 3.10).

</HTML>

Görsel 3.10: Metinlerin düzenlenmesi
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Köprü Etiketi

<a>..</a> : Web sayfaları arasında bağlantı oluşturmak için kullanılan etikettir.

<a> etiketinin en çok kullanılan öz nitelikleri “href” ve “target”dir.

href: Bağlantı verilen sayfanın URL adresini belirtir.

target: Bağlantının hangi pencerede açılacağını belirtir. Target özniteliğinin alabileceği parametreler 
ise Tablo 3.1’de gösterilmiştir.

Tablo: 3.1: Target Öz Niteliğinin Alabileceği Parametreler

Değer Tanım
_blank Belgeyi yeni bir pencerede veya sekmede açar.

_self Belgeyi aynı çerçeve içerisinde açar (varsayılan). 

_parent Belgeyi ana frame'de açar.

_top Belgeyi pencerenin gövdesinde açar.

frameismi İsmi, belirten frame üzerinde açar.

Kullanımı şu şekildedir:

<a href="https://meb.gov.tr" target=”_blank”>Millî Eğitim Bakanlığı</a> (Görsel 3.11).

Görsel 3.11: Bağlantı oluşturulmuş metin

Tanımlama Liste Etiketleri

<dl> tagı açıklama listesi, <dt> tagı açıklanacak terimi, <dd> tagı ise <dt> tagı ile belirtilen terime 
açıklama oluşturmak için kullanılır.

Tagın kullanımı şu şekildedir: 

<dl>

<dt>Temel Tasarım</dt>

<dd>Grafik tasarım bölümünde zorunlu derstir.</dd>

<dt>Web Tasarım</dt>
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Görsel 3.12: Tanımlama oluşturulmuş metin

Liste Oluşturma Etiketleri

<ul> tagı sırasız listeler oluşturmak, <ol> tagı sıralı listeler oluşturmak, <li> tagı sıralı ve sırasız listede 
öge eklemek için kullanılır. <ol> tagı type, start, reversed parametreleriyle kullanılabilir. Type ile 
listeleme türü (A, a, 1, i gibi), start ile belirlenen özelliğin nereden başlayacağı belirlenebilir. Reversed 
ise listeyi terstten sıralatmak için kullanılır (Görsel 3.13).

Tagın kullanımı şu şekildedir: 

<ul>

<li>Temel tasarım</li>

<li>Temel fotoğraf</li>

<li>Temel desen</li>

</ul>

<ol type=“A” start=“1” >

<li>Dergi Tasarımı</li>

<li>Gazete Tasarımı</li>

</ol>

Görsel 3.13: Listelenmiş metin

<dd>Grafik tasarım bölü-
münde seçmeli derstir.</
dd> (Görsel 3.12).

</dl>
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UYGULAMA ADI: HTML Belgesi Oluşturma ve Kaydetme  

AMAÇ: HTML belgesi oluşturmak ve kaydetmek. 

Araç Gereç

1. Bilgisayar

2. Metin editör programı

3. Genel ağ

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak bir HTML belgesi oluşturunuz. 
İstiklal Marşı’nın ilk iki kıtasını yazarak kaydediniz.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı 
ve araç gerecinizi hazırlayınız. 

2.	 Bilgisayarı çalışmaya hazır hâle getiriniz. 

3.	 Yeni bir metin belgesi açınız.

4.	 Metin belgesini uygun bir yere ve uygun formatta kaydediniz.

5.	 Sayfanıza “İstiklal Marşı” başlığını veriniz.

6.	 Sayfada kullanacağınız metnin başlığını oluşturunuz.

7.	 Sayfaya İstiklal Marşı’nın ilk iki kıtasını ekleyiniz.

8.	 Sayfanızdaki metinleri düzenleyiniz.

9.	 Çalışmanızı uygun formatta kaydediniz.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 6’nın ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

3.1. UYGULAMA
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Görünümü Düzenleme Etiketleri

Color, kullanıldığı tagın rengini belirlemek için kullanılan parametredir. Web tasarımında renk 
değeri, rengin İngilizce adı, renk modu (RGB) karşılığı ya da hexadecimal karşılığı şeklinde verile-
bilir (Görsel 3.14). 

<font color=”Red” > Bu yazı kırmızı renktedir. </font>

Görsel 3.14: Renklendirilmiş metin

Bgcolor, birlikte kullanıldığı tagın arka planını renklendirmeye yarar .

Örnek: <body bgcolor=“Black”> (Web sayfası arka planı siyah olacaktır.) (Görsel 3.15)

Görsel 3.15: Arka planı renklendirilmiş metin

Background, birlikte kullanıldığı tagın arka planına resim eklemeye yarar.

Örnek: <body background=“resimadı.uzantısı”> (Web sayfası arka planına resim gele-
cektir.) (Görsel 3.16)

Görsel 3.16: Arka planında resim kullanılmış metin
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Resim Ekleme Etiketi

 <img> resim eklemek için kullanılan bir tagdır. <img> tagı ile alt, src, width, height parametreleri 
kullanılabilir.

<img src=“dosya.adi” alt=“değer” weight=“değer” height=“değer”>

Src, resmin bağlantı adresi belirlenir.

Alt, resim hakkında bilgilendirme yapılır.

Width, resmin genişlik değeri belirlenir.

Height, resmin yükseklik değeri belirlenir.

Web sayfası hazırlarken dikkat edilmesi gerekli hususlardan biri de resim dosyalarının çalışma klasö-
rünün içinde başka bir klasörde tutulmasıdır. Örneğin çalışma klasörü “C:\WebSitesi\” ise bu klasör 
içerisinde “image” isimli bir klasör oluşturulmalıdır. Bu klasör içerisindeki bir resme ulaşmak için dosya 
yolu “image/resimadı ve uzantısı” şeklinde verilmelidir. Resim dosyaları www.Web_Site.com adlı bir 
URL de olduğu varsayıldığında dosya yolu “http://www.web_site.com/resimadı.uzantısı” şeklinde 
verilmelidir.

Görsel 3.17: Görsel eklenmiş sayfa

Örnek: <html>

	 <head>

		  <title> Resimlerle Çalışmak </title>

	 </head>

	 <body>

		  <img src=”https://meb.gov.tr/assets/images/29Ekim/logo-beyaz.
png” alt=”Meb_logo” weight=”200” height=”200”> (Görsel 3.17)

	 </body>

</html>
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UYGULAMA ADI: HTML Belgesine Resim Ekleme ve Kaydetme  

AMAÇ: HTML belgesi oluşturmak ve kaydetmek. 

Araç Gereç

1. Bilgisayar

2. Grafik tasarım programları

3. Genel ağ

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak 1. uygulama için hazırladığınız 
HTML belgesine Türk bayrağı görseli ekleyiniz ve kaydediniz.

İşlem Basamakları 

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı ve 
araç gerecinizi hazırlayınız. 

2.	 Bilgisayarı çalışmaya hazır hâle getiriniz.

3.	 1. uygulamada hazırladığınız sayfayı açınız. 

4.	 Sayfaya ekleyeceğiniz resmin boyutuna ve yerine dikkat ediniz.

5.	 Sayfaya görselinizi ekleyiniz.

6.	 Çalışmanızı uygun formatta kaydediniz.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 6’nın ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

3.2. UYGULAMA
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3.2. TABLO İŞLEMLERİ
Web sitelerinin en büyük amacı kullanıcıya içeriğin sunulmasıdır. Duyarlı web tasarımında içerikler, 
kullanıcı deneyimini arttırmak için birden fazla kolonda gösterilir. Kolonlar sistemine Sayfa İskeleti 
ya da Layout (sayfa düzeni) denir. Web sitesinde sunulmak istenen içeriğe göre tek, çift ya da üç 
kolonlu farklı sayfa düzeni kullanılabilir. 

Web tasarımında sayfa düzeni farklı taglarla oluşturulabilmekle birlikte CSS ile de oluşturulabilir. 
Duyarlı web tasarımında, tasarım bölümlerinin CSS ile şekillendirilerek genel kapsayıcı olan yapısal 
div tagıyla oluşturulması önerilir.

Web sayfaları kodlarla oluşturulabileceği gibi editör programlarla da oluşturulabilir. Web sayfası 
editör programı, HTML kodları kullanımının yanı sıra HTML kodu kullanmadan da sayfa tasarımına 
olanak sağlar. Ayrıca web sayfasında kullanılması planlanan görseller, interaktif içerikler gibi ögelerin 
düzenlenebileceği programlarla eşgüdümlü çalışma imkânı da sunar.

3.2.1. Editör Programının Açılış Ayarları
Web editör programının başlangıç aşamasında ve herhangi bir çalışma belgesi açık değilken 
(Görsel 3.18) başlangıç çalışma alanı görünür. Açılış arayüzünde; üst kısım menü çubuğu, sol kısım 
araç çubuğu, alt kısım özellikler paneli, sağ kısım panel grubu ve orta kısım çalışma alanıdır. Web 
editör programında çalışma alanı kullanım ihtiyacına göre kişiselleştirilebilir.

Görsel 3.18: Web editör programı başlangıç çalışma alanı

3.2.2. Araç Çubukları ve Panellerle Çalışma
Web editör programı, çalışma esnasında kolaylık sağlayacak birtakım bölümlerden oluşur. Bu 
bölümler şunlardır:
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Menü Çubuğu: Program arayüzünün üst kısmında bulunur. Menüler, çalışma alanı değiştiricisi ve 
uygulama denetimlerini içerir (Görsel 3.19).

Görsel 3.19: Web editör programı menü çubuğu

Standart Araç Çubuğu: Program arayüzünün üst kısmında bulunur. Çalışma esnasında sık kulla-
nılan yeni belge açma, kaydetme gibi komutlar mevcuttur (Görsel 3.20).

Görsel 3.20: Web editör programı standart araç çubuğu

Araç Çubuğu: Program arayüzünün sol kısmında bulunur. Çalışmaya uygun özel seçenekler içerir. Alt 
kısımda bulunan üç nokta bölümünden o an açık olmayan fakat gerektiğinde açılabilen diğer araçlar 
seçilerek aktif edilebilir (Görsel 3.21).

Görsel 3.21: Web editör programında araç çubuğu
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Belge Araç Çubuğu: Program arayüzünün 
üst kısmında bulunur. Çalışma sayfasının 
görünüm seçeneklerini içerir (Görsel 3.22). 
Bu seçenekler kod, bölmeli bölüm ve canlı 
bölümden oluşur.

Görsel 3.22: Web editör programında belge araç çubuğu

Görsel 3.23: Web editör programında paneller

Etiket Seçici: Program arayüzünün alt kısmında yer alır. Seçimin çevresindeki etiketlerin hiyerarşisini 
gösterir (Görsel 3.24). 

Görsel 3.24: Web editör programında etiket seçici

Özellik Denetçisi: Program arayüzünün alt kısmında yer alır. Seçili metin ya da nesnenin özellikle-
rinin görüntülenmesini ve değiştirilmesini sağlar (Görsel 3.25). 

Görsel 3.25: Web editör programında özellik denetçisi

Paneller: Program arayüzünün sağ kısmında bulunur. Çalışma esnasında gerekli olan paneller 
window menüsünden seçilebilir. Çalışmanın izlenmesini ve değiştirilmesini sağlar (Görsel 3.23). 
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3.2.3. Site Tanımlanması
Web editör programında, tüm dâhilî bağlantıları doğru şekilde oluşturmak ve bu bağlantıları site 
içerisinde farklı konuma taşırken güncellemelerini yapmak için yerel site klasörü oluşturmak gerekir. 
Ayrıca bilgisayara, oluşturulan web sitesinin çalışma sistemini doğru görüntüleyebilmek için local 
host (yerel barındırma) kurulumu yapmak gerekir. Her web site için oluşturulan yerel site klasörünün 
yerel barındırma içerisinde olması çalışma için çok önemlidir. Bu nedenle, öncelikle bilgisayarda yerel 
barındırma için alan belirlenmeli, ardından oluşturulacak her web sitesi için içerisinde o siteye ait her 
şeyin barınabileceği bir yerel site klasörü oluşturulmalıdır. 

Web sitesi ve siteye ait içerik oluşturulurken kullanılacak adlarda dikkat edilmesi gereken hususlar 
şunlardır: 

•	 Site adı; içeriği yansıtıcı, kısa, anlamlı, akılda kalıcı ve okunuşu kolay olmalıdır. 

•	 Türkçe karakter, boşluk, işaretler (“/\? %*:|"<>.”) ve mümkün olduğunca büyük harf kullanılma-
malıdır.

•	 Alfa sayısal karakterler, kısa 
çizgiler ve alt çizgiler kulla-
nılması önerilebilir.

•	 Web sitesine ait çoğu içerik adı, 
web sayfası url’sinin bir parçası 
olarak sona ekleneceğinden 
adların kısa ve anlamlı olması 
gerekir.    

Site Ayarları: Site>Manage Sites 
(Görsel 3.26) paneliyle yeni bir site 
oluşturma, mevcut siteyi düzenleme, 
site kaldırma, site çoğaltma, site 
ayarlarını içe ya da dışa aktarma gibi 
işlemler yapılabilir.

Görsel 3.26: Site ayarları

Manage Sites panelinde 
New Site komutuyla yeni 
bir site tanımlaması yapı-
labilir (Görsel 3.27).

Görsel 3.27: Yeni site tanımlama
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Site Setup for Unnamed Site panelinden Site Name bölümüne web sitesinin adı yazılmalıdır 
(Görsel 3.28). Local Site Folder bölümünden local host içerisinde oluşturulmuş yerel site klasörü 
seçilmelidir. 

Görsel 3.28: Files paneli

Files panelinden web editör programında mevcut tanımlı siteler ve içerikleri görüntülenebilir ve 
düzenlenebilir (Görsel 3.29).

Web Tarayıcı Tanımlama: 
Web sayfaları içerikte kul-
lanılan birtakım kodlar ve 
farklı nedenler sebebiyle 
her tarayıcıda farklı gö-
rüntülenebilir. Yayımlama 
veya güncellemeler son-
rası sorun yaşamama ve 
ön izleme için web editör 
programına farklı tarayıcı 
tanımlamak gerekir.

Görsel 3.29: Preferences paneli

3.2. ETKİNLİK 
Yerel kök klasör ve diğer klasör oluşturma işlemlerine dikkat ederek web 
tasarım editöründe site tanımlaması yapınız.
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Preview Paneli>Edit List ya da Edit>Preferences>Real-Time Preview paneli bilgisayarda mevcut 
tarayıcıların görülebildiği, düzenlenebildiği, ekleme ve çıkarma yapılabildiği, birinci ve ikinci tarayıcı 
önceliğinin seçilebildiği bölümler içerir (Görsel 3.30). 

Yeni web sayfası oluşturma: File>New komutuyla oluşturulabileceği gibi Ctrl+N kısayol tuşuyla 
da oluşturulabilir.

Görsel 3.30: New Document paneli

New Document panelinden sayfanın türü ve başlık belirlenerek Create komutuyla oluşturulabilir 
(Görsel 3.31). 

Web sayfasını kaydetme: File>Save komutuyla kaydedilebileceği gibi Ctrl+S kısayol tuşuyla da 
kaydedilebilir.  

Görsel 3.31: Farklı kaydet paneli
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Farklı Kaydet panelinden konum olarak web editör programına tanımlanan yerel site klasörünün içi 
seçilir, dosyanın adı verilir, kayıt türünden HTML Documents seçilir ve kaydet komutuyla kaydedilir 
(Görsel 3.32).

Görsel 3.32: Files paneli ilk sayfa

Files paneliyle oluşturulan sayfalar görüntülenebilir ve düzenlenebilir. Web sitesine ait tüm sayfalar 
ana sayfaya bağlı olacağından, ilk sayfa ana sayfa ya da index olarak oluşturulmalı ve kaydedilmelidir. 

Dom paneliyle statik ve dinamik içerikler için etkileşimli html ağacı oluşturulur .HTML yapısında 
düzenlemeler yapılabilir ve yapılan bu değişikler canlı (live) görünümde görülebilir. Canlı görünümde, 
statik ve dinamik ögeler; kod ya da tasarım görünümünde yalnızca statik ögeler görüntülenir. Deği-
şiklik yapılmak istenen kodların üzerine çift tıklanarak seçili hâle getirilir ve düzenleme yapılır. 

Tanımlanan web sitesi için tasarlanan web sayfalarının oluşturulma aşamasında ön izleme için 
Preview paneli kullanılır (Görsel 3.33).

Görsel 3.33: Preview paneli site ön izlemesi
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3.2.4. Tasarıma Uygun Temel Tabloları Oluşturma
Web sayfalarında veri sunmanın yanı sıra, metin / grafik mizanpajı (sayfa düzeni) için de yatay ve 
dikey konum düşünülerek satırlara ve sütunlara bölünmesi yöntemiyle tablolar kullanılırken, Web3.0 
teknolojisiyle birlikte duyarlı web tasarımında, sayfa düzeni kontrolü amacıyla HTML tablolarının 
kullanılmasını gerektirmeyen bir web tasarım yöntemi olan Tablosuz Web Tasarımı kullanılmaya 
başlanmıştır. 

Duyarlı Web Tasarımında sayfa düzeni için CSS biçimleri kullanılırken istisnai durumlar dışında veri 
sunmak amacıyla tablolar kullanılır.

Yapısal Div Tagı Kullanımı: Duyarlı web tasarımında layout oluşturulurken yapısal diğer taglar kulla-
nılabileceği gibi tüm tarayıcılar tarafından desteklenen, HTML yapısal tagı olan, çoğu durumda metin, 
görsel ve diğer sayfa ögeleri için kap görevi gören, yerleşim olarak bulunduğu yeri %100 kapsama 
özelliğine sahip blok yapıda bir tag olan div kullanılabilir.

Web3.0 standartları tarafından tercih edilen yöntem olan hareketli ögeler, dolgular ve kenar boşlukları 
belirtilerek konumlandırılabileceği gibi mutlak (x ve y koordinatları belirterek) ya da göreceli (geçerli 
konuma göre belirterek) olarak konumlandırılabilir. 

Her div tagının stil özellikleri ve konumlandırmasını belirlemek için kullanılan benzersiz bir kimliği 
(ID) vardır. Kimliklere, stil ve konumlandırma özelliği CSS ile verilebilir.

Web editör programında Insert>Div komutuyla Insert Div paneli açılır (Görsel 3.34).

Görsel 3.34: Insert Div paneli

Yeni oluşturulmak istenen Div, Insert ile At insertion point (ekleme noktasında), After start of tag (tag 
başladıktan sonra), Before end of tag (tag bitmeden) seçenekleriyle eklenmek istenen yer; Class ile 
sınıf, ID ile kimlik, New CSS Rule ile yeni CSS kuralı verilerek oluşturulur (Görsel 3.35).

Görsel 3.35: Web editör programında div
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Table Tagı kullanımı: Tablolar satır 
(row), sütun (column) ve satır ve sütun-
ların birleşim noktası hücrelerden (cell) 
oluşur. 

Tablonun gelmesi istenen yere imleç 
konumlandırılır, ardından Insert>Table 
komutu ya da Ctrl+Alt+T kısayoluyla 
tablonun özelliklerinin verilebileceği 
Table paneli açılır (Görsel 3.36).

Görsel 3.36: Table paneli

Oluşturulmak istenen tablonun satır / sütun sayısı, yüzde ya da piksel cinsinden genişlik değeri, 
piksel cinsinden çerçeve değeri, hücre dolgu değeri, hücre aralık değeri, başlık bölüm değeri, altyazı 
özellikleri Table panelinden verilebilir (Görsel 3.37).

Tablolar oluşturulduktan sonra ve hatta çalışmanın belli bir aşamasından sonra da özellikleri düzenle-
nebilir. Bu özellikler tablo seçildikten sonra properties panelinden yapılabilir. Tablo genelinde özellik 
verilebilirken satır ya da hücre bazında da özellikler verilebilir. Bu sıralamada hücre, satır ve tablo 
şeklinde önceliklendirilmelidir.

Görsel 3.37: Table paneliyle tablo oluşturma
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Table panelinden, Web teknolojisi başlığıyla 600 piksel genişliğinde 3 satır, 2 sütun, 1 piksel çerçeve 
kalınlık değerleri verilerek oluşturulan tablo, web editör programında canlı, kod bölümlerinde ve 
tarayıcıda görünecektir. Tablo oluşturma işleminden sonra istenen aşamada tablo üzerinde özellik 
düzenlemesi yapılabilir. 

Tablolarda, yan yana ya da alt alta gelen hücreler birleştirilebilir ve bölünebilir. Birleştirme ya da 
bölme işlemi için öncelikle işlem yapılacak hücrelerin seçilmesi gerekir. 

•	 Hücre bölmek için Edit>Table>Split cell komutu ya da Ctrl+Alt+Shift+T kısayol tuşu kullanıla-
bilir. 

•	 Hücre birleştirmek için Edit>Table> Merge cells komutu ya da Ctrl+Alt+M kısayol tuşu kullanı-
labilir. 

2. sütunda üç satır birleştirilmek istendiğinde satırlar seçilir ve ardından birleştirme komutu uygu-
lanır (Görsel 3.38).

Görsel 3.38: able paneliyle hücre birleştirme

3. sütunda 1. satır bölünmek istendiğinde hücre seçilir ve bölme komutuyla ekrana gelecek Split 
Cell panelinden bölme işleminin hücre sayısı, satır ya da sütun bazında yapılacağı belirlene-
bilir (Görsel 3.39). 
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Görsel 3.39: Table paneliyle hücre bölme

•	 Tabloya satır eklemek için Edit>Table>Insert Row komutu ya da Ctrl+M kısayol tuşu kullanıla-
bilir.

•	 Tabloya sütun eklemek için Edit>Table>Insert Column komutu ya da Shift+Ctrl+A kısayol tuşu 
kullanılabilir.

•	 Tablodan satır silmek için Edit>Table>Delete Row komutu, Shift+Ctrl+M kısayol tuşu ya da klav-
yeden delete tuşu kullanılabilir.

•	 Tablodan sütun silmek için Edit>Table>Delete Column komutu, Shift+Ctrl+- kısayol tuşu ya da 
klavyeden delete tuşu kullanılabilir.

Web editör programında tablolar tek başına kullanılabileceği gibi iç içe de kullanılır. Bu durumda 
içeriğe göre tablolar iç içe sıralanabilir (Görsel 3.40).

Görsel 3.40: Tabloları iç içe sıralama
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Web sayfasında tablolar çerçevesiz olarak kullanılabilir (Görsel 3.41).

Görsel 3.41: Çerçevesiz tabloları iç içe sıralama

3.2.5. Layout ve Expanded Modunda Tabloları Şekillendirme 
Layout (düzen) ve Expanded (genişletilmiş) modlar çalışma sayfasının görünüm seçeneklerini içerir 
(Görsel 3.42). Bu seçenekler Code (kod), Split (bölmeli bölüm) ve Live (canlı) bölümden oluşur. 

Görsel 3.42: Görünüm seçenekleri

Web editöründe kullanılan görünüm modları şunlardır:

•	 Farklı türdeki kodları yazmak ve düzenlemek için code bölümü

•	 Tarayıcıda nasıl görüneceğine ilişkin daha gerçekçi bir sunum görüntüsü, tarayıcıda yapılabi-
leceği gibi belgeyle etkileşim kurmak ve HTML öğelerini doğrudan düzenleyebilmek için live 
bölümü

•	 Web sayfasının (tarayıcıda göründüğüne benzer bir şekilde) görsel temsilini görerek görsel sayfa 
mizanpajı, görsel düzenleme ve hızlı uygulama geliştirme için design bölümü.

Web editör programında web sitesinde olması istenen içeriğe göre farklılık gösteren layoutlar oluş-
turulabilir (Görsel 3.43). Web sitesinde ulaşılmak istenen amaca göre layout oluşturulmalıdır. İçerikte 
şirket ya da ürün tanıtımı amacı güdülüyor ya da içerik teknik bilgi makalelerinden oluşacaksa tek 
kolonlu layoutlar, tek tip içerik ya da blog sitesi olacaksa iki kolonlu layoutlar, kullanıcı ilgisini farklı 
noktalara çekmek isteyen magazin ya da haber sitesi gibi olacaksa üç kolonlu layoutlar tercih edile-
bilir.
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Görsel 3.43: Layout örnekleri

Div tagıyla layout oluşturulurken öncelikle sayfa genelini kapsayıcı bir div, ardından tasarıma göre 
uyarlanmış bölümlerin divleri yerleştirilir (Görsel 3.44). 

Web sitesi tasarımına uygun layout, HTML sayfada oluşturulduktan sonra biçimlendirmesi CSS ile 
yapılmalıdır.

Görsel 3.44: Layout oluşturma
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UYGULAMA ADI: Web tasarım editöründe tablolarla çalışma

AMAÇ: Web tasarım editöründe sayfaya istenen özelliklerde tablolar eklemek. 
Araç Gereç

1. Bilgisayar

2. Grafik tasarım programları

3. Genel ağ 

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak 2. etkinlik için tanımladığınız 
site içinde oluşturacağınız sayfaya tablo ekleyiniz.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı 
ve araç gerecinizi hazırlayınız. 

2.	 Bilgisayarı çalışmaya hazır hâle getiriniz.

3.	 2. etkinlikte tanımladığınız site içinde yeni bir sayfa oluşturunuz.

4.	 Sayfa içinde bir tablo oluşturunuz.

5.	 Bilgisayarınızda bulunan haricî bir dosyadan tablonuza veri aktarınız.

6.	 Tablo verilerini düzenleyiniz.

7.	 Tablo hücrelerini silme, ekleme ve birleştirme yöntemlerini kullanarak biçimlendiriniz.

8.	 Tablonuza satır ve sütun ekleyiniz.

9.	 İç içe tablolar oluşturunuz.  

10.	 Çalışmanızı uygun formatta kaydediniz.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 6’nın ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

3.3. UYGULAMA
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3.3. GÖRSELLERİN EKLENMESİ
Web editör programında web sayfası tasarlama aşamasında amaç ve hedef kitle beklentisi doğrultu-
sunda metin, resim, grafik, fotoğraf, animasyon, video, ses, uygulama vb. ögeler içeriğe eklenebilir.

Görseller farklı cihazlarda görüntülendiğinde boyutları konusunda sorunlar yaşanır. Bu sorunun 
yaşanmaması için grid sistem içerisinde yer alan tasarım elemanlarının farklı cihazlarda kayıp yaşa-
madan farklı boyutlardaki ekranlara adapte edilmesi gerekir.

Her bir görüntünün farklı ekran boyutlarına göre adapte edilebilmesi için büyük kullanım kolaylığı 
sağlayan esnek imaj yönetimi kullanılabilir. 

Adaptif imajlar, kullanıcının ekran boyutuna uyan ve görüntünün masaüstüne yüklenmesine 
gerek kalmadan ekran boyutuna uyum sağlayan modüllerdir. Kullanıcılar, araçlarına görün-
tüleri Adaptif imajlar sayesinde daha hızlı yükleyebilmektedir. 

Esnek grid sistemi ve esnek imajlar, sayfa içerisindeki her bir elemana ait özellikleri atamayı sağlayan 
kodlar medya sorguları ile uygulanır. Tarayıcının desteklemesi koşuluyla medya sorguları, web 
arayüzünde yer alan tasarım elemanlarına ait anlık genişlik, yükseklik, renk, tipografi vb. unsur-
ların ekran üzerindeki uyumunu sağlar. Ayrıca görüntüleme cihazlarının ve browser’ın genişliği ve 
yüksekliği, cihazın çözünürlüğü ve yatay ya da dikey durmasına göre sayfayı düzenler. 

3.3.1. Metin Biçimlendirme, Liste Oluşturma, Haricî Metinler, Resim 
Ekleme ve Resim Biçimlendirme İşlemleri

Web editör programında, sayfa içerisinde metnin gelmesi istenen yere imleç konumlandırılır ve 
ardından şu üç farklı yöntemle metin eklenebilir:

•	 Doğrudan yazılabilir.

•	 Edit>Copy ya da Ctrl+C ardından Edit>Paste ya da Ctrl+V ile eklenebilir.

•	 Haricî metin (farklı bir program, kelime işlemci programı ya da genel ağ üzerinden alınmış bir 
metin) olarak eklenmek istenirse Edit>Paste Special (Görsel 3.45) komutuyla getirilmelidir. 
Özel yapıştırma panelinden salt metin kopyalama ya da biçimlendirilmiş metin özellikleriyle 
kopyalama özellikleri seçilebilir.

Görsel 3.45: Paste Special paneli



132

Sayfada farklı özellik verilmediği sürece page properties bölümünden belirtilen metin özellikleri 
geçerli olur (Görsel 3.46).

Görsel 3.46: Page properties paneli

Sadece HTML kodlarla çalışma yapılırken seçili olan metin biçimlendirmesi (sınırlı olmakla birlikte) 
Properties paneli ya da Edit>Text komutuyla yapılabilir. Ayrıca Insert paneliyle de özel karakterler 
eklenebilir (Görsel 3.47).

Görsel 3.47: Insert paneli
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Metinler gerekli durumlarda liste şekline dönüştürülebilir. Liste şekline dönüştürülmek istenen 
metnin enter tuşuyla sıralanmış olması gerekir. Metin seçili hâle getirilir. Properties ya da Insert 
panelinden unordered list (sırasız liste) ya da ordered list (sıralı liste) komutlarıyla listelenebilir 
(Görsel 3.48). Komutları orijinal yazımıyla alalım

Edit>Lİst>Properties komutuyla açılan List Properties panelinden liste türü, sıralı listeler için stil ve 
sayım başlatma belirlenebilir (Görsel 3.49). 

Görsel 3.48: Metin listeleme

Görsel 3.49: List Properties paneli

3.3. ETKİNLİK 
Okulunuzda bulunan alan dallarını web tasarım editöründe yazıp listele-
yiniz. 
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Bağlantılar, yayımlama ve güncelleştirmelerle ilgili sonraki aşamalarda sorun yaşamamak için web 
sitesinde kullanılacak her görselin, o siteye ait yerel site klasörü içerisinde oluşturulacak Images 
klasöründe olması son derece önemlidir.

Resim ya da grafikler web sayfasında web sitesi arka planı  (background), hücre (sadece belli bölüm-
lerde) arka plan  olarak kullanılabileceği gibi içerikte de farklı amaçlar için kullanılabilir.

Web sayfası arka planına renk ya da görsel eklemek için Page Properties panelinden Background 
color (Görsel 3.50), Background image komutları, eklenen görselin tekrar etme özelliği için ise 
Repeat komutu kullanılabilir (Görsel 3.51).

Görsel 3.50: Background color komutu

Görsel 3.51: Background image komutu
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Web sayfalarında istenen belli bölümlere renk (Görsel 3.52) ya da görsel (Görsel 3.53) eklenebilir.

Görsel 3.52: Hücre background renklendirme komutu

Görsel 3.53: Hücreye background image ekleme 
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Web sayfasına görsel eklemek için görselin gelmesi istenen yere imleç konumlandırılır. Insert>Image 
komutu ya da Ctrl+Alt+I kısayolu kullanılarak Select Image Source panelinde (Görsel 3.54, 3.55) 
getirilmek istenen görsel seçilir.

Görsel 3.54: Select Image Source paneli

Görsel 3.55: Web sayfasına resim ekleme

Web sayfasına eklenen görsel düzenlemesi için web editör programı Properties panelinden sınırlı 
düzenlemeler yapılabilirken Edit bölümünden haricî görsel düzenleme programıyla detaylı düzen-
lemeler yapılabilir (Görsel 3.56). 

Görsel 3.56: Haricî programla görsel düzenleme
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3.3.2. Haricî Düzenleme Programlarını Kullanma, Flash Animasyon, 
Düğme, Metin ve Video Ekleme

Web editör programı diğer tasarım prog-
ramlarıyla eşgüdümlü çalışabilme özel-
liğine sahiptir. Bunun için web editör 
programında haricî düzenleme program-
larının tanımlanması gerekir.

Web editör programında Edit>Prefe-
rences>File Types/Editors kategori-
sinden Extensions (dosya uzantısı) ve 
bunun için kullanılmak istenen Editors 
(program) tanımlanabilir (Görsel 3.57).

Görsel 3.57: Preferences paneli haricî program tanımlaması

Görsel 3.58:Assets paneli

Web editör programında tanımlanmış site sayfala-
rında kullanılan tüm görsel içerikler, Assets panelinde 
görüntülenebilir ve yönetilebilir (Görsel 3.58). Panelde 
sol bölümde Görsel, Renk, Url, Medya ve Script gibi 
varlıkların simgeleri bulunur. Panelde Insert ile web 
sayfasına varlık eklenir; Refresh Site List ile varlıklar 
listesi yenilenir. Edit ile varlıklar tanımlanmış haricî 
düzenleme programlarıyla düzenlenebilir.

3.4. ETKİNLİK 
Web tasarım editöründe sayfa arka planınıza ve sayfanızın farklı bölge-
lerine görseller ekleyerek düzenlemelerini yapınız.
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Web editör programında web sitesi tasarımının estetik, eğlenceli, akıcı ve dinamik olabilmesi için 
sayfa içeriklerine flash animasyon, düğme, metin ve video eklenebilir. Bu içerikler farklı programlarda 
oluşturulabilmekle birlikte interaktif içerik oluşturma programıyla da oluşturulabilir. 

Öncelikle flash animasyon, düğme ve metin interaktif içerik oluşturma programında oluşturulmalı ve 
ardından web sayfasında kullanılmak üzere .swf formatında kaydedilmelidir.

Web editör programında web sayfasında çalışmanın eklenmesi istenen yere imleç konumlandırılmalı 
ve ardından Insert>HTML>Flash Swf ya da Ctrl+Alt+F kısa yolu ile Select SWF panelinden .swf 
formatında hazırlanmış flash animasyon, buton ve metin dosyası seçilmelidir (Görsel 3.59). 

Görsel 3.59: Select SWF paneli

SWF dosya seçimiyle açılan Object Tag Accessibility Attributes (nesne etiketi erişilebilirlik nite-
likleri) penceresinden Title alanına başlık verilerek kaydedilir (Görsel 3.60).  

Görsel 3.60: Object Tag Accessibility Attributes paneli
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Web editör programı, eklenen SWF dosyalarını tarayıcıların düzgün görüntüleyebilmesi için yerel 
site klasörü içerisine Script adlı klasör içerisinde iki dosya yüklemesi yapar (Görsel 3.61). Web sitesi 
yayımlama aşamasında Script adlı klasöründe uzak siteye yüklenmesi gerekir. 

Görsel 3.61: SWF ek Script

Web editör programında sayfa içerisine eklenen SWF dosyanın kimlik, genişlik, yükseklik, döngü vb. 
özellikleri Properties panelinden düzenlenir. Orijinal dosya üzerinde değişiklik yapmak istenirse 
haricî düzenleme programı kullanılarak yapılır. 

Web editör programında videolar farklı yöntemlerle eklenebilir. Flash video yüklemek için video 
dosyasının .flv uzantılı olması gerekir. Bunun için farklı formatlarda oluşturulmuş video dosyasının 
bir kodlayıcı ile .flv formatına dönüştürülmesi gerekir. 

Web sayfasında içeriğin gelmesi istenen yere imleç konumlandırılır. Insert>HTML>Flash Video 
komutuyla Insert FLV penceresi 
açılır (Görsel 3.62). Insert FLV 
penceresinde; Video type (video 
türü) ile video akışının durumu, 
URL ile videonun olası ya da kesin 
yolu, Skin (dış görünüm) ile video 
bileşeninin görünümü, Constrain 
ile genişlik ve yükseklik arasındaki 
oranı korumakla birlikte Width 
(genişlik) ve Height (yükseklik), 
Auto play ile web sayfası açıldı-
ğında videonun oynatılma durumu, 
Auto rewind ile video oynatılması 
tamamlandıktan sonra kayıttan 
oynatma denetiminin başlangıç 
konumuna dönüp dönmeyeceği 
gibi özellikler belirlenir.

Görsel 3.62: Insert FLV penveresi
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Web editör programı, Insert FLV ile sayfaya eklenen video içeriğinin görüntülenebilmesi için belirtilen 
özellikler doğrultusunda gerekli olan SWF dosyalarını yerel site klasörü içerisine kaydeder. Program 
tarafından oluşturulan SWF dosyaları web sitesi yayımlama aşamasında yerel site klasöründeki diğer 
belgelerle birlikte uzak siteye aktarılmalıdır.

Web sayfasına eklenen SWF ve FLV dosyaları Assests panelinden, Media sekmesinde görüntülene-
bilir ve yönetilebilir.

3.3.3. Ses Oynatıcısı, Uygulama Ekleme, Param Ekleme, Activex 
	 Komutları Ekleme, Haricî Ses ve Video Ekleme
ActiveX, genel ağ üzerinde arka planda çalışan küçük programlardır. ActiveX denetimleri internet 
tabanlı uygulamaların çalıştırılmasını, internet kullanıcısı ile internet sitesi arasında etkileşimli bir 
ortam sağlar. 

Örneğin firmalar, işletim sistemi kullanan kullanıcıların bilgisayarlarında güncelleştirmelerin olup 
olmadığını ActiveX ile kontrol eder. Eğer güncelleştirme yüklü değilse işletim sistemine yüklenir.

Web editör programında otomatik olarak yazılabilen birtakım kodlar vardır. Ara yüzde, bu kodlar ön 
planda görünmez fakat arka planda çalışır. Web sayfasında içerikte kullanılmak istenen uygulama, ses, 
video, film vb. görüntü ögeleri sayfa içerisine <object>, <param> vb. etiketler kullanılarak, gömülü 
olarak getirilir. Web sitelerinde gömülü olarak kullanılan görüntü ögelerinin, kullanıcı cihazları 
tarafından görünmesi ve çalışması (daha da önemlisi doğru görünmesi ve çalışması) için gereken 
kodlama program tarafından yazılır (Görsel 3.63, 3.64) ve site kök klasörüne eklenir (Görsel 3.65). 

Görsel 3.63: Kodlama sayfaları

Görsel 3.64:  Kodlar

Görsel 3.65: Site kök klasörü
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AktiveX komutları, web tasarımında da aynı şekilde çalışmaktadır. Web editör programı tarafından 
yazılan kodlar ve site kök klasörüne yerleşen dosyalar; sitede gömülü  kullanılan uygulama, ses, video 
gibi ögelerin doğru çalışması için gerekli uygulamaların, kullanıcı cihazında var olup olmadığını 
kontrol eder ve yoksa yüklenebilmesi için yönlendirir.

Web editör programında web sayfasına HTML5 sesi eklenebilir ve önizlemesi yapılabilir. 

Web sayfasında ses ögesinin gelmesi istenen yere imleç konumlandırılır ve ardından 
Insert>HTML>HTML5 Audio komutuyla eklenir. 

Properties panelinden; Alt Source 1 - Alt Source 2 seçenekleri olmak üzere Source (kaynak) bölü-
münden ses dosyasının konumu, Title ile başlık, Fallback Text (geri dönüş metni) ile HTML 5 desteği 
bulunmayan tarayıcılar için gösterilecek metin, Controls (denetimler) ile HTML sayfasında Oynat - 
Duraklat - Sessiz gibi ses denetimlerinin gösterilmesi,  Loop (döngü) ile kullanıcı durdurana kadar 
tekrarlaması, Autoplay (otomatik oynatma) ile sesin web sayfasına indiği an oynamaya başlaması, 
Muted (sessiz) ile indirme işleminden sonra sesin kapatılması, Preload (ön yükleme) ile otomatik 
seçeneğinde sayfa indirme işleminde ses dosyasının tamamını yüklemek vb. özellikler belirlenebilir 
(Görsel 3.66).

Görsel 3.66: HTML5 Audio özellikleri

Bilgi notu

Web editör programında, web sitesi yapımının ilk aşamasında site için oluşturulan 
“site kök klasörünün” oluşturulmasının nedeni ve ayrıca yayımlama aşamasında, 
site kök klasörünün tamamının aktarılması gerektiğinin özellikle belirtilmesi gibi 
hatırlatmalar bu nedenledir. 
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Web editör programında web sayfasına HTML5 video eklenebilir. Web sayfasında video ögesinin 
gelmesi istenen yere imleç konumlandırılır ve ardından Insert>HTML>HTML5 Video komutuyla ya 
da Ctrl+Alt+Shift+V kısayoluyla eklenir. 

Properties panelinden; Alt Source 1 - Alt Source 2 seçenekleri olmak üzere Source (kaynak) bölü-
münden video dosyasının konumu, Title ile başlık, Fallback Text (geri dönüş metni) ile HTML5 
desteği bulunmayan tarayıcılar için gösterilecek metin, Flash Fallback ile HTML5 Videoyu destekle-
meyen tarayıcılar için bir SWF dosyası seçimi, Poster (görüntü) ile video dosyası yükleninceye ya da 
kullanıcı videoyu açıncaya kadar gösterilecek görüntü seçimi, Loop (döngü) ile kullanıcı durdurana 
kadar tekrarlaması, Autoplay (otomatik oynatma) ile videonun web sayfasına indiği an oynamaya 
başlaması, Muted (sessiz) ile indirme işleminden sonra videonun kapatılması, Preload (ön yükleme) 
ile otomatik seçeneğinde sayfa indirme işleminde videonun tamamını yükleme vb. özellikler belirle-
nebilir (Görsel 3.67).

Görsel 3.67:HTML5 Video özellikleri
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UYGULAMA ADI: Web Tasarım Editöründe Görsel Ekleme

AMAÇ: Web tasarım editöründe tasarıma görselleri eklemek. 

Araç Gereç

1. Bilgisayar

2. Grafik tasarım programları

3. Genel ağ

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak planını yaptığınız sayfaya 
görseller ekleyiniz.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı ve 
araç gerecinizi hazırlayınız. 

2.	 Bir sayfa planı yapınız.

3.	 Bilgisayarı çalışmaya hazır hâle getiriniz.

4.	 Web tasarım editöründe yeni bir sayfa açarak kaydediniz.

5.	 Sayfada metinler oluşturarak düzenlemeler yapınız. 

6.	 Sayfaya haricî metinler aktararak listeler oluşturunuz. 

7.	 Sayfaya görseller ekleyiniz.

8.	 Sayfaya bir ses oynatıcı ekleyiniz.

9.	 Sayfaya video ekleyiniz.

10.	 Sayfaya animasyon ekleyiniz.

11.	 Sayfaya düğme ekleyiniz.

12.	 Sayfanızı tarayıcılarla çalıştırarak test ediniz.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 6’nın ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

3.4. UYGULAMA
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3.4. BAĞLANTILARI OLUŞTURMAK
Web için bağlantı (link), genel ağda gezinme ayarları anlamına gelir. Bağlantılar verilebilir, test edile-
bilir, güncellenebilir ve değiştirilebilir. Metinlere, görsellere ve farklı nesnelere bağlantı verilebilir. 

Linkler, aynı sayfa içinde ya da sayfalar arası olmak üzere site içerisinde verilebileceği gibi siteler 
arasında da verilir. 

Bağlantı verilmeden önce sayfa adının ve konumunun sabit olmasına dikkat edilmelidir. Konumda ya 
da adda yapılacak herhangi bir değişiklik bağlantının doğru çalışmamasına neden olur. 

Web editör programında bağlantı vermek ve bağlantının özelliklerini belirlemek için Properties 
paneli kullanılır (Görsel 3.68). Properties panelinde farklı bir web sitesine link verileceği zaman URL 
adresi belirtilir. Point to File (Görsel 3.69) site içerisinde link verileceği zaman sürükleme yönte-
miyle Files panelinden tanımlı yerel site klasörü içerisindeki sayfa seçilir, Browse for File (Görsel 
3.70) komutu ile açılan Select File (Görsel 3.71) paneliyle yerel site klasöründen sayfa seçimi yapılır. 
Target, link verilecek sayfanın açılış şeklini belirler.

Görsel 3.68: Properties paneli link bölümü

Görsel 3.69: Properties paneli Point to File penceresi

Görsel 3.70: Properties paneli Browse For File penceresi

Görsel 3.71: Select File penceresi
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Bağlantı verilen sayfanın farklı açılış şekilleri şunlardır:

_blank: Yeni bir tarayıcı penceresinde açar.

_parent: Linkin bulunduğu sayfada açar. 

_self: Linkin bulunduğu çerçevede açar. 

_top: Tam büyüklükte bir pencerede açar.

3.4.1. Metinlere ve Resimlere Bağlantı Ekleme ve Özellik Ayarları
Bağlantı verilmek istenen bir ya da birden çok kelimeden oluşabilen metin seçili hâle getirilir. 
Ardından Properties panelinden link özellikleri belirlenir (Görsel 3.72). 

Görsel 3.72: Metine link verme

3.4.2. Sayfa İçi Bağlantıları ve E-posta Bağlantısı Ekleme
Web sayfası uzun ya da yoğunsa, 
birkaç bölümden oluşuyorsa 
sayfa içerisinde link verme 
kullanım kolaylığı sağlar ve 
gidilecek kısımlara hızlı ulaştırır. 
Sayfa içerisinde link vermek için 
öncelikle Adlı Bağlantı oluştu-
rulur, ardından Adlı Bağlantıya 
link verilir.  Sayfada ulaşılmak 
istenen öge seçilir ve Properties 
panelinde kimlik anlamına 
gelen ID bölümüne isim verilir 
(Görsel 3.73).

Görsel 3.73: Properties ID 
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Görsel 3.74: Sayfa içi link  

Web editör programında web sayfasında, e-posta linkiyle (kullanıcının tarayıcısı ile ilişkilendirilmiş posta 
programı kullanılarak) yeni bir boş mesaj penceresi açılması sağlanır (Görsel 3.75).  Sayfa içerisinde e-posta 
linki olarak görülmesi istenen öge seçilir ve ardından Properties panelinden Link bölümüne mailto:ma-
iladresi yazılır.

Görsel 3.75: E-mail link penceresi

 Tasarım görünümündeyken link verilecek öge seçilir. Properties panelinden link alanına #ID yazılır 
(Görsel 3.74). 
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UYGULAMA ADI: Web Tasarım Editöründe Bağlantılar Oluşturma

AMAÇ: Web tasarım editöründe sayfa içine ve sayfa dışına bağlantılar eklemek. 
Araç Gereç

1. Bilgisayar

2. Grafik tasarım programları

3. Genel ağ

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak sayfa içine ve sayfa dışına bağlan-
tılar ekleyiniz.

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı ve 
araç gerecinizi hazırlayınız. 

2.	 Bilgisayarı çalışmaya hazır hâle getiriniz.

3.	 4. Uygulama’da oluşturduğunuz sayfayı açınız. 

4.	 Sayfanızda uygun gördüğünüz bir metne bağlantı oluşturarak yönlendirme yapınız. 

5.	 Sayfanızda uygun gördüğünüz bir görsele bağlantı oluşturarak yönlendirme yapınız. 

6.	 Sayfanızın en altına iletişim bölümü oluşturunuz.

7.	 Sayfanın en üstünde iletişim bölümüne hızlı erişim için bağlantı oluşturunuz. 

8.	 İletişim bölümünde posta kısmına e-posta bağlantısı ekleyiniz. 

9.	 Sayfanızı tarayıcılarla çalıştırarak bağlantıları test ediniz.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 6’nın ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 

3.5. UYGULAMA
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3.5. CSS PANELİ
CSS-Cascading Style Sheets; basamaklı stil şablonları anlamına gelen, web sayfalarında içeriğin 
görünümünü denetleyen formatlama kuralları grubudur. HTML’ye ek olarak metin ve format biçim-
lendirme alanında fazladan olanak sunan bir işaretleme dilidir.

CSS’nin özellikleri şunlardır: 

•	 Web sayfaları için şablon oluşturulabilmesi

•	 Web sayfalarının hafızadaki boyutunu küçültmesi

•	 Güncellemede kolaylık sağlaması 

•	 Web sayfası tasarımında belirlenen renk, font vb. özelliklerin bir kez tanımlanarak siteye ait tüm 
sayfalarda kullanılabilmesi 

•	 Kullanımının esnek olması

HTML çalışma sayfasına CSS kodlarının eklenmesi şu yöntemlerle yapılır:

•	 HTML çalışma sayfası haricî CSS dosyasına referans verebilir.

•	 HTML çalışma sayfası iç stil türünde CSS içerebilir.

•	 Taglarla beraber CSS içerebilir.

•	 HTML ve CSS ile birlikte www’nin temel teknolojilerinden biri olan JavaScript programlama dili 
yoluyla HTML dosyasına CSS eklenebilir.

CSS kuralları HTML belgesine şu yöntemlerle eklenir:

•	 Haricî CSS stil sayfaları: HTML dosyasından ayrı olarak haricî bir CSS dosyası oluşturulur. Bu 
dosyalar, web sitesinde bir ya da birden fazla sayfaya, belgenin başlık kısmında link ya da @
importla (dosyayı sayfaya dâhil etmek) eklenir. 

Haricî CSS dosyası oluşturmak için File>New komutuyla New Document paneli açılır ve dosya tipi 
CSS seçilir (Görsel 3.76).  Oluşturulan CSS dosyasında, web sitesi sayfalarında kullanılması planlanan 
tüm özellikler verilebilir.

Görsel 3.76: CSS dosyası   
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Açılan CSS dosyası; Ctrl+S kısayolu ile Farklı Kaydet panelinden, dosya adı verilerek ve kayıt türü 
CSS seçilerek yerel site klasörü içerisine kaydedilir (Görsel 3.77). 

Görsel 3.77:CSS dosyasını kaydetme

HTML belgesinde CSS dosyasına bağlantı vermek için şu yol izlenir:

CSS dosyası oluşturulduktan sonra HTML belgesindeyken File> Attach Style Sheet ya da CSS Desig-
ner>Sources komutuyla Attach Existing CSS File paneli açılır.

Browser panelinden CSS dosyası seçilir.

Link verilir (Görsel 3.78).

Görsel 3.78: Attach Existing CSS File paneli
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Görsel 3.80:Attach Existing CSS File Import

Dâhilî CSS stil sayfaları: HTML belgesinin başlık kısmındaki style tagında bulunan CSS kurallar 
grubudur. Dâhilî CSS stilleri, HTML belgesindeyken Properties paneli>Page properties bölü-
münden belirlenir. Belirlenen özelliklerin kodları style bölümüne eklenirken uygulaması tüm sayfada 
görünür (Görsel 3.81).  

Görsel 3.81:  Dâhilî CSS

Görsel 3.79: Attach Existing CSS File Link

Import (Görsel 3.79, 3.80) seçeneklerinden birisiyle bağlantı verilir. 
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Satır içi stilleri: HTML belgesinde yer alan tagların belirli örneklerinde kullanılır fakat her tag için ayrı 
ayrı belirlenmesi gibi sınırlılıkları sebebiyle kullanımı önerilmez (Görsel 3.82).

Görsel 3.82: Satır içi CSS

CSS Seçici, özelliklerin uygulanacağı HTML ögesinin adıdır. Seçicilerin şu çeşitleri mevcuttur (Görsel 3.83):

İsim: “p { }” şeklinde ifade edilen, bir  HTML tagının varsayılan özelliklerinin stil tarafından değiştirile-
bildiği çeşididir.

ID: “#kimlikismi { }” şeklinde ifade edilen, ID oluşturularak bir ögenin benzersiz şekilde tanımlan-
masını sağlayan stil çeşididir. 

Class: “.sınıfismi { }” şeklinde ifade edilen, bir ögeye değil birden çok ögeye uygulanabilen bir stil 
çeşididir. 

Tüm ögeler: “* { }” şeklinde ifade edilen, HTML belgesindeki tüm ögelere uygulanabilen stil çeşididir.

Birleşik: “tagadi1 tagadi2 { }” (farklı birleşim şekli olmakla birlikte) şeklinde ifade edilen, 1. ögenin 
içinde bulunan, tüm 2. ögelere uygulanabilen stil çeşididir.

Görsel 3.83: CSS Seçiciler
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3.5.1. Web Editöründe CSS Panelinde Stiller Oluşturma
Web editör programında CSS özellikleri yazılarak oluşturulabileceği gibi 
CSS Designer paneliyle program tarafından oluşturulabilir.

Window>CSS Designer ya da Shift+F11 kısa yoluyla açılacak CSS 
Designer (Görsel 3.84) görsel şekilde dosyalar, kurallar ve ayarlı özellikler 
oluşturulmasına olanak sağlayan CSS özellik denetimidir.

CSS Designer panelinde; All (tümü) ile tüm CSS dosyaları, Current 
(geçerli) ile geçerli belgenin CSS dosyası, Sources (kaynaklar) ile 
özelliğin eklenme şekli (yeni bir CSS dosyası oluşturma, var olan CSS 
dosyasına ekleme ya da sayfada tanımlama), @Media (ortam) ile ekran 
boyutu denetlemek için ortam sorguları, Selectors (seçiciler) ile @Ortam 
panelinde seçili ortam sorgusuyla ilgili seçiciler, Properties (özellikler) 
ile sadece ayarlı özellikleri gösterme seçeneği bulunan seçiciyle ilişkili 
özellikler düzenlenebilir.

Web sayfasında metin oluşturulur.

CSS Designer>Sources ile kaynak seçilir. Metne atanmak istenen özel-
liklerin belirleneceği yeni class adı Selector bölümünden verilir. Properties bölümünden metne 
uygulanmak istenen CSS özellikleri tanımlanır. Ardından metin seçilir. Insert>Div ya da Insert>Htm-
l>Article ile Class kategorisinden oluşturulan ad seçilir (Görsel 3.85, 3.86).

Görsel 3.84: CSS Designer 
paneli

Görsel 3.85: CSS atanmamış metin

Görsel 3.86: CSS atanmış metin
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Web editör programında web site sayfalarında Layout oluşturmak için CSS kullanımı 

HTML formatında hazırlanan web sayfalarında layout için kullanılan divlere CSS stilleri oluşturmak 
gerekir. 

Biçimlendirilecek taga atanabilecek CSS stilleri farklılık göstermekle birlikte ortak birtakım özellikler 
de vardır. 

Layout için kullanılan div tagına verilebilecek temel özellikler, öncelikle kapsadığı şeyler için içerik 
alanı, çerçeve, iç - dış boşluk, genişlik, yükseklik ve konumdur (Görsel 3.87). 

Görsel 3.87: Div CSS stil

İçerik ile kenarlık arasında boşluk alanı; Padding tüm yönlere, Padding-top sadece üstten, Padding-
right sadece sağdan, Padding-bottom sadece alttan, Padding-left sadece soldan verilir. Bu özellik, 
border ve margin için de geçerlidir (Görsel 3.88):

Görsel 3.88: Div CSS atama
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Genişlik ve yükseklik değer hesaplamaları: Görsel 3.89’da oluşturulan content divinin genişlik ve 
yükseklik değeri, içerik alanı; 300px, padding; 15px (2 kenar için 15x2), margin; 10px (2 kenar için 
10x2), border; 10px (2 kenar için 10x2) şeklinde (300+30+20+20=370) hesaplanarak 370x370px’tir.

Genişlik ve yükseklik değerleri için kullanılabilecek diğer özellikler; “minimum” ile “değer bu kadar 
olsun ama içerik bu değeri geçerse yine de içeriğe göre kendini ayarla”, “maksimum” ile ise “değer 
bu kadar olsun içerik bu değeri aşarsa div dışına taşacak” anlamına gelen “min-width, max-width, 
min-height, max-height” tir.

HTML içerisinde bütün ögeler aksi belirtilmediği sürece, varsayılan-soldan sağa, yukarıdan aşağıya 
olarak konumlandırılır. 

Position ile yapılan konumlandırma şu değerleri alır:

Static: Sayfada tanımlanan her öge ilk başta bu değerdedir. Oluştukları yerde konumlanırlar, diğer 
yönlere yönlendirme özelliği çalışmaz.

Relative: Statikten farklı olarak belirli değerler verilerek diğer yönlere yönlendirme yapılabilir. 

Fixed: Tanımlanan ögeye sabit konum özelliği verilir. Diğer yönlerden değer verilerek konum belirle-
nebilir. Sayfa, yukarı-aşağı kaydırıldığında ögenin mevcut konumda kalmasını sağlar. 

Absolute: Tanımlanan öge için sabit, mutlak konumlandırmadır ancak öge kendisini statik konumda 
olmayan bir ebeveyn ögeye göre konumlandırır. Öge yoksa tarayıcı penceresinin sol üst köşesini 
referans alır, diğer yönlerden değer atanabilir. 

Sticky: Yapışkan olarak adlandırılır, belirlenen özelliklere gelene kadar relative öge gibi davranır. 
Belirtilen değerlere ulaşınca fixed öge gibi davranmaya başlar.

Konumlandırmada diğer yönlere yönlendirme yapmak için left (sol), top (üst), right (sağ) ve bottom 
(alt) özellikleri kullanılır.

Görsel 3.89: CSS ile div konumlandırma
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UYGULAMA ADI: Web Tasarım Editöründe CSS Kullanımı

AMAÇ: Web tasarım editöründe CSS komutları ile sayfayı bölümlere ayırmak.
Araç Gereç

1. Bilgisayar

2. Web tasarım programları

3. Genel ağ

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak CSS komutları ile oluşturaca-
ğınız HTML sayfayı 3.90’abenzer şekilde bölümlere ayırınız. 

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanınızı 
ve araç gerecinizi hazırlayınız. 

2.	  Bilgisayarı çalışmaya hazır hâle getiriniz.

3.	  Web tasarım editöründe yeni bir html sayfası oluşturunuz.

4.	 Oluşturduğunuz sayfanın <body></body> etiketleri arasına aşağıdaki komutları ya-
zarak bölümleri oluşturunuz.

	 <div id=”genel”> 
	 <divid=”ustAlan”> … </div> 
	 <div id=”icerik”> … </div> 
	 <div id=”menu”> … </div> 
	 <div id=”altAlan”> … </div> 
	 </div>

5.	 Web tasarım editöründe haricî bir CSS dosyası oluşturunuz.

3.6. UYGULAMA

Görsel 3.90: HTML sayfayı bölümlere ayırma
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6.	 Web tasarım editöründe haricî bir CSS dosyası oluşturunuz.
7.	 Oluşturduğunuz HTML sayfasına CSS dosyasını dâhil ediniz.
8.	 “genel” kutusunu oluşturmak için CSS dosyasına aşağıdaki komutları yazınız.

	 #genel { 
	 width: 1024px; 
	 }

9.	  “ustAlan” kutusunu oluşturmak için CSS dosyasına aşağıdaki komutları yazınız. 
	 #ustAlan { 
	 background-color: #FFAAB8; 
	 width: 1024px; 
	 height: 120px; 
	 }

10.	“icerik” kutusunu oluşturmak için CSS dosyasına aşağıdaki komutları yazınız. 
	 #icerik { 
	 float: right; 
	 width: 768px; 
	 height: 400px; 
	 background-color: #8AD4FF; 
	 }

11.	 “menu” kutusunu oluşturmak için CSS dosyasına aşağıdaki komutları yazınız.
	 #menu { 
	 float: left; 
	 width: 256px; 
	 height: 400px; 
	 background-color:# B4FAFF; 
	 }

12.	“altAlan” kutusunu oluşturmak için CSS dosyasına aşağıdaki komutları yazınız. 
	 #altAlan { 
	 width: 1024px; 
	 clear: both; 
	 height: 100px; 
	 background-color:# F9E4D5; 
	 }

13.	Sayfanızı tarayıcılarla çalıştırarak test ediniz.

DEĞERLENDİRME
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 1’deki 
Kontrol Listesi 7’nin ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri 
dikkate alınız. 
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3.6. SİTE YÖNETİMİ
Web sitesinin yayımlanma işlemi farklı yollarla yapılabilir. 

3.6.1. Site Erişilebilirliğini Test Etme, Dosya Transferini Yapma, 
	 Siteyi Yayınlama ve Sunucu Bağlantısı Yapma
Web sitesi yapım aşamasındayken sayfaların ve sayfalardaki mevcut içeriklerin ön izlemesinin belirli 
aralıklarla yapılması, sorunların ilerlemeden çözülmesi için oldukça önemlidir.  

Web sitesini sunucuya yüklemeden önce test aşamasında bakılması gereken konular şunlardır:

•	 Web sitesinin hedeflenen tarayıcılarda çalışması

•	 Web sitesinin farklı tarayıcı ve platformlarda doğru çalışması

•	 Web sitesi içerisindeki tüm linklerin çalışması

•	 Web sayfalarının boyutu ve sayfaların indirilme aşamasındaki sürenin kontrolü

•	 Web sayfalarının kodlarının kontrolü

Web sitesinin kullanıcılar tarafından çevrim içi ortamda görüntülenebilmesi için yayımlanması, 
yayımlama işlemi için ise web editör programında web sitesi için oluşturulan yerel site klasörünün 
uzak sunucuya (web sunucusu ya da yayımlama sunucusu) aktarılması gerekir. Uzak sunucu, kişisel 
bilgisayarlar gibi içerisinde dosya ve klasörlerin bulunduğu bir bilgisayardır.

Uzak sunucuda, web editör programında web sitesi için oluşturulan yerel site klasörü gibi web editör 
programının uzak site olarak adlandıracağı bir klasör oluşturulmalıdır. Ardından web editör progra-
mının web sunucusundan dosya yüklemesi ve indirmesi için bir bağlantı yöntemi seçilmelidir. Web 
editör programının desteklediği farklı yöntemler olmakla birlikte en genel kullanılan yöntem FTP’dir. 
Web editör programında uzak sunucuya erişim sağlandıktan sonra yayımlama işlemine geçilir.

Site>Manage Sites panelinden yayımlanmak istenen yerel site klasörü seçilir ve Edit the currently 
selected site komutuyla düzenleme paneli açılır. Açılan Site Setup for Siteadı panelinden Server 
kategorisi seçilir (Görsel 3.91). 

Görsel 3.91: Site Setup for Siteadı paneli 
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Server kategorisinde Add new Server komutuyla yeni bir sunucu tanımlaması yapılabilecek sunucu 
kurulum ekranı açılır (Görsel 3.92). 

Görsel 3.92: Sunucu kurulum ekranı  

Sunucu kurulum ekranında gerekli bilgiler yazılır ve kaydedilir.

•	 Server Name (sunucu adı): Bir sunucu adı verilebilir.

•	 Connect using (bağlantı yöntemi): FTP seçilmelidir.

•	 FTP Address (FTP Adres): Web hosting firmasından alınan, önüne protokol adı eklenmeden bilgi-
sayar sisteminin tam internet adı yazılmalıdır.

•	 Username and Password (kullanıcı adı ve şifre): FTP sunucusuna bağlanmak için kullanılan kullanıcı 
adı ve şifre yazılmalıdır.

•	 Test: FTP adresi, kullanıcı adı ve şifreyi test etmek için kullanılır.

•	 Root Directory (kök dizini): Uzak sunucudaki klasör yazılmalıdır.

•	 Web URL: “http://www.siteismi.com.tr” gibi web sitesinin tam adı yazılmalıdır.

Server kategorisinden eklenen sunucu, test sunucu ve uzak sunucu olarak seçilmelidir.

Files panelinden uzak site ile; bağlantı kurabilmek için Connects to Remote Host, bağlantıyı kesmek 
için Disconnect komutları kullanılmalıdır.
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UYGULAMA ADI: Site Yönetimi

AMAÇ: Web tasarım editöründe site yönetimini yapmak. 
Araç Gereç

1. Bilgisayar

2. Tasarım programları

3. Genel ağ

GÖREV: Aşağıdaki işlem basamaklarını dikkate alarak site yönetimini yapınız. 

İşlem Basamakları

1.		 Atölye önlüğünüzü giyiniz. İş sağlığı ve güvenliği önlemlerini alarak çalışma alanı-
nızı ve araç gerecinizi hazırlayınız. 

2.	 Bilgisayarı çalışmaya hazır hâle getiriniz.

3.	 Web tasarım editöründe, siteleri yönet bölümünden yayımlamak istediğiniz siteyi 
açınız.

4.	 Site erişilebilirlik testini yapınız. 

5.	 Sunucu kurulumunu yapınız.

6.	 Yayımlamak istediğiniz site dosyalarını transfer ediniz. 

7.	 Sunucu bağlantısı yaparak siteyi yayımlayınız.

DEĞERLENDİRME

Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız Ek 
1’deki Kontrol Listesi 8’in ölçütlerine göre değerlendirilecektir. Çalışmanızı yaparken bu 
ölçütleri dikkate alınız. 

3.7. UYGULAMA
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ÖLÇME VE DEĞERLENDİRME 

A) Aşağıda verilen cümlelerin başındaki parantezlere cümleler doğru ise “D”, yanlış ise “Y” 
yazınız. 

1.	 (   ) <TITLE> etiketi web sayfasının tarayıcıdaki adının ne olacağını belirleyen etikettir. 

2.	 (   ) <body background> parametresi ile web sayfasının zemin renginin ne olacağı belirlenir. 

3.	 (   ) Expanded görünüm modunda tablolar genişletilmiş hâlde görünür. 

4.	 (   ) Web tasarım editöründe satır sonu eklemek için Enter tuşuna basılmalıdır. 

5.	 (   ) Haricî bir dosyadaki metinleri tüm stilleriyle birlikte web tasarım editörüne kopyalamak  
mümkündür. 

6.	 (   ) Sayfada  bulunan resim  haricî bir resim düzenleme editöründe düzenlenemez. 

7.	 (   ) Sayfaya  ses dosyası eklemek için ortak menü grubu içinde bulunan ortam açılır menüsü 
altındaki  uygulama düğmesine tıklanır. 

8.	 (   ) Web tasarım editörüyle  sayfaları  oluşturduktan sonra bu sayfalar arasında bağlantılar oluş-
turulabilir. 

9.	 (   ) E-posta bağlantısı eklemek için ilgili nesne ya da metin seçildikten sonra Özellikler pencere-
sinde bulunan Bağ alanına “mail:” ifadesi ile başlayan e-posta adresi girilir. 

10.	 (   ) Tanımlanan  stilin site içinde birden fazla sayfada kullanılması isteniyorsa  haricî bir stil say-
fası oluşturulmalıdır. 

11.	 (   ) CSS dilimleme yöntemiyle web sayfası tasarımı yaparken sayfa boyutunun bilinmesi gerekir.

12.	 (   ) Dosyalar paneli bir araç çubuğuyla birlikte site devamlılığını sağlama işlevlerine sahip pek 
çok bağlam menüsü seçeneği içerir. 

B) Aşağıda verilen cümlelerde yer alan boşlukları doldurunuz.

13.	 HTML etiketleri yazılırken ........................................................ karakterler kullanılmamalıdır. 

14.	 Tablo içinde birbirinden farklı yerdeki hücreleri seçmek için ........................................................ tuşu-
na basılı tutulur.

15.	 Flash video eklemek için ortak menü grubu içinde yer alan ortam açılır menüsündeki .................
....................................... seçeneği seçilmelidir. 

16.	 Sayfa fontunu belirlemek için ........................................................ kutucuğu seçilmelidir. 

17.	 Web tasarım editöründe ........................................................  tuşlarına birlikte basarak metinler arası-
na bölünmez boşluklar eklenebilir. 
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C) Aşağıdaki soruları dikkatlice okuyarak doğru seçeneği işaretleyiniz.

18. Hazırlanan web sayfasında tarayıcı ekranında görünmeyen “Başlık” bilgisi hangi HTML 
etiketiyle gösterilir?

A) <body>	
B) <title> 	
C) <head> 	
D) <HX> 	
E) <B> 

19. Aşağıda verilen  HTML etiketlerinden hangisi bir listeleme etiketidir? 

A) <b> 	
B) <ol> 	
C) <u> 		
D) <br> 	
E) <i> 

20. <h1 align=”center”> şeklinde yazılanbir HTML komutu metne hangi özelliği verir?

A)  Metni aşağı iter. 
B)  Metni sola yaslar 
C)  Metni iki tarafa yaslar. 
D)  Metni sağa yaslar. 
E)  Metni sayfaya ortalar. 

21. Aşağıdakilerden hangisi herhangi bir site tanımlamada ilk adım olarak yapılır? 

A)  Siteleri Yönet iletişim kutusunu açmak .
B)  Yerel bir kök klasörü oluşturmak.
C)  Siteye bir isim vermek.
D)  Sunucu türünü belirtmek.
E)  Siteyi kaydetmek.

22. Aşağıda verilen  ifadelerden hangisi yanlıştır? 

A)  Tablolar bilgilerin düzenli bir şekilde sunulmasını  sağlar. 
B)  Tablolar satır ve sütunlardan oluşur. 
C)  Tablo bir HTML elemanı değildir. 
D)  Tablo iletişim kutusu üç bölüme ayrılır. 
E)  Tablo hücreleri arasındaki boşluk  hücre boşluğudur. 
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23. Web sayfasına dışarıdan tablo verilerini eklemek için aşağıdaki  menülerden hangisi  kullanılır? 

A) Dosya 	
B) Ekle
C) Komut 	
D) Pencere 
E) Tasarım 	

24. Bağlı sayfayı yeni bir pencerede açmak için hangi link açılış şekli hedef olarak belirlenir? 

A) Blank Parent 	
B) Left	
C) Parent 
D) Self		
E) Top		

25. Aşağıdakilerden hangisi bir CSS stili değildir? 

A) Bileşik 
B) Etiket 	
C) Kimlik 	
D) ID
E) Sınıf 	

26. Sayfa içindeki linklerin üzerine gelindiğinde  alacağı görünümün  ayarlanabileceği  tanımlama 
stili aşağıdakilerden hangisidir?

A) a:link	
B) a:hover 	
C) a:active 	
D) a:visited 	
E) a:script 

27. Ekle > Ortak >Bim Etiketi Ekle komutuyla sayfada  aşağıdaki  özelliklerden hangisi  kullanılabilir?

A) Tasarım alanları oluşturulur. 
B) Çoklu bileşenler eklenir. 
C) Davranış oluşturulur. 
D Link verilir. 
E) Uygulamalar eklenir.
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28. Aşağıdakilerden hangisi Float seçeneği ile sayfada kullanılan özelliktir? 

A) Karışık dilimler oluşturma
B) Yan yana dilimler oluşturma
C) Alt alta dilimler oluşturma 
D) Dilim karışıklığını giderme 
E) Dilimleri hizalama 

29. Bir davranış oluşturulduğunda, fareyle resmin üzerine gelindiğinde çıkacak açıklayıcı 
metin aşağıdaki başlıklardan hangisinin altında belirlenir?

A) Orijinal Görüntu

B) Rolover 

C) Alternatif Metin

D) Tıklatıldığında URL! Ye Git 

E) Kimlik ID 

D) Aşağıda verilen soruların cevaplarını noktalı yerlere yazınız.

30. Sırasız bir liste oluşturmak için hangi HTML etiketi kullanılır?

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

31. Ağ ve ağ kaynaklarına erişimi denetlemek için bir yazılım ve ağda bulunan bilgisayara ne 
ad verilir?

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

32.Tablo küçüldüğünde yazıların bir alt satıra inmesini engellemek için hangi tablo özelliği 
aktif hâle getirilir? 

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................

.....................................................................................................................................................................................................
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CEVAP ANAHTARI

1. ÖĞRENME BİRİMİ
1. D
2. D 
3. Y
4. D
5. eğlence, ticaret, kişisel
6. Jpeg, Gif, Png ve Svg
7. RGB
8. ana sayfası
9. link (bağlantı)
10. E
11. A
12. E
13.
14.
15.

2. ÖĞRENME BİRİMİ
1. D
2.  D
3.  Y
4. Y
5. Text Tool, Properties
6. Convert to Symbol
7. Actions
8. optimizasyon
9. A
10. C
11. C
12. E
13. Web2.0; interneti 

etkileşimli bir hâle 
getirmiş ve Html5, 
Css3 gibi teknoloji-
lerle etkileşimli web 
platformları oluşturul-
masını sağlamıştır.

14. Web3.0 ise güven 
gerektirmeyen bir 
alt yapıya dayalı yeni 
etkileşim paketleri 
ile tamamen merkezî 
olmayan bir web 
olarak geleceğin 
internetini oluştur-
muştur.

15. Web için animas-
yonlar sağlayan 
eski teknolojilerin; 
Web 3.0 teknolojisi 
tarafından desteklen-
memesi temel neden 
olmakla birlikte, 
tutarlı olmaması 
ayrıca mobil cihaz-
ların kullanımının 
çoğalması, kullanı-
cıların daha fazla 
performans istemesi 
vb. nedenlerden 
animasyon oluşturma 
ve kullanma tekniği 
değişim göstermiştir.

3. ÖĞRENME BİRİMİ
1. D
2. Y
3. D
4. Y
5. D 
6. Y
7. Y
8. D
9. Y
10. D
11. D
12. D
13. Türkçe
14. CTRL
15. FLV
16. Sayfa Özellikleri
17. Ctrl+ Shift ve boşluk
18. C
19. B
20. E
21. B
22. C
23. E
24. B
25. C
26. B
27. A
28. B
29. C
30. <ul>
31. Sunucu
32. Sarma yok
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KONTROL LISTESI

KONTROL LİSTESİ-1
1.1.Uygulama - Bilgilendirme Dosyası Hazırlama

GÖZLENECEK DAVRANIŞLAR GERÇEKLEŞTİ GERÇEKLEŞMEDİ
Konuya uygun ön araştırma yapar.
Konunun amacına uygun özgün çalışır. 
Konunun içeriğine uygun görsel hazırlar . 
İş sağlığı ve güvenliği tedbirlerini alarak web sitesinin 
genel amacını belirler. 
Dolaşım sistemini belirler .
Hedef kitle analizini hazırlar. 
Grafik tasarım yaklaşımını belirler. 
Sitenin prototipini oluşturarak sunumu tamamlar. (*)
Düzenli çalışmaya özen gösterir. (**)
Süreyi planlı ve verimli kullanır. (**)
Öğretmen yorumları:

Puanlama: Gözlenecek davranışlarda (*) ile ifade edilen her bir davranışın gerçekleşmesi 20 pua-
na, (**) ile ifade edilen davranışlar 5 puan diğerleri 10 puana karşılık gelir.

KONTROL LİSTESİ-2
1.2.Uygulama 

GÖZLENECEK DAVRANIŞLAR GERÇEKLEŞTİ GERÇEKLEŞMEDİ
Konuya uygun fotoğrafları belirler.
Kullanılacak görsel materyalleri, fotoğraf düzenleme prog-
ramına aktarır. (*)
Görsel materyallerin çözünürlük ve renk modunu uygun 
hale getirir. (*)
Görsel materyallerin format biçimini uygun hale getirir. (*)
Fotoğrafları uygun formatta kaydeder. (*)
İş sağlığı ve güvenliği tedbirlerini alarak uygulama yapar.
Düzenli çalışmaya özen gösterir.
Süreyi planlı ve verimli kullanır.
Öğretmen yorumları:

Puanlama: Gözlenecek davranışlarda (*) ile ifade edilen her bir davranışın gerçekleşmesi 15 pua-
na, diğerleri 10 puana karşılık gelir.



KONTROL LİSTESİ-3   
1.3. -  1.4. UYGULAMA

GÖZLENECEK DAVRANIŞLAR GERÇEKLEŞTİ GERÇEKLEŞMEDİ
Konuya uygun ön araştırma yapar. (*)
Web sayfasında kullanılacak tipografik ögelerin konumlan-
dırılmasını yapar. (*)
Görsel materyallerin tipografik ögelerle ilişkisine dikkat 
ederek tasarım yapar.(*)
RGB renk modunu kullanır. (*)
Ana sayfa ve tüm içerik sayfaları, belirlenen renk paletine 
göre renklendirir. (*)
İş sağlığı ve güvenliği tedbirlerini alarak düzenlemeyi 
uygun formatta kaydeder. (*)
Düzenli çalışmaya özen gösterir.
Süreyi planlı ve verimli kullanır.
Öğretmen yorumları:

Puanlama: Gözlenecek davranışlarda (*) ile ifade edilen her bir davranışın gerçekleşmesi 15 pua-
na, diğerleri 5 puana karşılık gelir.

KONTROL LİSTESİ-4  
(2.1.) – (2.2.)- (2.3.)- (2.4.)- (2.16.) UYGULAMA

GÖZLENECEK DAVRANIŞLAR GERÇEKLEŞTİ GERÇEKLEŞMEDİ
Konuya uygun ön araştırma çalışmaları yapar.
Sembol hâline getirecek şeklin eskizini çizer. (*)
Eskizi interaktif içerik oluşturma programına aktarıp çizim 
yapar. (*)
Eskizi renklendirir.
Çizimi sembol hâline getirir.
Konuya ilişkin özgün yaklaşımlarda bulunur.
İş sağlığı ve güvenliği tedbirlerini alarak çalışmayı program 
formatında kaydeder.
Düzenli çalışmaya özen gösterir.
Süreyi planlı ve verimli kullanır.
Öğretmen yorumları:

Puanlama: Gözlenecek davranışlarda (*) ile ifade edilen her bir davranışın gerçekleşmesi 15 pua-
na, diğerleri 10 puana karşılık gelir.
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KONTROL LİSTESİ-5  
(2.5.)-(2.6)-(2.7)-(2.8)-(2.9)-(2.10)-(2.11)-(2.13)-(2.14)-(2.15)-(2.17)-(2.18)-(2.19)-(2.20)

UYGULAMA
GÖZLENECEK DAVRANIŞLAR GERÇEKLEŞTİ GERÇEKLEŞMEDİ
Konuya uygun ön araştırma yapar. (*)
Uygulama yapılacak görseli belirler.(*)
Görseli, İnteraktif İçerik  /web editör/ piksel tabanlı/ vektör 
tabanlı programında açar.
İstenilen uygulama için uygun araçları kullanır. (*)
İstenilen uygulamayı yapar.(*)
Konuya ilişkin özgün yaklaşımlarda bulunur.
İş sağlığı ve güvenliği tedbirlerini alarak çalışmayı uygun 
formatta kaydeder. (*)
Düzenli çalışmaya özen gösterir.
Süreyi planlı ve verimli kullanır.
Öğretmen yorumları:

Puanlama: Gözlenecek davranışlarda (*) ile ifade edilen her bir davranışın gerçekleşmesi 15 pua-
na, diğerleri 5 puana karşılık gelir.

KONTROL LİSTESİ-6  
(3.1)-(3.2)-(3.3)-(3.4)-(3.5) UYGULAMA

GÖZLENECEK DAVRANIŞLAR GERÇEKLEŞTİ GERÇEKLEŞMEDİ
Yeni metin belgesi açar. (*)
Hazırlayacağı metin için uygun başlık verir (*)
Sayfaya metni / görsel / tablo/video, animasyon, ses oyna-
tıcı, düğme ekler. (**)
Sayfaya uygun görsel, metin, iletişim bağlantısı yapar. (**)
Metni /Görseli/ Tablo düzenler. (*)
Konuya ilişkin özgün yaklaşımlarda bulunur. (*)
İş sağlığı ve güvenliği tedbirlerini alarak çalışmayı program 
formatında kaydeder. (*)
Düzenli çalışmaya özen gösterir.
Süreyi planlı ve verimli kullanır.
Öğretmen yorumları:

Puanlama: Gözlenecek davranışlarda (**) ile ifade edilen her bir davranışın gerçekleşmesi 20 pu-
ana, (*) ile ifade edilen her bir davranışın gerçekleşmesi 10 puana, diğerleri 5 puana karşılık gelir.
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KONTROL LİSTESİ-7  
3.6. UYGULAMA

GÖZLENECEK DAVRANIŞLAR GERÇEKLEŞTİ GERÇEKLEŞMEDİ
Web tasarım editöründe yeni bir html sayfası oluşturur. (*)
html sayfasının <body></body> etiketleri arasına aşağıda-
ki komutları yazarak bölümleri oluşturur. (*)
Web tasarım editöründe haricî bir CSS dosyası oluşturur. (*)
Oluşturulan HTML sayfasına CSS dosyasını dâhil eder. (*)
“icerik”, “menü”, “altAlan”  kutusunu oluşturmak için CSS 
dosyasına komutları yazar. (*)
Sayfayı tarayıcılarla çalıştırarak test eder. (*)
Düzenli çalışmaya özen gösterir.
Süreyi planlı ve verimli kullanır.
Öğretmen yorumları:

Puanlama: Gözlenecek davranışlarda (*) ile ifade edilen her bir davranışın gerçekleşmesi 15 pua-
na, diğerleri 5 puana karşılık gelir.

KONTROL LİSTESİ-8
 3.7. UYGULAMA

GÖZLENECEK DAVRANIŞLAR GERÇEKLEŞTİ GERÇEKLEŞMEDİ
Web tasarım editöründe, siteleri yönet bölümünden yayım-
lamak istenilen siteyi açar. (*)
Site erişilebilirlik testini yapar. (*) 
Sunucu kurulumunu yapar. (*)
Yayınlamak istenilen site dosyalarını transfer eder. (*)
Sunucu bağlantısı yaparak siteyi yayımlar. (**)
Düzenli çalışmaya özen gösterir.
Süreyi planlı ve verimli kullanır. 
Öğretmen yorumları:

Puanlama: Gözlenecek davranışlarda (*) ile ifade edilen her bir davranışın gerçekleşmesi 15 pua-
na, diğerleri 5 puana karşılık gelir.
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